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Hosts and Services Basics

This guide gives administrators the standard procedures for adding and configuring hosts and services in
NetWitness. After introducing you to the basic purpose of hosts and services and how they function
within the NetWitness network, this guide covers:

e Tasks you must complete to set up hosts and services in your network

¢ Additional procedures that you complete based on the long-term and daily, operational needs of your
enterprise

e Reference topics that describe the user interface

Go to the NetWitness All Versions Documents page and find NetWitness Platform guides to
troubleshoot issues.

What Is a Host?

A host is the machine on which a service runs and can be a physical or virtual machine. See the
"NetWitness Detailed Host Deployment Diagram" in the NetWitness Deployment Guide for an
illustration of how hosts are deployed.

What Is a Category?

A category assigns a service or services to a host when you install a host from the Hosts view. You
choose a host Category in the Install Services dialog which is displayed when you select a host in the

Hosts view and click = " The following table lists each category and the services it installs. See
the "NetWitness Detailed Host Deployment Diagram" in the NetWitness Deployment Guide for an

illustration of how hosts are deployed.

Category Services Installed

Analyst Ul Investigate Server, Broker, NetWitness Ul, Reporting Engine, Respond Server
Archiver Workbench and Archiver

Broker Broker

Concentrator Concentrator

Endpoint Endpoint Server

Endpoint Broker Endpoint Broker Server

Endpoint Log Log Collector, Log Decoder, Endpoint Server, and Concentrator
Hybrid

ESA Primary Contexthub Server and ESA Correlation

8 Hosts and Services Basics
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Category Services Installed

ESA Secondary
Log Collector
Log Decoder
Log Hybrid

Log Hybrid -
Retention

Malware
Analysis

Network
Decoder

Network Hybrid

New Health and
Wellness

UEBA

Warehouse
Connector

ESA Correlation

Log Collector

Log Collector and Log Decoder

Log Collector, Log Decoder, and Concentrator

Log Collector and Log Decoder (deployed on NetWitness Series 6 Hybrid hardware
with Log Hybrid-Retention Optimization)

Malware Analysis and Broker

Decoder (Packets)

Concentrator and Network Decoder

Metrics Server

UEBA

Warehouse Connector

Caution: Endpoint Broker is designed to be installed as a standalone category (it's own host) or on the
standalone Endpoint-server host. Installation of Endpoint Broker on the Admin Server is not a
supported architecture.

What Is a Service?

A service performs a unique function, such as collecting logs or archiving data. Each service runs on a
dedicated port and is modeled as a plug-in to enable or disable, according to the function of the host.

You must configure the following Core services first:

¢ Network Decoder

¢ Concentrator
e Broker

e Log Decoder

All the services are listed below and each service except the Log Collector has its own guide or shares a
guide in the Host and Services Configuration Guides section of the NetWitness documentation page on
NetWitness Community at https://community.netwitness.com/t5/netwitness-platform/ct-p/netwitness-
documentation. The Log Collector has its own set of configuration guides to handle the configuration for
all the supported event collection protocols. For Log Collector information, see Log Collection Guides.

Hosts and Services Basics 9
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NW Server

Admin

Config

Content
Integration
Investigate
License
Orchestration
Reporting Engine
Respond

Security

Analyst UI

Broker
Investigate Server
NetWitness Ul
Reporting Engine
Respond Server
Archiver

Archiver
Workbench

Broker

Broker
Concentrator
Concentrator
Endpoint
Endpoint Server

Endpoint Broker

Endpoint Broker Server

Endpoint Log Hybrid

Log Collector
Log Decoder
Endpoint Server
Concentrator

ESA Primary

Contexthub
ESA Correlation

Implemented with the NW Server
Implemented with the NW Server
Implemented with the NW Server
Implemented with the NW Server
Implemented with the NW Server
Implemented with the NW Server
Implemented with the NW Server

Implemented with the NW Server
Implemented with the NW Server

Implemented with the Analyst Ul
Implemented with the Analyst Ul
Implemented with the Analyst Ul
Implemented with the Analyst Ul
Implemented with the Analyst Ul

Core Service

Core Service

Core Service

Core Service
Core Service

Core Service

10
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ESA Secondary

ESA Correlation

Log Collector

Log Collector Core Service

Log Decoder

Log Collector

Log Decoder Core Service

Log Hybrid

Log Collector

Log Decoder Core Service

Concentrator Core Service

Log Hybrid - Retention Deployed on Series 6 Hybrid hardware with Log Hybrid-Retention
Optimization.

Log Collector
Log Decoder Core Service

Malware Analysis

Malware Analysis
Broker Core Service

Network Decoder

Decoder (Packets) Core Service
Network Hybrid

Concentrator Core Service
Network Decoder Core Service

New Health and Wellness

Metrics Server

UEBA

UEBA

Warehouse Connector

Warehouse Connector Command line installation

You must configure hosts and services to communicate with the network and each other so they can
perform their functions such as storing or capturing data. For information about ports and a
comprehensive list of ports for all services, see "Network Architecture and Ports" in the Deployment
Guide for NetWitness Platform. Go to the NetWitness All Versions Documents page and find
NetWitness Platform guides to troubleshoot issues.

Hosts and Services Basics 11
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Hosts view or Services view > System > Host Task List dialog Services View

} |

Deploy a Host
(Indluding

Maintain a Host Maintain a Service

Installing a
Category on Host)

Setting Up a Host

You use the Hosts view to add a host to NetWitness. See Step 1. Deploy a Host for detailed instructions.

Maintaining Hosts

You use the main Hosts view ( (Admin) > Hosts) to add, edit, delete, and perform other
maintenance tasks for the hosts in your deployment. You use the Host Task List dialog to perform tasks
relating to a host and its communications with the network. See Hosts and Services Maintenance
Procedures for detailed instructions.

After initial implementation of NetWitness, the major task you perform from the Hosts view is updating
your NetWitness deployment to a new version.

Update Version Naming Convention

You use the Hosts view to apply the latest version updates from your Hosts and Services Maintenance
Procedures. You must understand the update version naming convention to know which version you
want to apply to the host. The naming convention is major-release.minor-release.service-pack.patch.
For example, if you choose 11.6.1.2, you apply the following version to the host.

* 11 =major release
* 6 =minor release
e 1 =service pack

e 2 =patch

NetWitness supports multiple versions in your deployment. For more information, see Running in Mixed

Mode. The NetWitness Server (NW Server Host) is updated first and all other hosts must have the same
or earlier version as the NW Server Host.
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The following example is a single version deployment with all hosts updated to 11.5.0.0.

NETWITNESS
HOSTS s CES EVEN NDPOINT SOURCES HEALTH & WELLNESS SYSTEM SECURITY
Groups Hosts
+ c é Update é Discover Filte X
Name Name Host Services  Current Version Update Version Status
=2 ( Analyst User Interface IP address 11.5.0.0 Up-to-date
Concentrator IP address 11.5.00 Up-to-date
Endpoint Log Hybrid IP address 11.5.0.0 Up-to-date
Health and Wellness Beta IP address 11.5.0.0 Up-to-date
Log Hybrid IP address 11.5.0.0 Up-to-date
Log Hybrid - Retention IP address 11.5.0.0 Up-to-date
Malware Analysis IP address 11.5.0.0 Up-to-date
Network Hybrid (Packets) IP address 11.5.0.0 Up-to-date
NW Server IP address 11.5.00 Up-to-date
Displaying 1-9 of 9
Page 1 of1 | C Displaying 1-9 of 9

Maintaining Services

A
You use the Services view ( (Admin) > Services) to add, edit, delete, monitor, and perform other
maintenance tasks for the services in your deployment. See Hosts and Services Procedures for detailed
instructions.

Services Implemented with the NetWitness Server

The services in the following list are implemented when you deploy the NW Server to support:

* The expansion of physical and virtual deployment platforms and improvements to host and service
maintenance.

e Content, Investigate, Respond, and Source functionality.

Caution: You do not need to configure these services to deploy NetWitness. recommends that you
monitor the operating status of these services using Health-and-Wellness. Do not attempt to modify the
parameters in the Explore view without contacting Customer Support

(https://community.netwitness.com/t5/support-information/how-to-contact-netwitness-support/ta-
p/563897).

Hosts and Services Basics 13
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N

Admin The Administration (Admin) Server is the back-end service for administrative
tasks in the NetWitness User Interface (UI). It abstracts authentication, global
preferences management, and authorization support for the Ul. The Admin server
requires the Config server and the Security server to be online to perform its role.

Config The Configuration (Config) Server stores and manages configuration sets. A
configuration set is any logical configuration group that is managed independently.
The Config server facilitates the sharing of properties among services, provides
configuration backup and restore facilities, and tracks changes to properties.

Content The Content server manages the NetWitness provided and user-created parser
rules. For more information on parser management, search for "parsers" in
NetWitness Community.

Integration The Integration Server manages interactions with external systems. The service
handles the following outbound or inbound channels.

e REST API Gateway - gateway to external REST clients that assigns calls to the
NetWitness Application Programming Interface (API).

¢ Notifications Dispatcher - centralized dispatcher for all outbound notifications
originating in the NetWitness deployment.

Investigate The Investigate server supports Investigate and Malware Analysis functionality.
For more information see the NetWitness Investigate User Guide,

Orchestration The Orchestration server provisions, installs, and configures all services in your
NetWitness deployment.

Respond The Respond server supports Respond functionality. For more information see the
NetWitness Respond Configuration Guide.

14 Hosts and Services Basics
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N

Security The NetWitness Security Server (Security server) manages the security
infrastructure of a NetWitness deployment. It handles the following security-
related concerns.

e Users and the authentication accounts
¢ Role Based Access Control (RBAC)
¢ Deployment PKI infrastructure

A NetWitness deployment has users with authentication accounts. Independent of
how you verify the identity of the analyst (for example, Active Directory),
NetWitness must maintain the user state, which is not provided by all
authentication providers (for example, last login time, failed login attempts, and
roles). The concept of a user is separate from the identify associated with the user
and the Security server maintains these as separate User and Account entities. In
addition to the out-of-the-box local NetWitness accounts available to all
NetWitness deployments, the server supports external authentication providers.

The Security server also implements RBAC by managing Role and Permission
entities. Permissions can be assigned to roles and roles to users. Together these
enable a flexible authorization policy for the deployment. The server also manages
generation of cryptographically secure tokens that encode the applicable
authorization for a user. These tokens form the basis for deployment-wide
authorization.

Source The Source server is reserved for future use and will provide a centralized location
to configure sources (for example, Endpoints and Log Sources).

Running in Mixed Mode

Mixed mode occurs when some services are updated to the latest version and some are still on older
versions. This happens when you update the hosts in your deployment to the latest version in phases (or
stagger the update).

Functionality Gaps Encountered During in Staggered Updates

If you stagger the update, you:
e May not have all the features operational until you update your entire deployment.

* Will not have service administrative features available until you update all the hosts in your
deployment.

e May be without data capture for a period of time.

Examples of Staggered Updates

In the following examples, all the hosts are on 11.4.0.0 and you want to stagger the host updates to
version 11.4.1.0.

Hosts and Services Basics 15
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Example 1. Multiple Network Decoders and Concentrators, Alternative 1

In this example, the 11.4.0.0 deployment includes one NW Server host, two Network Decoder hosts, two
Concentrator hosts, one Archiver host, one Broker host, one Event Stream Analysis host, one Endpoint
Log Hybrid host, and one Malware Analysis host.

You must complete Session 1 first and update the hosts in the order listed.
NetWitness recommends that you update the Sessions 2 and 3 hosts in the order listed.

Session 1: Update Essential Hosts

1. Update the NetWitness Server host.

2. Update the Event Stream Analysis host.
3. Update the Endpoint Log Hybrid host.
4. Update the Malware Analysis host.

5. Update the Broker host.

Session 2: Update Other Hosts

1. Update the two Network Decoder hosts.
2. Update the two Concentrator hosts and the Archiver host.
Session 3: Update Other Hosts

1. Update all other hosts.

Example 2. Multiple Network Decoders and Concentrators, Alternative 2

In this example, the 11.4.0.0 deployment includes one NW Server host, two Network Decoder hosts, two
Concentrator hosts, one Broker host, one Event Stream Analysis host, one Endpoint Log Hybrid host and
one Malware Analysis host.

You must complete Session 1 first and update the hosts in the order listed.
NetWitness recommends that you update the Sessions 2 and 3 hosts in the order listed.
Session 1: Update Essential Hosts

1. Update the NetWitness Server host.

2. Update the Event Stream Analysis host.

3. Update the Endpoint Log Hybrid host.

4. Update the Malware Analysis host.

5. Update the Broker host.

Session 2: Update Other Hosts

1. Update one Network Decoder host and one Concentrator host.

Note: It does not matter which of the Network Decoder hosts or which of the Concentrator hosts you
update first.

Time elapses during which NetWitness processes a significant amount of data.
Session 3: Update Other Hosts

16 Hosts and Services Basics
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1.
2.
3.

Update the second Network Decoder host and the second Concentrator host.
Update all Log Decoder hosts before you update Virtual Log Collectors.
Update all other hosts.

Example 3. Multiple Regions

In this example, the 11.4.0.0 deployment includes one NW Server host, one Event Stream Analysis host,
one Endpoint Log Hybrid host, one Malware Analysis host. Additionally, there are two sites, each with
two Network Decoders, two Concentrators, and one Broker, for a total of four Network Decoder hosts,
four Concentrator hosts, and two Broker hosts.

Session 1: Update Essential Hosts and Site 1

1.

Update the NW Server host.

2. Update the Event Stream Analysis host.
3.
4
5

Update the Endpoint Log Hybrid host.

. Update the Malware Analysis host.

. Update one Broker host, two Network Decoder hosts, and two Concentrator hosts.

Session 2: Update Other Hosts and Site 2

1.

Update the second Broker host.

2. Update the two remaining Network Decoder hosts.
3.
4. Update all the other hosts.

Update the two remaining Concentrator hosts.

Hosts and Services Basics 17
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Hosts and Services Set Up Procedures

Every service requires a host. After you set up a host, you can assign services to and from this host to
other hosts in your NetWitness deployment. This topic contains information about basic procedures. For
additional procedures, see Hosts and Services Maintenance Procedures.

Hosts view or Services view > System > Host Task List dialog Services View

v

Deploy a Host
({Including

\J

Maintain a Host Maintain a Service

Installing a
Category on Host)

Set up a host. Set Built-In Clock. Add a service, modify, or delete a service.
Install a category (service or services) on a host. Add Filesystem Monitor. Add, replicate, or delete a service user.
Specify port connection. Manage Host Groups. Add a service role.
Limit access to a host. Set Network Configuration. Create and manage service groups.
Verify NW Suite connection. Show Network Port Status. Duplicate or replicate a service role.
Update a Host Version (with or without Web Access). Set Network Time Source. Edit Core Service configuration files.

Set Syslog Forwarding. Edit or delete a service.

Reboot Host. Explore and edit service property tree.

Search for Host. Kill a connection to a service.

Shut Down Host. Search for services.

View Serial Number. Start, stop, or restart a service.

Set SNMP. View service details.

Stop or Start Service.

High-Level Task | Description

Set Up a Host Complete the following tasks in the order shown to set up a host.
Step 1. Deploy a Host

Step 2. Install a Service on a Host

Step 3. Review SSL Ports for Trusted Connections

Step 4. Manage Access to a Service

Step 1. Deploy a Host

nn

Caution: If you include "." in a host name, the host name must also include a valid domain name.

1. Deploy a host.

You can deploy a physical host (NetWitness Appliance), virtual host on-prem, a virtual in AWS, a
virtual host in Azure, or a virtual host on Google Cloud Platform. See the following guides for
instructions on how to deploy hosts.

e Physical Host Installation Guide
e Virtual Host Installation Guide
o AWS Installation Guide
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o Azure Installation Guide

o GCP Installation Guide

2. Goto (Admin) > Hosts.

The New Hosts dialog is displayed with the hosts that you deployed.
3. Select the hosts that you want to enable.

The Enable menu option becomes active.

4. Click Enable.

New Hosts

E-'::.n'&? Reject

Host Public Key Hash

host-uuid public-key

5. Select the host you enabled.

The host is displayed in the Hosts view. At this point, you can install a service on the host.

Step 2. Install a Service on a Host

Perform the following steps to install a service on a host.

QA
1. In NetWitness, go to (Admin) > Hosts.
The Hosts view is displayed.

2. Select the host on which you want to install the service (for example, Event Stream Analysis).

3. Click &M@l i the toolbar.
The Install Services dialog is displayed.

4. Select a service from the Category drop-down list (for example, ESA Primary).
5. Click in the Install Services dialog.

6. A pop-up listing all the services already installed on this host is displayed. If there are no services
installed, this pop-up will not be displayed.

7. Click Yes to install the new service.

Step 3. Review SSL Ports for Trusted Connections

To support trusted connections each core service has two ports, an unencrypted non-SSL port and an
encrypted SSL port. Trusted connections require the encrypted SSL port.

Hosts and Services Set Up Procedures 19
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Encrypted SSL Ports

By default, trusted connections are established with two settings:

e SSL is enabled.

e Core service is connected to an encrypted SSL port.

Each NetWitness Core service has two ports:

e Unencrypted non-SSL port
Example: Archiver 50008

* Encrypted SSL port
Example: Archiver 56008

The SSL port is the non-SSL port + 6000.

For information about ports and a comprehensive list of ports for all services, see "Network Architecture
and Ports" in the Deployment Guide for NetWitness Platform. Go to the NetWitness All Versions
Documents page and find NetWitness Platform guides to troubleshoot issues.

Step 4. Manage Access to a Service

In a trusted connection, a service explicitly trusts the NW Server to manage and authenticate users. With

Q
this trust, services in (Admin) > Services no longer require credentials to be defined for every
NetWitness Core service. Instead, users who have been authenticated by the server can access the service
without entering another password.

Test a Trusted Connection

Prerequisites

1. The administrator must assign a role to the user.
For more information, see "Add a User and Assign a Role" in the System Security and User
Management Guide.

2. The user must:
¢ Log in to NetWitness for the server to authenticate the user.

* Have access to the service.

Procedure

QA
1. In NetWitness, go to (Admin) > Services.
The Services view is displayed.
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NETWITNESS > Respon rs  Hosts  Fles  Dashboard  Reports O B ¥ O amn

HOSTS SERVICES ' ) ENDPOINT SOURCES HEALTH & WELLNESS SY SECURITY

+ < ¥ © |Filte X
Name Name Licensed Type version Actions
OA Admin Admin Server 1Mxxx &

AnalystU - AnalystUI 11XXX el
Broke Broker 11X.XX o
Concentrato Hybrid Concentrator 11XXX a.
Con rato brid Concentrator 11X.XX el
Network Hybrid Concentrator 11XX.X &
Config Server 11X.XX Lo
Content Content Server 110X £
Contexthub ESA Primary Contexthub 11XXX o
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Endpoint d Endpoint 11xXX o
| ESA Correlation 11xxX o
ESA Primary ESA Analytics 11 XXX o
rver Integration Server 11X.XX &
Investigate Server 11X.XX fed
Log Collector 11XXX &
Log Collector 11XXX fed
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Log Hybric Log Decoder 11X.XX o =
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2.

3.
4.

4

Select the checkbox of the service (for example, a Concentrator) to test and click —.
The Edit Service dialog is displayed.

Edit Service

Service Concentrator

Host Concentrator

Name Concentrator
Connection Details

Port 56005

Options

| Entitle Service

Test Connection

Cancel

Note: The Options box will only display if the selected service is not licensed. A licensed service
is denoted by a " in the Services view.

Remove the username to test the connection without credentials.

Click Test Connection.

Edit Service

Service Concentrator
Host Concentrator
Name Concentrator

CAannectio Natail
connection Details

Port 56005

Options

] Entitle Service

Test connection successful

22

Hosts and Services Set Up Procedures



Hosts and Services Getting Started Guide

The message Test connection successful confirms the trusted connection is established.
The previously authenticated user can access the service without typing a username and password on
the service.

5. Click Save.
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Hosts and Services Maintenance Procedures

Every service requires a host. After you set up a host, you can assign services to and from this host to

other hosts in your NetWitness deployment.

Hosts view or Services view > System > Host Task List dialog

Services View

v

Deploy a Host
({Including

Maintain a Host

Installing a
Category on Host)

Maintain a Service

Set Built-In Clock.
Add Filesystem Monitor.

Set up a host.
Install a category (service or services) on a host.

Specify port connection.
Limit access to a host.
Verify NW Suite connection.

Manage Host Groups.

Set Network Configuration.
Show Network Port Status.

Set Network Time Source.
Set Syslog Forwarding.
Reboot Host.

Search for Host.

Shut Down Host.

View Serial Number.

Set SNMP.

Stop or Start Service.

Update a Host Version (with or without Web Access).

Add a service, modify, or delete a service.
Add, replicate, or delete a service user.
Add a service role.

Create and manage service groups.
Duplicate or replicate a service role.
Edit Core Service configuration files.
Edit or delete a service.

Explore and edit service property tree.
Kill a connection to a service.

Search for services.

Start, stop, or restart a service.

View service details.

High-Level
Task

Description

Maintain a Host -

Basics e Apply Version Upgrades to a Host

¢ Create and Manage Host Groups

e Search for Hosts

¢ Set Network Time Source

¢ Show Network Port Status

e Show Serial Number

¢ Shut Down Host

¢ Stop and Start a Service on a Host

The following maintenance tasks are shown in alphabetical order.

24
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High-Level

Description
Task
Maintain a Host You use the Host Task List dialog to manage tasks that relate to a host and its
from the Host Task communications with the network. Several service and host configuration options
List Dialog are available for Core hosts.

Execute a Task From the Host Task List

Add and Delete a Filesystem Monitor

Reboot a Host
Set Host Built-In Clock

Set Network Time Source

Set SNMP

Set Syslog Forwarding

Show Network Port Status

Show Serial Number

Shut Down Host

Stop and Start a Service on a Host

Maintain a Service The following procedures describe how to maintain services.

Add, Replicate, or Delete a Service User

Add a User Role to a Service

Change a Service User Password

Create and Manage Service Groups

Duplicate or Replicate a Service Role

Edit Core Service Configuration Files

Edit or Delete a Service

Explore and Edit Service Property Tree

Terminate a Connection to a Service

Search for Services

Start, Stop, or Restart a Service

View Topology Details

Services System View

Centralized Service Configuration via Policy
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Apply Version Upgrades to a Host

Upgrade guides are available for all supported versions of NetWitness. Refer to the upgrade guide for the
latest version in the Install and Upgrade section of the NetWitness documentation page on
NetWitness Link.

Pre-Stage Host

Note: The Pre Stage Host option is enabled for upgrade on the Admin Server. This option will be
available after you upgrade to 11.7.1 and can be used to upgrade to versions later than 11.7.1.

2
1. Goto > Hosts.

2. Click Update > Check for Updates.
All possible update versions will displayed in the Versions drop-down list.

3. Click Update > Pre Stage Host and select the version in the update version column.
A confirmation message for downloading the files is displayed.

NETWITNESS wesligale Respond

40STS SERVICES EVENT SOURCES ENDPOINT SOURCES HEALTH & WELLNESS

[sroups Hosts
H c = < & | ZEnstall 4 Update ~ & Discover & Reboot Host Filte x

jame Name Update Host P Services  Current it Version Update Version Status

Pre Stage Host

Sai LD1171A 8 10.125.246.86 11.7.1.0 Up-to-Date
Check for Updates

v sA1171A T 25 1246175 10.125.246.75 11.7.1.0 11800

4. Click Yes to download the upgrade packages to the repo.

5. Verify the status of the download in the notifications tray as shown below.
The Pre Stage Host and Upgrade Host will be disabled until pre stage is completed.

NETWITNESS

HOSTS  SCRVICES

d completed for Version 11.8.0.0

- Jeted for Version 118.0.
Groups

Note: The current version and the update version in the Ul will be the same during the pre stage as
it is not the actual update. This is because only the repo files are downloaded and no actual
upgrade is done. The version will change only after upgrade.

6. If the download is successful, Check for Updates again to start the initialization.
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7. Click on Initialize Update.
The initialization of the package will take some time as the files are large and will need to be
unzipped.

IMPORTANT: Pre Stage Repo preparation steps from 1 to 4 can be performed at any time.
However, from steps 5 to 8 the upgrade process begins and you must NOT reboot the host or
restart the jetty server during this time as it will corrupt the .ZIP files.

8. Check the status of initialization in the notifications tray.

9. After the initialization is completed successfully, click Update > Update Host.
After the host is updated, you will be prompted to reboot the host.

Groups Hosts

10. Set up the host and reboot the host.

Create and Manage Host Groups

The Hosts view provides options for creating and managing groups of hosts. The Groups panel toolbar
includes options for creating, editing, and deleting host groups. Once groups are created, you can drag
individual hosts from the Hosts panel into a group.

Groups may reflect functional, geographical, project-oriented, or any other organization principle that is
useful. A host may belong to more than one group. Here are some examples of possible groupings:

* Group different categories to make it easier to configure and monitor all Brokers, Network Decoders,
or Concentrators.

e Group hosts that are part of the same data flow; for example, a Broker, and all associated
Concentrators and Network Decoders.

* Group hosts according to their geographic region and location within the region. If a major power
outage occurs in a location, potentially affected hosts are easily identifiable.
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Create a Group
Q
1. Select (Admin) > Hosts.
The Hosts view is displayed.

2. In the Groups panel toolbar, click +.
A field for the new group opens with a blinking cursor.

Groups
+ c
Name

Al

3. Type the name of the new group in the field (for example, Geo 1) and press Enter.
The group is created as a folder in the tree. The number next to the group indicates the number of
hosts in that group.

Groups
+ -
Name

S Al 12 ]

= Geo1

Change the Name of a Group
[

1. In the Hosts view Groups panel, double-click the group name, or select the group and click —.
The name field opens with a blinking cursor.

2. Type the new name of the group and press Enter.
The name field closes and the new group name is displayed in the tree.

Add a Host to a Group

In the Hosts view Hosts panel, select a host and drag the host to a group folder in the Groups panel.
The host is added to the group.

View the Hosts in a Group

To view the hosts in a group, click the group in the Groups panel.
The Hosts panel lists the hosts in that group.
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Remove a Host from a Group

1.

In the Hosts view Groups panel, select the group that contains the host that you want to remove.
The hosts in that group appear in the Hosts panel.

In the Hosts panel, select one or more hosts that you want to remove from the group, and in the
toolbar, select = > Remove from Group.

The selected hosts are removed from the group, but are not removed from the NetWitness user
interface. The number of hosts in the group, which is listed near the group name, decreases by the
number of hosts removed from the group. The 211 group contains the hosts that were removed from
the group.

In the following example, the host group called Geo 1 does not contain any hosts, because all the
hosts in that group are removed.

Groups
+ -2
Name

=l

& Geo

Delete a Group

. In the Hosts view Groups panel, select the group that you want to delete.

Click =.
The selected group is removed from the Groups panel. The hosts that were in the group are not
removed from the NetWitness user interface. The A11 group contains the hosts from the deleted

group.

Search for Hosts

You can search for hosts from a list of hosts in the Hosts view. The Hosts view enables you quickly filter
the list of hosts by Name and Host. It is possible to have numerous NetWitness hosts in use for various
purposes. Instead of scrolling through the host list, you can quickly filter the host list to locate the hosts
that you want to administer.

In the Services view, you can search for a service and quickly find the host that runs that service.
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Search for a Host

Q
1. Select (Admin) > Hosts.

2. In the Hosts panel toolbar, type a host Name or Hostname in the Filter field.

X

The Hosts panel lists the hosts that match the names entered in the Filter field.

Find the Host that Runs a Service

4
. Select (Admin) > Services.

In the Services view, select a service. The associated host is listed in the Host column for that
service.

. To administer the host in the Hosts view, click the link in the Host column for that service.
The host associated with the selected service is displayed in the Hosts view.

NETWITNESS

HOSTS SERVICES EVENT SOURCES ENDPOINT SOURCES HEALTH & WELLNESS SYSTEM SECURITY
+ C | @

Name Name Host Services Current Version Update Version Status

Sal NW Serve IP-address 11.5.0.0

Execute a Task From the Host Task List

Q
1. Select (Admin) > Services.

2. In the Services list, select a service and click 2 > View > System.

Note: The Admin, Config, Orchestration, Security, Investigate, and Respond services do have
access to the System view. They only have access to the Explore view.

The System view for the service is displayed below.
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NETWITNESS ) ers sty Files Dashiboan

SERVICES

. Change Service | B3 Broker

&' Swop Aggregation . Hos: Tasks Q Shutdown Service O shutdewn Appliance Service U]

Appliance Service Information

NW Server (Host
11.5.0.0 (Rév nu
27168 KB (0.02% of 126 GB)

30 e <
S

utes S0 seconds

Broker User Information Host User Information
admin admin

Administrators Administrators

appliance.manage, CoONNECTions.Manage
OgS.MANAgE, Servicés. Mand
TOredproc. execute, STore
yS.

manage, users.man.

Aggregate, concentrator.manage,

Session Information
Session User P Adgdress Login Time ~ Active Queries
admin P Addres 2019-Dec-17 16:55:09 c
admin 2019-Dec-17 16:55:17 C
admin 2019-Dec-19 15:43:30 0
2019-Dec-19 15:42:20 0 1

escalateduser

3. In the Services System view toolbar, click s,

Host Task List

Output

Cancel
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4. In the Host Task List dialog, click in the Task field to display a drop-down list of tasks that run on a
host.

Task

UETELE TIIE=FSLETTT TRIOTITILT

Arguments Reboot Host Bun
Set Host Built-In Clock

Set Host Hostname

Set Metwork Configuration

Set Network Time Source

Set Syslog Ferwarding

Show Metwork Port Status

Show Serial Mumber

Shut Down Host
Start Service

. Cancel
Stop Service

5. Select a task (for example, click Stop Service).
The task is displayed in the Task field. Task description, example arguments, security roles, and
parameters are displayed in the Info area.

Host Task List

Task Stop Service w
Arguments |5E|'-.-'ce=uec:uda"| | Run
Infa Stop a Metwitness service on this appliance

Example arguments:
service=decoder v

Output

Cancel

6. Type arguments if necessary and click Run.
The command executes and the result is displayed in the Output section.
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Add and Delete a Filesystem Monitor

When you want a service to monitor traffic on a specific file system, you can select the service and then
specify the path. NetWitness Platform adds a filesystem monitor. Once a file system monitor is added to
a service, the service continues to monitor traffic on that path until the file system monitor is deleted.

Configure the Filesystem Monitor

Q
1. Select (Admin) > Services.

2. In the Services list, select a service and click > View > System.
The System view for the service is displayed.

3. In the Services System view toolbar, click Host Tasks.

4. In the Host Task List, select Add Filesystem Monitor.
In the Info area, a brief explanation of the task and the task arguments is displayed.

5. To identify the file system to monitor, type the path in the Arguments field. For example:
path=/var/netwitness/decoder/packetdb

Host Task List

a5k Add Filesystemn Monitor bl
Arguments path=/war/netwitness/decoderfpacketdh Run
Infa parameters: -
path - <string. {file:The file or directory must exist
or be creatable}> Filesystem path to monitor
Output

Cancel

6. Click Run.
The result is displayed in the Output area. The service begins to monitor the file system and
continues to monitor it until you delete the filesystem monitor.
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Delete a Filesystem Monitor

Q
1. Select (Admin) > Services.
2. In the Services list, select a service and click 2 > View > System.
The System view for the service is displayed.
3. In the Services System view toolbar, click Host Tasks.

4. In the Host Task List, select Delete Filesystem Monitor.
In the Info area, a brief explanation of the task and the task arguments is displayed.

5. To identify the filesystem to stop monitoring, type the path in the Arguments field. For example:
path=/var/netwitness/decoder/packetdb

Host Task List

ash Delete Filesystem Monitor -

path=fvar/netwitness/deco JEI'-"FIEC{-E:dtl | Run

Arguments

Infa Delete a filesystem monitor

Example arguments:
path=fvar/netwitness/decoder/packetdh

Output

Cancel

6. Click Run.
The result is displayed in the Output area. The service stops monitoring the file system.

Reboot a Host

Under certain conditions, you must reboot a host; for example, after installing a software upgrade. This
procedure uses a Host Task List message to shut down and restart a host.

NetWitness Platform also offers other options for shutting down a host:
* To shut down and restart a host through an attached service, go to the Hosts view from a service in

the Services view (see Search for Hosts) and then follow the Shut Down and Restart a Host from
the Hosts View procedure below.

* To shut down the physical host without restarting, see Shut Down Host.
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Shut Down and Restart a Host from the Hosts View

Q
1. Select (Admin) > Hosts.

2. In the Hosts panel, select a host.

3. Select = RERo0t Host from the toolbar.

Shut Down and Restart a Host from the Host Task List

A
1. Select (Admin) > Services.

2. In the Services panel, select a service and click L > View > System.
The System view for the service is displayed.

3. In the Services System view toolbar, click Host Tasks.

4. In the Host Task List, select Reboot Host in the Task field.
No arguments are required.

Reboot this appliance

Mo arguments required

5. Click Run.
The host is rebooted and the result is displayed in the Output area.

Set Host Built-In Clock

After a shutdown or battery failure, it may be necessary to set the local clock on a host. The Set Host
Built-In Clock task resets the clock time.
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Set the Time on the Local Clock

Q
1. Select (Admin) > Services.
2. In the Services list, select a service and 2 > View > System.
The System view for the service is displayed.
3. In the Services System view toolbar, click Host Tasks.

4. 1In the Host Task List, select Set Host Built-In Clock.
Help for the task is displayed in the Info area.

5. Enter the date and time arguments in the Arguments field.
For example, to specify October 31, 2017 at 11:59:59 PM, type:
set=20171031T235959

Host Task List

35k Set Host Built-In Clock -
Arguments |5E:=2T T-'I-Z-E.I'HEEIEE* | Run
Infa et the appliance local clock

Example arguments:
set=20091231T235959 *

Output

Cancel

6. Click Run.
The clock is set to the specified time and a message is displayed in the Output area.

Set Network Time Source

When setting the clock source for a host, set the hostname or address of an Network Time Protocol
(NTP) server to be the network clock source for the host. If the host is using a local clock source, you
must specify local here to allow Set the Local Clock Source to be effective.
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Specify the Network Clock Source

Q
1. Select (Admin) > Services.

2. In the Services list, select a service and click 2> View > System.
The System view for the service is displayed.

3. In the Services System view toolbar, click Host Tasks.

4. In the Host Task List, select Set Network Time Source.
Host Task List

Task Set Metwork Time Source

Arguments

Info Set the clock source for this appliance

Example arguments:
source=tictoc.localdomain

5. Do one of the following:

* Type the hostname or address of the NTP server to serve as the clock source for this host; for
example: source=tictoc.localdomain

e If you want to use the host clock as a clock source, type:

source=local

6. Click Run.
The clock source is set and a message is displayed in the Output area.

Note: If you specified a NTP clock source of local, the host clock serves as the clock source and the
time is configured using Set Host Built-In Clock.
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Set SNMP

The Set SNMP task in the Host Task List enables or disables the SNMP service on a host. For a host to
receive SNMP notifications, enable the SNMP service. If you are not using SNMP for NetWitness
notifications, it is not necessary to enable the service.

Toggle SNMP Service on the Host

Q
1. Select (Admin) > Services.

2. In the Services list, select a service and click > View > System.
The System view for the service is displayed.

3. In the Services System view toolbar, click Host Tasks.

4. In the Host Task List, select setSNMP.
In the Info area, a brief explanation of the task and the task arguments is displayed.

5. Do one of the following:

¢ [f you want to disable the service, type enable=0 in the Arguments field.

setSNMP

Arguments |EI‘|-E-:| e=0 Run

Infa Enabled or Disable the SNMP service

Example arguments:
enable=1
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e [f you want to enable the service, type enable=1 in the Arguments ficld.

setSNMP

Arguments |E|-.5:, ==1 Ruri

Infa Emabled or Disable the SMMP service

Example arguments:
enable=1

6. Click Run.
The result is displayed in the Output area.

Set Syslog Forwarding

You can configure Syslog forwarding to forward the operating system logs of your NetWitness Hosts to
a remote syslog server. You can use the Set Syslog Forwarding task in the Host Task List to enable or
disable syslog forwarding.

Set Up and Start Syslog Forwarding

A
1. Select (Admin) > Services.

2. In the Services list, select a service and click > View > System.
The System view for the service is displayed.

3. In the Services System view toolbar, click Host Tasks.

Hosts and Services Maintenance Procedures 39



Hosts and Services Getting Started Guide

4. In the Host Task List, select Set Syslog Forwarding.
In the Info area, a brief explanation of the task and the task arguments is displayed.

Host Task List

Task Set Syslog Forwarding ~
Arguments Run
Infa Enable or disable syslog forwarding -

Example arguments:
hast=loghost.localdomain

Output

Cancel

5. In the Arguments field, do any one of the following.

¢ To enable syslog forwarding, specify any one of the following formats:
host=<loghost>.<localdomain> (for example, host=syslogserver.local).

host=<loghost>.<localdomain>:<port> (for
example, host=syslogserver.local:514).

host=<IP> (for example, host=10.31.244.244).
host=<IP>:<port> (for example, host=10.31.244.244:514).

The following table lists the parameters used to enable syslog forwarding.

loghost The host name of the remote syslog server.

localdomain  The domain of the remote syslog server.

port IP address of the remote syslog server.
1P The port number on which the remote syslog server receives a syslog
messages.

e To disable syslog forwarding, type host=disable.
6. Click Run.
The result is displayed in the Output area.

Once syslog forwarding is enabled or disabled, the /etc/rsyslog.conf file is
updated automatically to enable or disable syslog forwarding to the remote syslog destination and the
syslog service is restarted.

If you enable syslog forwarding, the logs from the configured service are forwarded to the defined syslog
server and continues forwarding until disabled.
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Note: You can now log in to the remote syslog server and verify if the messages are being received
from the NetWitness services configured for syslog forwarding.

Show Network Port Status

The Show Network Port Status task in the Host Task List gives you the status of all configured ports on
the host.

Display the Network Port Status

Q
1. Select (Admin) > Services.
2. In the Services list, select a service and T > View> System.
The System view for the selected service is displayed.
3. In the Services System view toolbar, click Host Tasks.

4. In the Host Task List, click Show Network Port Status.
The task is displayed in the Task field, and information about the task is displayed in the Info area.

5. No arguments are required for this task. Click Run.
The status for each port on the host is displayed in the Output area.

Host Task List

Task Show Network Port Status v

Info Show interface information
security.roles: appliance.manage

Output lo: link up
em4: link down
em3: link down
em?1: link up v

Cancel

Show Serial Number

The Show Serial Number task in the Host Task List displays the serial number of a host.
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Show the Serial Number

Q
1. Select (Admin) > Services.
2. In the Services list, select a service and click 2> View> System.
The System view for the service is displayed.
3. In the Services System view toolbar, click Host Tasks.

4. 1In the Host Task List, select Show Serial Number.
In the Info area, a brief explanation of the task and the task arguments is displayed.

5. No arguments are required for this task. Click Run.
The serial number of the selected host is displayed in the Output area.

Host Task List
Task Show Serial Number v
Run
Info Retrieve the appliance serial number
security.roles: everyone
Output serial number

Cancel

Shut Down Host

Under certain circumstances (for example, a hardware upgrade or an extended power outage that exceeds
backup power capacity), it may be necessary to shut down a physical host. When you shut down a host,
all services running on the host are stopped and the physical host turns off.

The physical host does not restart automatically. Use the power switch to restart the host. Once the
physical host restarts, the host and services are configured to restart automatically.

See Reboot a Host for how to start and stop a host without shutting down the host.
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Shut Down the Host

1. In the Host Task List, select Shut Down Host.

Host Task List

Task

Shut Down —|:5'I "|

Info Shut down this appliance

Mo arguments required

Output

Cancel

2. To execute the task, click Run.
The host shuts down, and the host turns off.

Stop and Start a Service on a Host

The Host Task List has two options for stopping and starting a service on a host. When you stop a
service using the Stop Service message, all processes of the service are stopped and users connecting to
the service are disconnected. Unless there is a problem with the service, it restarts automatically. This is
the same as the Shutdown Service option in the Services System view.

If a service does not restart automatically after being stopped, you can restart it manually using the Start
Service message.

Stop a Service on a Host

Q
1. Select (Admin) > Services.

2. In the Services list, select a service and click > Views> System.
The System view for the service is displayed.

3. In the Services System view toolbar, click Host Tasks.

4. In the Host Task List, select Stop Service.
The task is displayed in the Task field, and information about the task is displayed in the Info area.
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5. Specify the service (decoder, concentrator, broker, logdecoder, logcollector) to stop in

the Arguments field; for example, service=decoder.

Host Task List

Stop Service

|5E|'-.-'ce= :ECDd?"I

| Run

Stop a Metwitness service on this appliance

Example arguments:
service=decoder

Output

Cancel

6. To execute the task, click Run.

The service stops and the status is displayed in the Output area. All processes of the service are
stopped and users connecting to the service are disconnected. Unless there is a problem with the

service, it restarts automatically.

Start a Service on a Host

Q
Select (Admin) > Services.

1.
2. In the Services list, select a service and click 2> View> System.
The System view for the service is displayed.
3. In the Services System view toolbar, click Host Tasks.
4. In the Host Task List, select Start Service.
The task is displayed in the Task field, and information about the task is displayed in the Info area.
44
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5. Specify the service (decoder, concentrator, broker, logdecoder, logcollector) to stop in

Host Task List

SSH Start Service bl

the Arguments field; for example, service=decoder.

Arguments |5EI"."IIE=.ECDE|=."‘|

| Run

Infao Start a Metwitness service on this appliance

Example arguments:
service=decoder

Output

Cancel

6. To execute the task, click Run.

The service starts and the status is displayed on the Output area.

Add, Replicate, or Delete a Service User

You must add a user to a service for:
e Aggregation
e Accessing the service with the:

° Thick client

° REST API

System Security and User Management Guide.

Note: This topic does not apply to users who access services through the user interface on NetWitness
Server. You must add those users to the system, not a service. For details, see the "Set Up a User" in

For each service user, you can:

» Configure user authentication and query handling properties for the service

e Make the user a member of a role, which has a set of permissions the user receives

e Replicate the user account to other services

» Change the service user password on selected services

Change a Service User Password provides instructions for changing the service user password across

services.
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To navigate to the Services Security view:

Q
1. In NetWitness, go to (Admin) > Services.

2. Select a service, then click T > View > Security.
The Security view for the selected service is displayed with the Users tab open.

NETWITNESS vestigate Jsers  Hosts  Flles  Dashboard ~ Reports
SERVICES T SOURCES SOURCES

-+ Change Service | I3 broker - Broker

+ - | & car | mEmrmmasmm
=) a
USC U allV
Username
ame Username
admin .
Administrato admin
test
Dace ~red Conmfirmm Dace ~ared
Password Co Password
Ema Description
Administrator account for this service
ser Settings
UoCl OCLUNES
Auth Type Core Query Timeout
mase Diatforn - PN
e ess Plat v ev ~
Ia) D Sagceimmn Th ehalA
Que Pre 28353510 es a
DAla AarminAarelsim
ROIC IVIT JCI D W/
Groups

v/ Administrators

Add a Service User

1. On the Users tab, click +

2. Type the user name to access the service, then press Enter.
The User Information section displays the user name and the rest of the fields are available for
editing.
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3. Type the password for logging on to the service in the Password and Confirm Password fields.
4. (Optional) Provide additional information:

* Name for logging on to NetWitness

* Email address

e Description of the user

5. In the User Settings section, select the following information:
e Authentication Type
o If NetWitness authenticates the user, select NetWitness.
* If Active Directory or PAM is configured on NetWitness Server to authenticate the user, select

External.

* Core Query Timeout is the maximum number of minutes a user can run a query on the service.
This field applies to NetWitness 10.5 and later service versions and does not appear for 10.4 and
earlier versions.

6. (Optional) Specify additional query criteria:

* Query Prefix filters queries. Type a prefix to restrict results the user sees.

e Session Threshold controls how the service scans meta values to determine session counts. Any
meta value with a session count that is above the threshold stops its determination of the true
session count.

7. In the Role Membership section, select each role to assign to the user. When a user is a member of a
role on a service, the user has the permissions assigned to the role.

8. To activate the new service user, click Apply.

Replicate a User to Other Services

Note: The admin user cannot be replicated to other services.

1. In the Users tab, select a user and click s Replicate.
The Replicate Users to Other Services dialog is displayed.
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Replicate User to other services

Please enter and confirm the service user password. The entire service user account
replicates to the selected services. The user password also changes on each selected
service.

Password

Confirm Password

Ll Name ~ Address Type

[l Broker Broker

[_] Concentrator Concentrator

[] Archiver Archiver

[] Workbench Workbench

[7] Log Collector Log Collector

[7] Log Decoder Log Decoder

[[] Warehouse Connector Warehouse C...
NW — Malware A Malware A

Replicate

2. Enter and confirm the password.
3. Select each service to which you are replicating the user.

4. Click Replicate.
Delete a Service User

1. On the Users tab, select the Username and click =.
NetWitness requests confirmation that you want to delete the selected user.

2. To confirm, click Yes.

Add a User Role to a Service

There are pre-configured roles in NetWitness that are installed on the server and on each service. You
can also add custom roles. The following table lists the pre-configured user roles and their permissions.

Administrators ~ Full system access
Operators Access to configurations but not to metadata and session content

Analysts Access to metadata and session content but not to configurations
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SOC Managers Same access as Analysts and additional permissions to handle incidents

Malware Access to malware events and to metadata and session content

Analysts

Data Privacy ~  Access to metadata and session content and configuration options that manage
Officers obfuscation and viewing of sensitive data within the system (see Data Privacy

Management Guide),

You must add a service role when you have added a:
» Service user or users that requires a new set of permissions.

e Custom role on NetWitness Server because trusted connections require that the same custom role
exists both on the server and on each service the custom role will access. The names must be
identical. For example, if you add a Junior Analysts role on the server then you must add a Junior
Analysts role on each service the role will access. For more information, see "Add a Role and Assign
Permissions" in the System Security and User Management Guide.

There is also a pre-configured Aggregation service role. Services Security View - Aggregation Role and
Services Security View - Service User Roles and Permissions provide additional information.

To add a service user role and assign permissions to it:

4
1. In NetWitness, go to (Admin) > Services.

2. Select a service, then L > View > Security.
The Security view for the selected service is displayed with the Users tab open.
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3. Select the Roles tab and click +

NETWITNESS

SERVICES E\

& Change Service | B concentrator1 - Concentrator Security ©

Name
v aggregate

concentrator.manage

ogs.manage

rules.manage
¥ sdk.content

sdk.manage
v sdk.meta

v sdk.packets

services.manage

4. Click + , type the Role Name and press Enter.

The Services Security view is displayed and five pre-configured roles

are already listed.

Description

Allows aggregation of data

Allows users to manage the concentrator rules
Allows users to access sdk content

Allows users to manage queries and the sdk subsy...
Allows users to access sdk metadata

Allows users to access raw packets or logs

The Role Name is displayed above a list of Role Permissions.

5. Select each permission the role will have on the service.

6. Click Apply.

You can add service users to the role in the Users tab.

Change a Service User Password

This procedure allows administrators to change the password of a service user and replicate the new
password to all Core services with that user account defined. It replicates only the password change to
the Core services selected and does not replicate the entire user account. Administrators can also change

the password of the admin account on the Core services.

Note: The Change Password option does not apply to external users.
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To change the password of a service user:

Q
1. In NetWitness, go to (Admin) > Services.
The Admin Services view is displayed.

2. Select a service, then click T > View > Security.
The Security view for the selected services is displayed.

3. In the Users tab, select a user and select Change Password from T
The Change Password dialog is displayed.

Change Password

Please enter and confirm the service user password. Only the user password changes on the selected
services. No other user attributes will replicate to the services
Password
Confirm Password
Name ~ Address Type
Endpoint Log Hybrid — Log Decader Log Decoder -
Log Decoder — Log Collector Log Collector
Log Decoder — Log Decoder Log Decoder
Log Hybrid — Concentrator Concentrator
Log Hybrid — Log Collector Log Collector
Log Hybrid — Log Decoder Log Decoder
Malware Analysis — Broker Broker
Network Decoder — Network Decoder Network Dec...
Network Hybrid — Concentrator Concentrator
Network Hybrid — Network Decoder Network Dec...
Remote LC (VLC) — Log Collector Log Collector

Change Password

4. Type a new password for the user and confirm the password.
5. Select the services where you want the user password to change.

6. Click Change Password.
The status of the password change on the selected services is displayed.

IMPORTANT: If you change the admin password on a NetWitness service that is used as a Reporting
Engine data source, you must remove and then re-add the service as a data source. For details, see
"Configure the Data Sources" topic in the Reporting Engine Configuration Guide for RSA NetWitness
Platform 11.x Guide.
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Create and Manage Service Groups

The Admin Services view provides options to create and manage groups of services. The Services list
toolbar includes options to create, edit, and delete service groups. Once groups are created, you can drag

individual services from the Services panel into a group.

Groups may reflect functional, geographical, project-oriented, or any other organization principle that is
useful. A service may belong to more than one group. Here are some examples of possible groupings.

e Group different service types to make it easier to configure and monitor all Brokers, Network

Decoders, or Concentrators.

e Group services that are part of the same data flow; for example, a Broker, and all associated

Concentrators and Network Decoders.

* Group services according to their geographic region and location within the region. If a major power
outage occurs in a location, potentially affected services are easily identifiable.

Create a Group

QA
1. In NetWitness, go to (Admin) > Services.
The Admin Services view is displayed.

2. In the Groups panel toolbar, click +
A field for the new group opens with a blinking cursor.

Groups

+ -7 e
Mame

= All

[

" East Coast

) West Coast

3. Type the name of the new group in the field (for example, A New Group) and press Enter.
The group is created as a folder in the tree. The number next to the group indicates the number of
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services in that group.

Groups

+ c

MName

= Al
T A New Group

T East Coast

000

=} West Coast

Change the Name of a Group
L4

1. In the Services view Groups panel, double-click the group name or select the group and click ='.
The name field opens with a blinking cursor.

2. Type the new name of the group and press Enter.
The name field closes and the new group name is displayed in the tree.

Add a Service to a Group

In the Services view Services panel, select a service and drag the service to a group folder in the groups
panel.
The service is added to the group.

View the Services in a Group

To view the services in a group, click the group in the Groups panel.

The Services panel lists the services in that group.
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Remove a Service from a Group

1.

In the Services view Groups panel, select the group that contains the service that you want to
remove. The services in that group appear in the Services panel.

In the Services panel, select one or more services that you want to remove from the group, and in the
toolbar, select = > Remove from Group.

The selected services are removed from the group, but are not removed from the NetWitness user
interface. The number of services in the group, which is listed near the group name, decreases by the
number of services removed from the group. The A11 group contains the services that are removed
from the group.

In the following example, the service group called A New Group does not contain any services,
because the service in that group is removed.

Groups

o %4
Marme

= Al
= A New Group
i} East Coast

= West Coast

Delete a Group

In the Services view Groups panel, select the group that you want to delete.

Click =.
The selected group is removed from the Groups panel. The services that were in the group are not
removed from the NetWitness user interface. The A11 group contains the services from the deleted

group.

Duplicate or Replicate a Service Role

An efficient way to add a new service role is to duplicate a similar role, save it with a new name and
revise the permissions that are already assigned. For example, you could duplicate the Analysts role.
Then, save it as JuniorAnalysts and modify the permissions.
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The quick way to add an existing role to other services is to replicate the role. For example, you could
replicate the JuniorAnalysts role that exists on a Broker to a Concentrator and Log Decoder.

To navigate to the Services Security view:

Q
1. In NetWitness, go to (Admin) > Services.

2. Select a service, then click T > View > Security.
The Security view for the selected service is displayed with the Users tab open.

3. Select the Roles tab.

Duplicate a Service Role

1. In the Roles tab, select the role you want to duplicate.

NETWITNESS

SERVICES

- Change Service | 0 concentrator1 - Concentrator

-
+ - B Replicate - .
role Intormaticn
Role Name ~
ame
Administrators .
Aggregation
ROlIe Fermissions
Name Description
v

Allows aggregation of data

database.manage

everyone

¥ sdk.content Allows users to access sdk content

sdk.manage Allows users to manage queries and the sdk subsy...
v sdk.meta Allows users to access sdk metadata
v sdk.packets Allows users to access raw packets or logs

ections to other servi...

proc.manage

sys.manage

2. Click “__:_:I > Duplicate Role.

3. Type a new name and click Apply.
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4. Select the new role.

5. In the Role Permissions section, select or deselect permissions to modify what the new role can do.

Replicate a Role

1. In the Roles tab, select the role you want to replicate and click Replicate.
2. In the Replicate Role to Other Services dialog, select each service on which to add the role.

3. Click Replicate.

Edit Core Service Configuration Files

The service configuration files for Network Decoder, Log Decoder, Broker, Concentrator, Archiver, and
Workbench services are editable as text files. In the Services Config view > Files tab, you can:

e View and edit a service configuration file that the NetWitness system is currently using.
e Retrieve and restore the latest backup of the file you are editing.
» Push the open file to other services.

e Save changes made to a file.

The files available to edit vary depending upon the type of service being configured. The files that are
common to all Core services are the:

e The NetWitness file (netwitness). This is preconfigured and does not require editing.

e The service index file (index-<service>). This is preconfigured and may require editing.
See Edit a Service Index File for more information.

e The scheduler file (scheduler). The scheduler service is optional and requires editing.
See Configure the Task Scheduler for more information.

* The crash reporter file (crashreporter). The crash reporter service is optional and requires editing.
See Enable the Crash Reporter Service for more information.

e The feed definitions file (feed-definitions). This file is optional and may require editing.
See "Feed Definitions File" in the Decoder Configuration Guide for more information.

In addition, the Network Decoder has files that configure parsers, feed definitions, and a wireless LAN
adapter. There is also the table mapping file provided by NetWitness, table-map.xml, which is an
important part of the Log Decoder.

Note: The default values in these configuration files are good for the most common situations,
however some editing is necessary for optional services, such as the crash reporter or scheduler. Only
administrators with a good understanding of the networks and the factors that affect the way services
collect and parse data should make changes to these files in the Files tab.
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Edit a Service Configuration File

To edit a file:

1.
2.
3.

7.

Q
In NetWitness, go to (Admin) > Services.

In the Services list, select a service.
Select ¥ ' > View > Config.
The Service Config view is displayed with the General tab open.

Click the Files tab.
cThe selected service, such as Concentrator, appears in the drop-down list on the right.

(Optional) To edit a file for the host instead of the service, select Host in the drop-down list.

Choose a file from the Please Select A File To Edit drop-down list.
The file content is displayed in edit mode.

Dashboard ~ Reports

SERVICES VENT SOURCES
- Change Service | 3 concentrator1 - Concentrator | Config &
General Data Retention Scheduler ~ Correlation Rules  Appliance Service Configuration
ndex-broker-custom.xm v  Concentrator v 3 Get Backup | ,7::3.,?
<?xml version="1.0" encoding="ut-8"7>
<language level="IndexNone" defaultAction="Auto">
Eps:oa ndex Language Definition File 10.6 (December, 2015

Edit the file and click Apply.

The current file is overwritten and a backup file is created. The changes go into effect after the service is
restarted.

Revert to a Backup Version of a Service Configuration File

After you make changes to a configuration file, save the file, and restart the service, a backup file is
available.
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To revert to a backup of a configuration file:

1. Select a configuration file by completing steps 1-6 of Edit a Service Configuration File.

2. Click @ GetBackup,
The backup file opens in the text editor.
3. To revert to the backup version, click Save.

The changes go into effect after the service is restarted.

Push a Configuration File to Other Services

Once you have edited a service configuration file, you can push the same configuration to other services
of the same type.

1. Select a configuration file by completing steps 1-6 of Edit a Service Configuration File.

2. Click «s FUSh

The Select Services dialog is displayed.

3. Select each service to push the configuration file on it. Each service must be the same type as the one
you selected in the Services view.

Caution: If you decide not to push the configuration file, click Cancel.

4. To push the configuration file to all selected services, click OK.

The configuration file is pushed to all selected services.

Edit a Service Index File

This topic provides important information and guidelines for configuring service custom index files,
which are editable in the Service Config view > Files tab.

The index file, along with other configuration files, controls operation of each core service. Accessing
the index file through the Service Config view in NetWitness opens the file in a text editor, where you
can edit the file.

Note: Only administrators with a thorough and comprehensive understanding of Core service
configuration are qualified to make changes to an index file, which is one of the central configuration
files for the appliance service. Changes made should be consistent across all Core services. Invalid
entries or a misconfigured file can prevent the system from starting and can require the assistance of
NetWitness Support to bring the system back into a working state.

These are the index files:

¢ index-broker.xml, and index-brokereustom.xml

e index-concentrator.xml, and index-concentrator-custom.xml
¢ index-decoder.xml, and index-decodereustom.xml

e index-logdecoder.xml, and index-logdecodereustom.xml

58 Hosts and Services Maintenance Procedures



Hosts and Services Getting Started Guide

* index-archiver.xml, and index-archiver-custom.xml

¢ index-workbench.xml, and index-workbench-custom.xml

Index and Custom Index Files

All customer-specific index changes are made in index-<service>-custom.xml. This file overrides
any settings in index-<service>.xml, which is solely controlled by NetWitness.

The custom index file, index-<service>-custom.xml, allows creation of custom definitions or
overrides of your own language keys that are not overwritten during the upgrade process.

» Keys that are defined in index-<service>-custom.xml replace the definitions found in index-

<service>.xml.

* Keys that are added to index-<service>eustom.xml and not found in index-
<service>.xml are added to the language as a new key.

Some common applications for editing the index file are:
e To add new custom meta keys to add new fields to the NetWitness user interface.

e To configure protected meta keys as part of a data privacy solution as described in the Data Privacy
Management Guide.

e To adjust the NetWitness Core database query performance as described in the NetWitness Core
Database Tuning Guide.

Caution: Never set the index level to IndexKeys or IndexValues on a Network Decoder if you
have a Concentrator or Archiver aggregating from the Network Decoder. The index partition size is
too small to support any indexing beyond the default time meta key.

Configure the Task Scheduler

Scheduler File

You can edit the scheduler file that in the Service Config view > Files tab. This file configures the
built-in task scheduler for a service. The task scheduler can automatically send messages at predefined
intervals or specific times of the day.

Scheduler Task Syntax

A task line in the scheduler file consists of the following syntax, where <value> has no spaces:
<ParamName>=<Value>

If <value> has any spaces, this is the syntax:

<ParamName>="<Value>"

In each task line, these guidelines apply:
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e Parameter time or one of the interval parameters (seconds, minutes or hours) is required.

e Escape special characters with a \ (backslash).

Task Line Parameters

The following task line parameters are accepted by the scheduler.

daysOfWeek: <string, optional, {enum-
any:sun|mon|tue|wed|thu|fri|sat|all}>

deleteOnFinish: <bool, optional>

hours: <uint32, optional, {range:1 to
8760}>

logOutput: <string, optional>

minutes: <uint32, optional, {range:1 to
525948} >

msg: <string>

params: <string, optional>

pathname: <string>

seconds: <uint32, optional, {range:1 to
31556926} >

time: <string>

timesToRun: <uint32, optional>

Messages

The days of week to execute a task. The
default value is all.

Delete the task when it has successfully
finished.

The number of hours between executions.
Output the response to log using the
specified module name.

The number of minutes between
executions.

The message to send the node.
The parameters for the message.

The path of the node that receives the
message.

The number of seconds between
executions.

The time of execution in HH::MM:SS
format (local time of this server).

How many times to run because service
start, 0 = unlimited (default).

The following are the message strings to use in the Task Scheduler msg parameter.

addInter
save command every 6 hours:

Add a task to run at a defined interval. For example, this message runs the /index

addInter hours=6 pathname=/index msg=save
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addmil Add a task to run at a specific time of day or even day(s) of the week. For example,

this message runs the /index save command at 1 AM every business day:
addMil time= 01:00:00 pathname=/index

msg=save daysOfWeek=mon, tue,wed, thu, fri

delSched Deletes an existing scheduled task. The id parameter of the task must be retrieved
from the print message.

print Prints all scheduled tasks.
replace Assign all scheduled tasks in one message, deleting any existing tasks.
save Save node.

Sample Task Line

The following example task line in the scheduler file downloads the feeds package file (feeds.zip)

to the selected Network Decoder every 120 minutes from the feeds host server:
minutes=120 pathname=/parsers msg=feed params="type\=wget
file\=http://feedshost/nwlive/feeds.zip"

Enable the Crash Reporter Service

The Crash Reporter is an optional service for NetWitness services. When activated for any of the Core
services, the Crash Reporter automatically generates a package of information to be used for diagnosing
and solving the problem that resulted in the service failure. The package is automatically sent to
NetWitness for analysis. The results are forwarded to NetWitness Support for any further action.

The information package sent to NetWitness does not contain captured data. This information package
consists of the following information:

e Stack trace

* Logs

e Configuration settings
* Software version

¢ CPU information

¢ Installed RPMs

* Disk geometry

The Crash Reporter crash analysis can be activated for any Core product.

The crashreporter.cfg File

One of the files available for editing in the Service Config view > Files tab is crashreporter.cfg, the
Crash Reporter Client Server configuration file.

This file is used by the script that checks, updates, and builds crash reports on the host. The list of
products to monitor can include Network Decoders, Concentrators, Brokers, and hosts.
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This table lists the settings for the crashreporter.cfg file.

N

applicationlist=decoder, concentrator, host

sitedir=/var/crashreporter

webdir=/usr/share/crashreporter/Web

devdir=/var/crashreporter/Dev

datadir=/var/crashreporter/data

perldir=/usr/share/crashreporter/perl
bindir=/usr/share/crashreporter/bin
libdir=/usr/share/crashreporter/lib
cfgdir=/etc/crashreporter
logdir=/var/log/crashreporter

scriptdir=/usr/share/crashreporter/scripts

workdir=/var/crashreporter/work

sgqldir=/var/crashreporter/sql

reportdir=/var/crashreporter/reports

packagedir=/var/crashreporter/packages

gdbconfig=/etc/crashreporter/crashreporter.gdb

corewaittime=30

cyclewaittime=10

Define the list of products to
monitor.

Location of the site directory for the
report.

Location of the web directory.

Location of the development
directory.

Location of the directory storing
data files.

Location of the Perl files.

Location of the binary executables.
Location of the binary libraries.
Location of the configuration files.
Location of the log files.

Location of the directory containing
scripts.

Location of the process work
directory.

Location where created SQL files
are placed.

Location where temporary reports
are created.

Location of the created package
files.

Location of the gdb configuration
file.

Define the number of seconds to
wait after finding a core to
determine if the core is still being
written.

Define the number of minutes to
wait between search cycles
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N

deletecores=1 Specify if the Core files should be
deleted after report.
0=No
1=Yes

Note: Until the Core file is
deleted, it is reported each
time crashreporter is restarted.

deletereportdir=1 Specity if the report directory should
be deleted after the report. Useful to
view ore reports on box.
0=No
1=Yes

Note: If not deleted, the directory
will be included in each
subsequent package.

debug=1 Specify whether debugging

messages are turned on or off in
the crashreporter logging output.
0=No
1=Yes
posturl=https://www.netwitnesslive.com/

. Define the webserver post URL.
crash...ter/submit.php

postpackages=0 Specify if the packages should be

posted to the webserver.
0=No
1=Yes
deletepackages=1 Specify if packages should be
deleted after they are posted to

webserver.
0=No
1=Yes

Configure the Crash Reporter Service

To configure the Crash Reporter service:

Q
1. Select (Admin) > Services.

2. Select a service and click ¥ © > View > Config.
3. Select the Files tab.

4. Edit crashreporter.cfq.
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5. Click Save.

6. To display the Service System view, select Config > System.

7. To restart the service, click & Shutdown Service
The service shuts down and restarts.

Start and Stop the Crash Reporter Service

To start the Crash Reporter Service:

QA
1. Select (Admin) > Services.

2. Select a service and click # * > View > System.

3. In the toolbar, click &#osms,
The Host Task List is displayed.

4. In the Task drop-down list, select Start Service.

5. In the Arguments field, type crashreporter, then click Run.

Host Task List

Task Start Service ~
Arguments ‘crashrepor‘ter | Run
Info Start a Netwitness service on this appliance

Example arguments:
service=decoder

Output

Cancel

The Crash Reporter service is activated and remains active until you stop it.

To stop the Crash Reporter service, select Stop Service from the Task drop-down list.

Maintain the Table Map Files

The table mapping file provided by NetWitness, table-map.xml, is a very important part of the Log
Decoder. It is a meta definition file which also maps the keys used in a log parser to the keys in the
metadb.
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Note: Do not edit the table-map.xml file. If you want to make changes to the table-map, make them
in the table-map-custom. xml file. The latest table-map.xml file is available on Live Services,
which NetWitness updates as required. If you make changes to the table-map.xml file, they can be
overwritten during a content or service upgrade.

The table map and custom table map files have two purposes:
e To translate the variables used in the Log Parsers to NetWitness meta key names

* To tell the system which keys to move onto the Concentrator.

For example, look at the out-of-the-box Palo Alto log parser, and examine one of its meta keys:
stransaddr. This key represents the source translated address. If we look in the table-map . xm1file
we can see that this variable is listed as Transient:

<mapping envisionName="stransaddr" nwName="stransaddr" flags="Transient"
format="Text" />

Because this variable is listed as, Transient, it never moved to the Concentrator. In fact, if you look at
all the metadata that we parse from that log in the Concentrator, it is not listed as an available key.
Assume we change the value in the table-map-custom. xmlfile to the following:

<mapping envisionName="stransaddr" nwName="stransaddr" flags="None"
format="Text" />

In this case, the key-value pair would get copied to the Concentrator, and from there you can choose
whether or not to index it.

In thetable-map.xmlfile, some meta keys are set to Transient and some are set to None. To store
and index a specific meta key, the key must be set to None. To make changes to the mapping, you need
to create a copy of the file named table-map-custom.xml on the Log Decoder and set the meta keys
to None.

For meta key indexing:
e When a key is marked as None in the table-map.xml file in the Log Decoder, it is indexed.

e When a key is marked as Transient in the table-map.xml file in the Log Decoder, it is not
indexed. To index the key, copy the entry to the table-map-custom.xml file and change
the keyword flags="Transient" to flags="None".

e [f a key does not exist in the table-map.xmlfile, add an entry to the table-map-custom.xmlfile
in the Log Decoder.

IMPORTANT: Do not update the table-map.xml file because an upgrade can overwrite it. Add all
of the changes that you want to make to the table-map-custom. xmlfile.

Prerequisites

If you do not have a table-map-custom.xml file on the Log Decoder, create a copy of table-
map.xml and rename it to table-map-custom.xml

To verify and update the table mapping file:
Q
1. Goto (Admin) > Services.

2. In the Services list, select a Log Decoder and click L > View > Config.
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3. Click the Files tab and select the table-map.xml file.
NETWITNESS Investigate ~ Respor Users losts ~ Files  Dashboard ~ Reports

SERVICES EVENT SOURCES ENDPOINT SOURCES HEALTH & V

-5 Change Service | =@ logdecoder - Log Decoder | Config &

Data Retention Scheduler ~ App Rules  Correlation Rules Parsers Parser Mappings

4. Verify that the f1ags keywords are set correctly to either Transient or None.

5. If you need to change an entry, do not change the table-map.xml file. Instead, copy the entry,
select the table-map-custom.xml file, find the entry in the table-map-custom.xml file and
change the flags keyword from Transient to None.

For example, the following entry for the hardware. id meta key in the table-map.xml file is not
indexed and the £1ags keyword shows as Transient:

<mapping envisionName="hardware id" nwName="hardware.id"
flags="Transient"/>

To index the hardware. id meta key, change the flags keyword from Transient to None in the

table-map-custom.xml file:
<mapping envisionName="hardware id" nwName="hardware.id" flags="None"/>

6. If an entry does not exist in the table-map.xml file, add an entry to the table-map-custom.xml
file.

7. After making your changes to the table-map-custom.xml file, click Apply.
Caution: Before changing the table mapping files, carefully consider the effect of changing the index
from Transient to None because it can impact the available storage and performance of the Log

Decoder. For this reason, only certain meta keys are indexed out-of-the-box. Use the table-map-
custom.xml file for different use cases.

Edit or Delete a Service

You can edit service settings, such as changing the host name or port number, or deleting a service that
you no longer need.

Each of the following procedures starts in the Services view.
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Q
To navigate to the Services view, in NetWitness, go to (Admin) > Services.

NETWITNESS vestigate Users sts Files  Dashboard ~ Reports
HOSTS SERVICES VENT SC SOURCES HEALTH & WELLNESS SYSTEM SECURITY
Groups | Services
+ < v x
Name Name Licensed | Host Type version Actions
A (25} Admin NW Servei Admin Server 1Mxxx -3
Anal AnalystU AnalystUI 11X.XX Ee]
Broke! NW Server Broker 11XXX Fo
Concentrator Endpoint Log Hybrid Concentrator 11XXX Ee]
Concentrator Log Hybrid Concentrator 11XXX fe3
Concentrator Network Hybrid Concentrator 11XXX &
Config NW Server Config Server 11XXX Foy
\ten Server Content Server 11XXX o
Contexthub ESA Prim Contexthub 11x%X &
Decoder Network Hybrid Decoder 11XXX o
Endpoint Endpoint Log Hybrid Endpoint 11XXX o
ESA Correlation ESA Primary ESA Correlation 11XXX o]
ESA Primary ESA Analytics 11XXX Ee]
nt Integration Server 11X.XX o]
nvestigate NW Server Investigate Server 11xxX Eel
e En nt Log Hybrid  Log Collector 11xxX fe3
Log Collector Log Hybrid Log Collector 11XXX fe3
Endpoint Log Hybrid Log Decoder 11XXX Fel
Log Hybrid Log Decoder 11X & v
Page of 1 | | C Displaying 1 - 25 of 25

Edit a Service

1. In the Services view, select a service and either click lill-Ir or ¥ > Edit.

The Edit Service dialog is displayed. It shows only the fields that apply to the selected service.
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Service Eroker
Host lacalhast.localdomain
Mame Broke

Connection Detail

Por SE003

Test Connection

Cancel Save

2. Edit the service details by changing any of the following fields:

e Name

SSL - For trusted connections, you must use SSL.

Port - Each Core service has two ports, SSL and non-SSL.

e Username and Password - Use these credentials to test the connection to a service.

a. If you use a trusted connection, delete the username.

If you do not use a trusted connection, type a username and password.

b. Click Test Connection.
3. Click Save.

Delete a Service

1. In the Services view, select one or more services and either click = or T 7 > Delete.

2. A dialog requests confirmation. To delete the service, click Yes.

The deleted service is no longer available to the NetWitness modules.

Explore and Edit Service Property Tree

You have advanced access and control of service functionality in the Services Explore view, which
consists of two parts. The Node list displays service functionality in a tree structure of folders.
The Monitor panel displays properties of the folder or file selected in the Nodes list.

Each of the following procedures starts in the Explore view.
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To navigate to the Explore view:

1.
2.

Q
In NetWitness, go to (Admin) > Services.

Select a service, then select > View > Explore.

The Explore view is displayed. The Node list is on the left and the Monitor panel is on the right.

NETWITNESS estigate  Respond Sers 0sts les Dashboard

HOSTS SERVICES EVENT SOURCES ENDPOINT SOURCES

-+ Change Service | ER concentrator1 - Concentrator Explore «

B[ sdk storedproc
B[] service:

B[] storec d

=[]

B[ use

Display or Edit a Service Property

To display a service property:

1.
2.

Right-click a file in the Node list or Monitor panel.
Click Properties.

To edit the value of a service property:

1.
2.

In the Monitor panel, select an editable property value.

Type a new value.

Send a Message to a Node

1.

In the Properties dialog, select a message type from the drop-down list. Options vary according to the
file selected in the Node list.
A description of the selected message type is displayed in the Message Help field.

(Optional) If the message requires them, type the Parameters.

Click Send.
The value or format is displayed in the Response Output field.
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Terminate a Connection to a Service

You can view sessions that are running on a service in the Service System view. From within the list of
sessions, you can terminate the session and the active queries in a session.

Terminate a Session on a Service

Q
1. In NetWitness, go to (Admin) > Services.

The Admin Services view is displayed.

2. Select a service, and select LT > View> System.

The Services System view is displayed.

NETWITNESS

SERVICES E

- Change Service | 8 Broker

&' Stwop Aggregation . Hos: Tasks D shutgewn Service ® Shutdewn Appliance Service G Redee:

Appliance Service Information

utes 30 seconds

coNNections.manage,

Login Time ~ Active Queries

»
3. In the Session Information list at the bottom, click a session number from the Session column.
The confirmation dialog is displayed.

4. Click Yes.
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Terminate an Active Query in a Session

1. Scroll down to the Sessions list.

2. In the Active Queries column, click a non-zero count of active queries for a session. You
cannot click on it if there are 0 active queries.

The Active Queries dialog is displayed.

Active Queries

Running Since Query

2018-May—3011:40.. id1=1id2=1787124 size=10000 query="select
2018-May—3011:40.. jd1=1id2=1787124 size=10000 query="select
2018-May—3011:40.. id1=1760539 id2=1787124 size=10000 query:

2018-May—3011:40.. id1=1508859 id2=1787124 size=10000 query:

Close Cancel Query

3. Select a query and click Cancel Query.

The query stops and the Active Queries column is updated.

Search for Services

You can search for services from the list of services in the Services view. The Services view enables you
to quickly filter the list of services by Name, Host, and Service Type. You can use the Filter drop-down
menu and the Filter field separately or at the same time to filter the Services view.

Search for a Service

Q
1. In NetWitness, go to (Admin) > Services.

2. In the Services list toolbar, type a service Name, Host, or service Type in the Filter field.
= o %
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The Services panel lists the services that match the names entered in the Filter field. The following
example shows the search results after starting to type log in the filter field.

Services
| A 4
Name Licensed Host
Log Collector Log Decoder
Log Decoder Log Decoder
| Page 1 of1 | | C

log X
Type Version Actions

Log Collector  11.5.0.0 |%¥

Log Decoder 11.5.0.0 ¥

Displaying 1-2of 2

Filter Services by Type

QA
In NetWitness, go to (Admin) > Services.

o =

view.

4

Admin Server |
Archiver

Broker

Cloud Gateway Server
Concentrator

Config Server

Content Server
Contexthub Server
Decoder

Endpoint Broker Server
Endpoint Server
Enrichment Server
Entity Behavior Analytics
ESA Correlation

Ewvent Stream Analysis
Integration Server
Investigate Server
License Server

Log Collector

Log Decoder

Malware Analysis
Metrics Server
Orchestration Server
Reporting Engine
Respond Server
Security Server

Source Server

UEBA Server

Warehouse Connecior

00000000 DOOO0OO0O0O0OO0OODOOOO0OOOOOOOO0OND

Workbench

In the Services view, click ¥ - and select the service types that you want to appear in the Services

The selected service types appear in the Services view. The following example shows the Services view

filtered for Concentrator and Log Decoder.
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Name Licensed | Host Admin Server Actions
Archiver

Broker

Cloud Gateway Server

Concentrator

Config Server

L 2RNE - 20K -

Content Server
Contexthub Server
Decoder

Endpoint Broker Server
Endpoint Server
Enrichment Server
Entity Behavior Analytics
ESA Correlation

Event Stream Analysis
Integration Server
Investigate Server
License Server

Log Collector

Log Decoder

ORO00OOODOO0OOOODOOODOOROOOO

Malware Analysis
[ Metrics Server
[] Orchestration Server
[ Reporting Engine
[] Respond Server
[ Security Server
[ Source Server
[ UEBA Server
{ [ Warehouse Connectar
| Page 1 of1 | 1 01 Workbench ing 1-4of4

Find the Services on a Host

In addition to being able to locate the services for a host in the Services view, you can also quickly find
the services that run on a host in the Hosts view.

A
1. In NetWitness, go to (Admin) > Hosts.

2. In the Hosts view, select a host and click the box that contains a number (the number of services) in
the Services column.

A list of the services on the selected host is displayed.

In the following example, a list of two services on the selected host are listed after clicking the box
containing the number 2.
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NETWITNESS vestige  Respond  Users  Hosts  Flles  Dashbord

HOSTS SERVICES EVENT SOURCES NT SOURCES

+ C I £ Update © @ Discover Filce X
Name Name Host Services Current Version Update Version
Sa @ NW Server IP-address 11.500
Archiver IP-address 11.5.0.0
Concentrator IP-address 11.50.0
Decoder IP-address 11.5.0.0
Log Collector IP-address 11.5.0.0
Log Decoder IP-address 11.50.0
Network Decoder (Packets) IP-address
| Decode :
| Page 1 of1 | | C DTS OTAY g T 70T 7

3. You can click the service links to view the services in the Services view.

Start, Stop, or Restart a Service

These procedures apply to Core services only.

Q
Each of the following procedures starts in the Services view. In NetWitness, go to (Admin) >
Services.

Start a Service

1. Select a service and click o> Start.

Stop a Service

When you stop a service, all of its processes stop and active users are disconnected from it.

To stop a service:
1. Select a service and click % ' > Stop.

2. A dialog requests confirmation. To stop the service, click Yes.

Restart a Service

Occasionally, you have to restart a service for changes to take effect. When you change a parameter that
requires a restart, NetWitness displays a message.
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To restart a service:

1. Select a service and click L o JEEN Restart.

2. A dialog requests confirmation. To stop the service, click Yes.

The service stops, then restarts automatically.

View Service Details
You can view and edit information about services using options in the View menu for a service.

System I View »
Stats

Config

Explore

Logs

Security

Purpose of Each Service View

Each view displays a functional piece of a service and is described in detail in its own section:

e Services System View shows a summary of service, appliance service, service user, host user, and
session information.

* Services Stats View provides a way to monitor service operations and status.

e Services Config View is for configuring all aspects of a service.

e Services Explore View is for viewing and editing host and service configurations.
e System Logging Panel shows service logs that you can search.

* Services Security View is a way to add NetWitness Platform Core user accounts for aggregation, thick
client users, and REST API users.

Access a Service View

To access a view for a service:

A
1. In NetWitness, go to (Admin) > Services.

2. Select a service and click L o JEIPN View.

The View menu is displayed.
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System View b
Stats Delete

Config Edit

Explore Start

Logs Stop

Security Restart

3. From the options on the left, select a view.

Below is an example of the Services System view for a Broker.

NETWITNESS

SERVICES EVENT SOURCES E POINT SOURCES HEALTH & WELLNESS

- Change Service | 8 Broker

&' Swop Aggregation ’ Hos: Tasks QO shutdewn Service O Shutdown Appliance Service O Rebdboo:

Appliance Service Information

1
979 MB (0.76% of 126 GB 27168 KB (0.02% of 126

GB)
=)
MO o 17 1£-C -7
2019.Dec-17 16:54:47
5 dave 3 haure 8 minuree 30 carand
2 days 3 hours 8 utes 50 seconds

Host User Information

agmin
Administrators
apphancé.manage,

gs.manage, se;

CoNNeCtions. Manage

Caccinn |nfarmatinn
2353510 0 allQ
Session User o T e
agmin
arun
admin
-
escalatecuse 2019.Dec-19 15:44:2

4. Use the toolbar to navigate:

i. Change Service Broker

a. Click Change Service to select another service.
The Administrate Service dialog is displayed.

b. Select the checkbox to the left of the service that you want.
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c. Select the view that you want for the service you selected in the View drop-down list.
E"ﬂ:‘w & Nav
|  System
. Stats
Config
Explore
Logs

Security

The new view (for example, Stats) is displayed for the service you selected.

View Topology Details

Note: This feature is supported in 11.7 and later.

Note: To view the Service Topology Tab, you must ensure this feature is enabled under Admin
Server > Explorer > Feature> service-topology-feature.

Administrators and analysts can view all the NetWitness core services in a hierarchical layout depicting
the collection and aggregation of the services in your deployment. This visualization displays the

topology for Broker, Concentrator, Log Decoder, Packet Decoder, Hybrids, ESA and Log Collector and
provides insights on which:

o Broker aggregates from the Concentrators.
» Concentrator aggregates from the Log Decoders.
o Log Decoder receives data from the Log Collectors.

e Log Collector sending data to other Log Collectors and vice-veNetWitness and the direction of the
data flow.

Note: Services such as Reporting Engine, Malware Analysis, UEBA, Endpoint Server, Cloud Link
Service, and Warehouse connector are not supported.

The topology is automatically refreshed once in 3 hours. You can click on any node to view the details.

To view the Topology:
1. Click [El > Service Topology.
2. Do one of the following:

o Scroll horizontally to view the complete topology.

o Click Search and enter the service name to locate a specific service. The specific service will be
highlighted in blue color in the hierarchical layout.

3. Click on the node to view the details.
For more information, see Services Topology View topic.
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—— - @ logriecoder - Log Collector

._W-Lugnecﬁ;

@—umm e

| concentrator1- Concentrator @

Centralized Service Configuration via Policy

Note: The information in this section applies to NetWitness Platform Version 11.7 and Later.

Centralized Service Configuration allows you to manage the configuration of services in your
environment efficiently. The Decoder, Concentrator, and Log Decoder deployed in your environment
may be large in number and geographically distributed. Managing common configurations across the
services can be time consuming. With Centralized Service Configuration, you can centrally create a
policy of common configuration settings and apply the policy to a set of groups.

Groups

A group is a set of services based on the service type Decoder, Concentrator, and Log Decoder. You can
create a group and assign policy to it based on your requirement. For example, group all the 10G
Decoder services or group services within a geographical area. For more information on creating groups,
see Creating Groups and Policies.

Policies

A Policy is a set of service configurations that you can apply to a set of groups. This allows you to
efficiently manage the service settings. Once you create a customized policy, you can assign it to a
group.

Benefits of Centralized Service Configuration

o Apply customized settings in one step to any number of services

o Centrally restart all services within a group (when needed) to apply changes

 Indicates when an action is required, such as service restart, failed publication, or Out of Compliance
services

 Clone policy to quickly create similar policies with minor changes
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Quickly revert changes to a policy in case of issues
Groups of the same service type can be created based on similar hardware profiles or other criteria

Add configuration items to policies in order to customize settings. Any settings which are not in the
policy will be left as default

(For version 11.7.1 and Later) Reconfigure 10G Network Decoders from the Policy UL
Administrators can quickly create 10G policies for each Decoder group based on the hardware profile

(For version 11.7.1 and Later) Clone policy from an existing service, to save policy transition time for
existing users

Creating Groups and Policies

Create a Group

You can create a group with one or more services and assign one policy to it. Atleast one service is
required to publish a group.

To create a group:

1.
2.

Go to (CONFIGURE) > Policies.
In the left panel, click Groups.

3. In the tool bar, click .

6.

In the New Group panel, do the following:

o Enter the name of the group.

o Enter a description for the group.

o Select the type of service for the group.
Click Next.

I{_-.I
In the Define Group, click to assign services to the group.

Note: A service is disabled if it is assigned to another group.

7.

Click Next.

In the Assign Policies, click M
group is of same service type.

to assign one policy to a group. Make sure that the policy and

Do any one of the following:
o Click Save and Publish to save and publish the policy.

The Publish and Restart Services dialog is displayed only if some settings require a service restart
for the changes to take effect. In the Publish and Restart Services dialog, do any one of the
following:
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o To publish and restart the services immediately, click Publish & Restart.

o To publish and restart the services later, click Publish & Restart Later. In this case you must
restart the services manually.

o To cancel the restart dialog, click Cancel.
The settings that do not require restart will be applied immediately.

Click Save and Close to save the settings.

Create a Policy
You can create a policy and assign it to one or more groups.

To create a policy:

1.
2.

Go to B2l (CONFIGURE) > Policies.

Click Policies.
The available policies are displayed.

3. Click to add a new policy.

4. In the New Policy panel, do the following:
o Select the policy type from the drop-down list.
o Enter a unique policy name.
o Enter a description for the policy.
o Select the service type for the policy from the drop-down list.
o (For version 11.7.1 and Later) Select the service from which you want to clone the settings.
5. Click Next.
6. Do any one of the following:
o Customize the settings for the policy based on your requirement, for example, in the Database
setting, click and change the Policy value to sha256 or change the byte range to 10 MB.
Note: (For version 11.7.1 and Later) If you have preferred to clone from existing service,
the setting values are populated automatically from the selected service on customize
settings section. You can also add or modify the settings based on your requirement.
e (For version 11.7.1 and Later) To configure 10g Settings:
o Click 10g Settings.
o Select the Decoder service to fetch the settings.
o Click Done.
7. In the Group List, click ® to assign groups to the policy. The policy and group should be of
same service type.
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Note: A group is disabled if another policy of the same type is already assigned to this group.

8. Do any one of the following:
e Click Save and Publish to save and publish the policy.

The Publish and Restart Services dialog is displayed only if some settings require a service
restart for the changes to take effect. In the Publish and Restart Services dialog, do any one of
the following:

o To publish and restart the services immediately, click Publish & Restart Now.

o To publish and restart the services later, click Publish & Restart Later. In this case you
must restart the services manually.

o To cancel the restart dialog, click Cancel.

The settings that do not require restart will be applied immediately.

¢ Click Save and Close to save and return to the Policies view.
Managing Groups and Policies

View a Group

To view properties of the selected group:

1. Goto (CONFIGURE) > Policies.

2. Click Groups. The available groups are displayed.

3. Click a row to view details about the selected group in the right panel.

Delete a group

You can delete one or more groups. Once a group is deleted, the services and policies in the group will
no longer displays the deleted group details.

To delete a group:

1. Goto (CONFIGURE) > Policies.

2. Click Groups. The available groups are displayed.
3. Select one or more groups and click Delete.

The confirmation message is displayed.

Edit a Group

You can edit the properties of the group at any point in time. The service type cannot be edited. The
status of the updated group is unpublished if you change the service or policies in a group. If you just
change the group name and description the status remains published (if it is already published).

To edit a group:
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1. Goto (CONFIGURE) > Policies.
2. Click Groups. The available groups are displayed.

3. Select a group and click Edit.

Note: You cannot edit the service type.

4. Make the required changes in the group.

5. Do any one of the following:

¢ Click Save and Publish to save and publish the policy.
The policy will be listed under the published category.

¢ Click Save and Close to save the settings and return to the Groups view.

Filter Groups

The Filters Panel allows you to filter the list of displayed groups, based on the service type:

e Decoder

o Log Decoder

o Concentrator

Additionally, you can filter based on publication status or service status:
o Published: Groups that are published.

o Unpublished: Groups that are saved but not published.

o Failed: Groups that are failed to publish.

o N/A: Groups for which publication status is not applicable.

o Service Require Restart: The services associated with the group that require restart.

The Filters panel can be hidden or displayed:
* To display if hidden, click B in the toolbar.

* To hide, click at the top-right of the panel.

Delete a Policy

To delete a policy:

1. Goto (CONFIGURE) > Policies.

2. Click Policies. The available policies are displayed.

3. Select one or more policies and in the More Actions drop-down list in the tool bar, click Delete.

The delete dialog is displayed.

Note: The services associated with this policy still require a restart if the restart is pending.
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4. Click Delete to permanently delete the selected policies.

The deletion will take effect immediately.

Revert a Policy

You can revert a policy to the previously published version for a maximum of 5 times. Once a policy is
reverted you cannot get back to the newer version and you must publish a policy.

Note: The revert is disabled if there is no previously published version.

To revert a policy:
1. Goto (CONFIGURE) > Policies.
2. Click Policies. The available policies are displayed.

3. Select a policy and in the More Actions drop-down list in the tool bar, click Revert.
All changes made to policy will be discarded and reverted to the previously published version. You
must publish the policy once it is reverted.

Note: If there are any missing settings in the previously published version, then a default value is set
for those settings.

Clone a Policy

You can clone only one policy at a time. Once cloned, all the settings from the old policy is copied to the
new policy.

To clone a policy:

1. Goto (CONFIGURE) > Policies.

2. Click Policies. The available policies are displayed.

3. Select a policy to clone and in the More actions drop-down list in the tool bar, click Clone.

The policy is cloned successfully.

Edit a Policy

You can edit the settings of the policies. The service type and policy type cannot be edited. Once the
policy is edited the changes in the policy is reflected upon saving the policy. The updated settings are
applied to the service if published.

After saving and before publishing the publication status of the changed policy is set to Unpublished if
any settings is changed.

To edit a policy:

1. Goto (CONFIGURE) > Policies.
2. Click Policies. The available policies are displayed.
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3. Select a policy and click Edit.

4. Make the required changes in policy.

Note: You cannot edit service type and policy type.

5. Do any one of the following:

¢ Click Save and Publish to save and publish the policy.
The policy will be listed under the published category.

» Click Save and Close to save the settings and return to the Policies view.

View a Policy

To view a policy:

1. Goto (CONFIGURE) > Policies.

2. Click Policies. The available policies are displayed.

3. Click a row to view details about the selected policy in the right panel.

Filter Policies

The Filters Panel allows you to filter the list of displayed policies, based on the policy status and service
type:
o Published: Policies that are published.

o Unpublished: Policies that are saved but not published.

o Failed: Policies that are failed to publish.

o N/A: Policies for which publication status is not applicable.
The Filters panel can be hidden or displayed:

* To display if hidden, click B in the toolbar.

* To hide, click at the top-right of the panel.
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Hosts and Services Views References

This topic is a reference for features in the NetWitness Admin user interface.

The Admin module pulls NetWitness Admin activities into a single view to monitor and manage hosts
(appliances), services, tasks, and security.

Topics
e Hosts View
e Services View

e Services Config View

e Services Explore View

e Services Logs View

e Services Security View

e Services Stats View

e Services System View
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Hosts View

You set up and maintain the physical or virtual machine on which NetWitness services run in the Hosts
view.

IMPORTANT: For help with resolving errors you receive during version installation and update, see
Troubleshooting Version Installations and Updates .

A service performs a unique function, such as collecting logs or archiving data. Each service runs on a
dedicated port and is modeled as a plug-in to enable or disable, according to the function of the host.
You must configure the Core services first. You must configure hosts and services to communicate with
the network and each other so they can perform their functions such as storing or capturing data.

Workflow

This workflow shows the procedures you complete to set up a host, maintain a host, and update the host
with new NetWitness versions. Setting up a host is the first task in this workflow.The hosts with Core
services are set up out-of-the-box. After that, you can set up additional hosts to enhance your NetWitness
deployment. The other two tasks, maintaining a host and updating versions for a host, are performed
when required and do not have a specific order of completion.

Hosts View Services View

Set Up a Host

l
T
|
|
Maintain a Host ‘ Maintain a Service
l
|

You are here

What do you want to do?

o . o

Administrator  set up a host.* Setting Up a Host
Administrator maintain a host.* Maintaining Hosts
Administrator  maintain a service. Maintaining Services

Administrator  apply version updates to a host.* Apply Version Upgrades to a Host

* You can perform these tasks in the current view.
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Related Topics:
e Services View

e Hosts and Services Set Up Procedures

e Hosts and Services Maintenance Procedures

Quick Look

This is an example of the Hosts view.

NETWITNESS

+ -0 leEEe] - 7 o dwe doo @
- ~ Upaate Homk ” Serviet  CureneVernon  Lipdste Yeron Suna
A O | Checkfor Updates
Y SAVTIA T—TS TS 1WA 24675 nre
©

Groups Panel Toolbar - Provides options to work with host groups in the list.
Groups Panel - Lists all host groups currently in your deployment.

Hosts List Toolbar - Provides options to work with the Hosts list.

n Hosts List - Lists all hosts currently in your deployment.

Groups Panel Toolbar

e Towemn

+ Displays a new row in the Groups panel in which you enter the name of a new
group.
- Asks for confirmation that you want to delete the group. You can confirm or

cancel the deletion.

3 Opens the field for renaming the selected preexisting group. You can also double
click on the group name in the Groups panel to rename the group. Changes take
effect immediately.

F Refreshes the Groups panel to reflect the changes and goes back to the All group

view. Changes take effect immediately.
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Groups Panel

The Groups panel provides a logical way to organize hosts, such as by function, geography, or project.
Once hosts are grouped, it is easier to perform operations on multiple hosts by interacting with each host
in a group rather than individual hosts from an non-grouped list. You can drag a host from the Hosts list
to add it to a group. A host may belong to more than one group.

Note: In NetWitness Live, groups can subscribe to resources while individual hosts cannot.

Column
Title

Description

Name The host groups are displayed in the Groups panel. The number next to each group
name displays the number of hosts that added to the group.

Hosts List Toolbar

The Hosts list toolbar contains the tools that you use to maintain the hosts in your NetWitness
deployment.

T

This drop-down list displays two options.

« Remove Host: Deletes the selected host from both
the host group and the Hosts list altogether. All
related services will be removed as well.

¢ Remove From Group: Removes the selected host
from the host group. The Host will still be
available in the Hosts list.

Changes take effect immediately.

Z Opens the Edit Host dialog in which you edit a host or
service identification and basic communication
settings. See Step 1. Deploy a Host for more
information.

2 Install Opens the Install Services dialog from which you can
install a service on a deployed host. See Step 2. Install
a Service on a Host for more information.
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T

L e This drop-down list displays three options.

Update Host
Pre Stage Host

| e | e Update Host: Updates the selected hosts with the
version you select in the Update Version column.

* Pre-Stage Host: Pre-stage the upgrade repository
by downloading the required packages without
affecting the system.

e Check for Updates: Checks the Local Update
Repo for the latest updates available from
NetWitness.

Changes take effect immediately. See Apply Version
Upgrades to a Host for more information.

& Discover Most of the time, the Discovery function completes
automatically and you do not need to click

Q@ Discover

For a fresh installation, click Discover to access the
Provision dialog box so you can complete the
provisioning phase. After the provisioning phase,
NetWitness automatically discovers services running
on the host and you do not need to click Discover.

&8 Reboot Host Restarts the host immediately.

Entering a Name or Host here filters the list. This

Filter X . .
er field allows you to quickly find a particular host.

Hosts List

(] Select the host by clicking the corresponding checkbox in this column. To select
all of the hosts, select the checkbox in the header.

Name Displays the name of the host that was given when the host was installed. This
column is organized in alphabetical order by default. Click the Name column title
to view in reverse alphabetical order.

Host Displays the IP address of each host.

Services  Displays the number of services added to the host.

Current  Displays the version that the host is currently on.
Version

Update Displays a drop-down list of versions that the user can upgrade to. See Apply
Version  Version Upgrades to a Host for more information.
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Status Displays whether or not the host is upgraded to the most current version. If the
host is on the most current version, then the Status displays "Up-to-Date".
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Services View

You set up and maintain the NetWitness services in the Services view. In the Services view, you can:

* Quickly search for and locate a specific service or type of service, such as Log Decoder or Warehouse
Connector.

¢ Use shortcuts to get to administration tasks.

e Add, edit, and remove services.

e Sort services by name and host.

 Filter services by type, name, and host.

e Start, stop, and restart services.

A service performs a unique function, such as collecting logs or archiving data. Each service runs on a

dedicated port and is modeled as a plug-in to enable or disable, according to the function of the host.
You must configure the following Core services first.

NW Server

Admin Implemented with the NW Server
Config Implemented with the NW Server
Content Implemented with the NW Server
Integration Implemented with the NW Server
Investigate Implemented with the NW Server
License Implemented with the NW Server
Orchestration Implemented with the NW Server
Reporting Engine

Respond Implemented with the NW Server
Security Implemented with the NW Server
Analyst UI

Broker Implemented with the Analyst Ul
Investigate Server Implemented with the Analyst Ul
NetWitness Ul Implemented with the Analyst Ul

Reporting Engine
Respond Server

Implemented with the Analyst Ul
Implemented with the Analyst Ul

Archiver

Archiver Core Service
Workbench

Broker

Broker Core Service
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Concentrator

Concentrator Core Service
Endpoint

Endpoint Server

Endpoint Broker

Endpoint Broker Server

Endpoint Log Hybrid

Log Collector Core Service

Log Decoder Core Service
Endpoint Server

Concentrator Core Service
ESA Primary

Contexthub
ESA Correlation

ESA Secondary

ESA Correlation

Log Collector

Log Collector Core Service

Log Decoder

Log Collector

Log Decoder Core Service

Log Hybrid

Log Collector

Log Decoder Core Service

Concentrator Core Service

Log Hybrid - Retention Deployed on Series 6 Hybrid hardware with Log Hybrid-Retention
Optimization.

Log Collector

Log Decoder Core Service

Malware Analysis

Malware Analysis
Broker Core Service

Network Decoder
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Decoder (Packets) Core Service
Network Hybrid

Concentrator Core Service
Network Decoder Core Service

New Health and Wellness

Metrics Server

UEBA

UEBA

Warehouse Connector

Warehouse Connector Command line installation

You must configure hosts and services to communicate with the network and each other so they can
perform their functions such as storing or capturing data. For information about ports and a
comprehensive list of ports for all services, see "Network Architecture and Ports" in the Deployment
Guide for NetWitness Platform. Go to the NetWitness All Versions Documents page and find
NetWitness Platform guides to troubleshoot issues.

Workflow

This workflow shows the procedures you complete to set up and maintain a service. Adding a service to
a host is the first task in this workflow. The hosts with Core services are set up out-of-the-box. After
that, you can set up additional services on hosts to enhance your NetWitness deployment.

Services View

Hosts View

Maintain a Service

Set Up a Host Maintain a Host

You are here

What do you want to do?

rroe i

Administrator  set up a host. Setting Up a Host

Administrator ~ maintain a host. Maintaining Hosts

Administrator  maintain a service.* Maintaining Services
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* You can perform these tasks in the current view.

Related Topics
e View Topology Details

e Hosts View

» Hosts and Services Set Up Procedures

e Hosts and Services Maintenance Procedures

See the following NetWitness guides for detailed information on individual services. Go to the
NetWitness All Versions Documents page and find NetWitness Platform guides to troubleshoot issues.

Archiver Configuration Guide

Broker and Concentrator Configuration Guide

Context Hub Configuration Guide
Decoder Configuration Guide
Endpoint Configuration Guide

Event Stream Analysis (ESA) Configuration Guide

Malware Analysis Configuration Guide
Log Collection Configuration Guide
Malware Analysis Configuration Guide
Reporting Engine User Guide
NetWitness Respond Configuration Guide
NetWitness UEBA User Guide
Workbench Configuration Guide

Warehouse Connector Configuration Guide

Quick Look

This is an example of the Services view.

NETWITNESS nvestigate

Respond  Users  Hosts  Files

Dashboard ~ Reports

HOSTS SERVICES EVENT SOURCES ENDPOINT SOURCES HEALTH & WELLNESS SYSTEM SECURITY
Groups Services
+ - 1 =’4*4- =z Iter X I
Name '/u n—'l Name Licensed | Host Type Version Actions I
Sau 20 ) Adm Admin Server 11.5.0.0 o]
Scroup2 0 - Broker 11.5.0.0 el
_ Config Server 11.5.0.0 e
- Content Server 11.5.0.0 o)
Integration Server 11.5.0.0 o
Investigate Server 11.5.0.0 o
- License Server 11.5.0.0 e
Orchestration Server 11.5.0.0 el d
| Page 1 |of1 | | C Displaying 1 - 20 of 20
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Groups Panel Toolbar - Provides options to work with service groups in the list.
Groups Panel - Lists all service groups currently in your deployment.

Services List Toolbar - Provides options to work with the Services list.

W scrvices List - Lists all services currently in your deployment.

Groups Panel Toolbar

e Towemn

+ Displays a new row in the Groups panel in which you enter the name of a new
group.
- Asks for confirmation that you want to delete the group. You can confirm or

cancel the deletion.

z Opens the field for renaming the selected preexisting group. You can also double
click on the group name in the Groups panel to rename the group. Changes take
effect immediately.

F Refreshes the Groups panel to reflect the changes and goes back to the All group
view. Changes take effect immediately.

Groups Panel

The Groups panel provides a logical way to manage groups of services, such as by function, geography,
or project. After you create a group, you can drag individual services from the Services panel into the
group. A service may belong to more than one group.

Column -
. Description
Title
Name The service groups are displayed in the Groups panel. The number next to each

group name displays the number of hosts that added to the group.

Services List Toolbar

This topic introduces the options in Services list toolbar to add, remove, edit, and get a license for
services. You can also filter the services listed in the Services list.

4
To access the Admin Services view, in NetWitness, go to (Admin) > Services. The Services list
toolbar is at the top of the Services list in the Services view.

e

=+ Adds a service for your deployment of NetWitness to manage. See Step 2. Install a
Service on a Host,

- Deletes a service from your deployment of NetWitness. See Edit or Delete a Service.
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e Jowamn

L7 Edits service identification and basic communication settings.

T« rirer % Filters the services listed in Services view.
In the Filter drop-down list, you can filter the services by one or more selected service
types. In the Filter field, you can filter the services by Name and Host. You can use the
Filter drop-down list and the Filter field at the same time to filter the services listed in
the Services view.

Services List

O]

Online/Offline
Indicator

Name

Licensed

Host

Type
Version

Actions

Topics

Select the service by clicking the corresponding checkbox in this column. To
select all of the services, select the checkbox in the header.

Displays " if the service is online.

Displays ® if the service is offline.

Displays the name of the service that was given when the service was
installed. This column is organized in alphabetical order by default. Click the
Name column title to view in reverse alphabetical order.

Displays  if the service is licensed.

Displays ® if the service is not licensed. If one or more services are not
licensed, a red banner will appear at the top of the screen that will prompt
you to fix this.

@ One or more services are not licensed. For more information, see License Details @

Displays the host name that the service belongs to.

Displays the service type.

Displays the version that the service is currently on.
Use drop-down list to:

* Navigate to the different service views (System, Stats, Config, Explore,
Logs, Security) See View Topology Details for more information.

* Delete, edit, start, stop, and restart a service. See Start, Stop, or Restart a
Service for more information.

o Edit Service Dialog

¢ Services Config View
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e Services Explore View

e Services Logs View

e Services Security View

¢ Services Stats View

e Services System View
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Edit Service Dialog

NetWitness services are automatically discovered in NetWitness.

Q
You can use the Edit Service dialog to modify services. To access the Edit Service dialog, go to

(Admin) > Services and click lil‘ in the Services list toolbar.
Workflow
Hosts View Services View

Set Up a Host Maintain a Host Maintain a Service

You are here

What do you want to do?

T T ey

Administrator ~ set up a host. Setting Up a Host

Administrator ~ maintain a host. Maintaining Hosts

Administrator ~ maintain a service. Maintaining Services

Administrator  edit a service.* Edit a Service
* You can perform these tasks in the current view.
Related Topics:

e Services View

e Hosts and Services Set Up Procedures

e Hosts and Services Maintenance Procedures
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Quick Look

Edit Service

Service Eroker
Host localhostlocaldomain
Name Broker

Connection Details

na

Port 5003

Test Connection

Cancel Save

The following list describes the features of the Add Service or Edit Service dialogs.

Field or Description
Option

Service Displays the service type. You can add the following services: Archiver, Broker,
Concentrator, Network Decoder, Event Stream Analysis, Incident Management, [IPDB
Extractor, Log Collector, Log Decoder, Malware Analysis, Reporting Engine,
Warehouse Connector, and Workbench.

Host Specifies the host on which the service resides.

Name Specifies the name used to identify the service, for example, Broker, An
understandable naming convention can make administrative tasks easier. Some
administrators find it convenient to use the hostname or IP address (specified in the
Host field) for the Name as well.

Port Specifies the port used to communicate with this service. The default port, based on
the selected service type in the Service field, is autofilled here. If you select SSL
below, this port becomes an SSL port. If you do not select SSL, it becomes a non-SSL
port. You can customize this port by opening a firewall for the port that you add. For
information about ports, see "Network Architecture and Ports" in the Deployment

Guide,.
SSL Indicates that NetWitness uses SSL for communications with this service.
Username Specifies the username used to log in to this service. The default username is admin,
Password Specifies the password used to log in to this service. The default password is
netwitness,
Test Tests the connection of a service that you are adding.
Connection
Cancel Closes the Add Service or Edit Service dialog. If you do not save the service before

closing the dialog, the service is not added or edited.
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Field or Description
Option

Save

Adds a new service or saves changes to existing service.
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Services Config View

The Services Config view is one of the views available from the Kl (Admin) > Services > T
provides a user interface for configuring all aspects of a Core service or NetWitness service.

The configuration options in the Services Config view are organized as tabs, with each tab providing a
view of a set of related parameters. Unlike the Services Explore view, which offers direct access to all
configuration files for a service, these tabs present the most commonly modified parameters of service
configuration in a user-friendly view.

Due to configuration requirements for different services; each type of service has variations in available
tabs and configuration parameters in this view. Individual topics describe configuration parameters that
are specific to a host (Brokers, Concentrators, Network Decoders, Log Decoders, and Archivers) or
service (for example, Reporting Engine, IPDB Extractor, Log Collector, and Warehouse Connector).

Workflow

Hosts View Services View

Set Up a Host Maintain a Host Maintain a Service

You are here

What do you want to do?

oo

Administrator set up a host. Setting Up a Host

Administrator ~ maintain a host. Maintaining Hosts

Administrator maintain a service. Maintaining Services

Administrator ~ configure an Archiver service. See Archiver Configuration Guide.

Administrator ~ configure a Broker service. See Broker and Concentrator Configuration
Guide.

Administrator ~ configure a Concentrator service. See Broker and Concentrator Configuration
Guide.

Administrator ~ configure a Context Hub service. See Context Hub Configuration Guide,

Administrator  configure an Endpoint Broker See Endpoint Configuration Guide,

service.
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T T e S

Administrator  configure an Endpoint Log Hybrid See Endpoint Configuration Guide.
service.

Administrator configure an ESA Primary service. See ESA Configuration Guide,

Administrator conﬁgure an ESA Secondary service. See ESA Conﬁgumtion Guide.

Administrator  configure a Log Collector service. See Log Collection Configuration Guide,

Administrator ~ configure a Log Decoder service. See Decoder Configuration Guide

Administrator ~ configure a Malware Analysis See Malware Analysis User Guide.
service.

Administrator  configure a Network Decoder See Decoder Configuration Guide.
service.

Administrator  configure a Reporting Engine See Reporting Engine Configuration Guide,
service.

Administrator  configure a Respond service. See NetWitness Respond Configuration

Guide.

Administrator configure a UEBA service. See NetWitness UEBA User Guide.

Administrator ~ configure a Warehouse Connector See Warehouse Connector Configuration
service. Guide.

Administrator  configure a Workbench service. See Workbench Configuration Guide.

Go to the NetWitness All Versions Documents page and find NetWitness Platform guides to
troubleshoot issues.

Related Topics
o Edit Service Dialog

e Services Explore View

e Services Logs View

e Services Security View

¢ Services Stats View

e Services System View

e Services View

Quick Look

This is an example of the Services Config view for a Network Decoder.
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NETWITNESS vestiga 5 e File:

HOSTS SERVICES EVENT SOURCES ENDPOINT SOURCES HEALTH & WELLNESS SYSTEM SECURITY

1. Change Service B Decoder Config

Files Data Retention Scheduler Network Rules App Rules  Correlation Rules

Config Value

e Name

3 ALERTS
3 DHCP
3 DNS

- 3 Entropy

3 FeedParser

Naracdar Canfien iratiorm 3 fingerprint_office_lua
vecoder Lonigurado

3 fingerprint_pdf_lua
Name Config Value

3 fingerprint_rar_lua

3 fingerprint_rtf_lua

3 fingerprint_zip

3 FTP

3 GeolP

3 GeolP2

3 GTalk

3 H323

v 3 HTTP
» »

NETWITNESS vestigat Users  Hosts  Files  Dashboard  Reports % @ adwin>

HOSTS SERVICES EVENT SOURCES ENDPOINT SOURCES HEALTH & WELLNESS SIS SECURI

Change Service @ Concentrator | Config

Files Data Retention Scheduler  Correlation Rules  Appliance Service Configuration

+ = 7 © tonService & Toggle Service ® Start Aggregation Name Conng vae

AgEregate Autostant
p-address 56.. 0 186 0 no consumi

p-address 56.. 0 24.. 0 no consumi

Name Conng vatse
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Note: Although both examples show the Services Config view, the tabs and panels are different for
each. Refer to the respective guides for detailed instructions on how to configure a particular Services
Config view.

Topics

e Services Config View - Appliance Service Configuration Tab

o Services Config View - Data Retention Scheduler Tab

e Services Config View - Files Tab

Services Config View - Appliance Service Configuration Tab
The Appliance Service Configuration tab appears in the Services Config view for the Archiver, Broker,
Concentrator, IPDB Extractor, Network Decoder, Log Collector, and Log Decoder services.

This topic lists and describes the available configuration parameters for the NetWitness Core Appliance
service. The NetWitness Core Appliance service provides hardware monitoring on legacy NetWitness
hardware.

Workflow

Hosts View Services View

Set Up a Host Maintain a Host Maintain a Service

You are here

What do you want to do?

T T e

Administrator  set up a host. Setting Up a Host

Administrator ~ maintain a host. Maintaining Hosts

Administrator =~ maintain a Maintaining Services
service.*

Administrator ~ view or modify See "Services Config View - Appliance Service Configuration
appliance service Tab" in the Hosts and Services Getting Started Guide for
parameters.* Version 10.xand prior.
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Administrator specify how long to See "Configure Data Retention" in the Data Privacy

retain database Management Guide.
records. For information about the Data Retention tab for Archiver, see
"Data Retention Tab - Archiver" in the Archiver Configuration
Guide.
Administrator  edit . xml and Edit Core Service Configuration Files

- lua files.
* You can perform these tasks in the current view.

Related Topics

e Services Config View - Data Retention Scheduler Tab

e Services Config View - Data Retention Scheduler Tab

e Services Config View - Files Tab

e Services Config View

Quick Look

This is an example of the Appliance Service Configuration tab for a Broker.

NETWITNESS

HOSTS SERVICES EVENT SOURCES ENDPOINT SOURCES HEALTH & WELLNESS

&+ Change Service | I adminserver-Broker | Config @
General Files Appliance Service Configuration
Name Config Value
Compression 0
Port 50006
SSL Port 56006
Stat Update Interval 1000
Threads 20
Apply

The following list describes the configuration values for this tab.
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Compression

Port

SSL FIPS
Mode

SSL Port

Stat Update
Interval

Threads

Description of Configuration Value

Compresses a message when it reaches the positive number (in
bytes) that you specify.

Unencrypted listening port.
0 indicates that the port is disabled.

One of the parameters you need to enable or disable Federal
Information Processing Standards (FIPS). For detailed instructions,
see "Activate or Deactivate FIPS" in the System Maintenance
Guide.

SSL (Secure Sockets Layer) listening port.

0 indicates that the port is disabled. SSL is the standard security
technology for establishing an encrypted link between a web server
and a browser. This link ensures that all data passed between the
web server and browsers remain private and integral.

How often (in milliseconds) the system updates statistic nodes for
monitoring Health and Wellness.

Threads in thread pool required to used to handle requests. The
Threads parameter works with the Polling Interval parameter
for event and log threads.

Services Config View - Data Retention Scheduler Tab

When
Changes
Take Effect

The next time
you connect to
this service.

Upon restart of
the service.

Upon restart of
the service.

Upon restart of
the service.

Immediately.

Immediately.

The Data Retention Scheduler tab appears in the Services Config view for the Network Decoder, Log
Decoder, and Concentrator.

In the Data Retention Scheduler tab, you can define the criteria for removing database records from
primary storage on Network Decoder, Log Decoder, and Concentrator services, and schedule the timing
for checking the threshold.

Note: If additional customization is necessary, use the Scheduler under the Files tab in the Services
Config view. For example, if you have storage available to save the RAW data versus the metadata,
use Capacity as the threshold and to set different thresholds per database (metadata versus packet).
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Workflow

Services View

Hosts View

Set Up a Host Maintain a Host Maintain a Service

You are here

What do you want to do?

o i ommeen

Administrator set up a host. Setting Up a Host

Administrator ~ maintain a host. Maintaining Hosts

Administrator =~ maintain a Maintaining Services
service.*

Administrator  view or modify See "Services Config View - Appliance Service Configuration
appliance service  Tab" in the Hosts and Services Getting Started Guide for
parameters. Version 10.x and prior.

Administrator  specify how long See "Configure Data Retention" in the Data Privacy
to retain database =~ Management Guide.

records.* For information about the Data Retention tab for Archiver, see
"Data Retention Tab - Archiver" in the Archiver Configuration
Guide.
Administrator  edit .xml and Edit Core Service Configuration Files
. lua files.
Related Topics

e Services Config View - Appliance Service Configuration Tab

e Services Config View - Files Tab

e Services Config View

Quick Look

The following figure illustrates the parameters in the Data Retention Scheduler tab for a Concentrator.
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NETWITNESS mestigate R Users  Hosts s Dashboard  Reparts 0 B X

HOSTS SERVICES EVENT SOURCES ENDPOINT SOURCES HEALTH & WELLNESS

-+ Change Service | concentrator1 - Concentrator | Config

General Files DEICIEChI( N« L@  Correlation Rules  Appliance Service Configuration

Define the rollover criteria for removing database records from primary storage using an age-based threshold, and schedule the
timing for checking if the threshold has been reached.

Threshold (® Duration O Date

Days c Hours z Minutes c
Run @ Interval (L Date & Time

Hours L Minutes 15 >

Apply Reset

The Data Retention Scheduler tab has sections to specify Threshold settings and Run settings. The
following table lists the parameters supported for data retention configuration.

Threshold The threshold is based on the age of the data, the amount of time the data was stored
or the date on which the data was stored. The date is from the database file, not from
the actual session time.
¢ Duration: The duration of time that data can be stored before removal.

Specifies the number of days (365 maximum), hours (24 maximum), and minutes
(60 maximum) that have elapsed since the time stamp on the data.

¢ Date: The removal of data based on the date of the timestamp.

Specifies the monthly date and time in the and : fields.

Run The schedule for running the job that checks rollover criteria.

e Interval: Schedule the database check to occur at a regular interval.
Specifies the hours and minutes between the scheduled checks.

e Date and Time: Schedule the database check to occur at a regular day and time.
Specifies the day from the drop-down list and the system clock time
in hh:mm: ss format. Possible values for day are Everyday, Weekdays,
Weekends, and Custom, where Custom allows you to select one or more specific
days of the week.
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Apply Overwrites any previous schedule for this service and applies the new settings
immediately.

Caution: After you apply these settings, when the threshold is met the system
deletes the old data from the database and you can no longer access it.

Reset Resets the schedule to the last applied state.

Services Config View - Files Tab

The Files tab appears in the Services Config view for Archivers, Brokers, Concentrators, Log Decoders,
and Network Decoders.

In the Files tab, you can edit service configuration files as text files. The files you can edit vary

depending upon the type of service you are configuring. The following files are common to all Core
services.

e The NetWitness file (netwitness)

e The service index file (index-<service>)
¢ The scheduler file (scheduler)

e The crash reporter file (crashreporter)

* The feed definitions file (feed-definitions)

In addition, the Decoder has files that configure parsers, feed definitions, and a wireless LAN adapter.

Note: The default values in the configuration files cover most common situations. You may need to
edit configuration parameters and values for optional services, such as the crash reporter or
scheduler. Do not change these values in the Files tab unless you understand networks and the factors
that affect the way services collect and parse data.

More detail on the service configuration parameters is available in the Service Configuration Settings.
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Workflow

Services View

Hosts View

Set Up a Host Maintain a Host Maintain a Service

You are here

What do you want to do?

oo

Administrator set up a host. Setting Up a Host

Administrator ~ maintain a host. Maintaining Hosts

Administrator =~ maintain a Maintaining Services
service.*

Administrator  view or modify See "Services Config View - Appliance Service Configuration
appliance service Tab" in the Hosts and Services Getting Started Guide for
parameters. Version 10.xand prior.

Administrator  specify how long See "Configure Data Retention" in the Data Privacy
to retain database =~ Management Guide.

records. For information about the Data Retention tab for Archiver, see
"Data Retention Tab - Archiver" in the Archiver Configuration
Guide.
Administrator  edit . xm1 and Edit Core Service Configuration Files
. lua files.*
Related Topics

o Services Config View - Data Retention Scheduler Tab

e Services Config View - Data Retention Scheduler Tab

e Services Config View

Quick Look

This is an example of the Files tab.
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NETWITNESS

SERVICES
+ Change Service | B concentrator1 - Concentrator | Config
General Data Retention Scheduler  Correlation Rules  Appliance Service Configuration
index-broker-custom.xml v | Concentrator v| @ GetBackup | — Push
<?xml version="1.0" encoding="ut%-8"7> -
<language level="IndexNone" defaultAction="Aut0">
<!

Custom Index Language Definition File 10.6 (December, 2015)

<language> root node which specifies any defaults found in key nodes
<key> child node of language
name = Name of the key (maxis 16 chars)

which can have the fo owing attributes:

description = Description of the key (max is 256 bytes, strings encoded as UTF-8)
format = Type format of the value which can be:

nt8, Uint8, Int16, UInt16, Int32, Uint32, Inté4, Uintéd, Uint128

Float32, Floate4, TimeT, Binary, Text, IPv4, IPvE, MAC
evel = The index level for the key. If not defined, it will be set to IndexNone.

ndexNone - Defaultindex level which provides no indexing

ndexKeys - Provide indexing e.g.. identify

highly efficien

ons have values, but do not track

. T

the actual values
queries for other operators

queries, but slower

ike: key
ndexValues - Highest indexing level. Provides the best performance for all query operators but also takes

| ey |
Files Tab Toolbar

The Files tab has a toolbar and an edit window. This is an example of the toolbar.

index-concentrator.xml v | Concentrator v B GetBackup | 'E Push

These are the features of the Files tab toolbar.
Description

File drop-  Displays a list of files that the system is currently using. When you select a file, the text
down list of the file is displayed in the text edit window. In the text window, you can edit the file
and save the changes, or create alternate files to use.

Service / Displays the service type and host. You can open a file from either the service or the host
Host drop-  for editing.
down list

@ cetBackup  Retrieves the latest backup of the current file, which can prove useful when you have
made changes and want to go back to the previous version of the file. The backup does
not replace the current file unless you click Save,

"Ef' Push  Displays a dialog in which you can select services of the same type and push the
e currently viewed file to the services.

Apply Overwrites the current file and creates a backup file.
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Services Explore View

: . : : . D o v
You can use the NetWitness Services Explore view ( K&l (Admin) > Services, L > View
> Explore) to display and edit both host and service configurations.

The Services Explore view offers advanced access and control of all NetWitness hosts and services. All
services expose their functionality through a treelike series of nodes, similar to the Windows Explorer
view of a Windows file system. Here you can:

* View a directory tree showing common files for all selected services.

e Navigate down through the directory to a file.

* Open the same file for each service, and display the contents side by side.
¢ Select an entry in the file and edit the value.

* Apply a property value from one service to other services.

The Services Explore view can also display a Properties dialog, a simple interface for viewing
properties of any node in the system and sending messages to the node.

Caution: A good understanding of the nodes and parameters is required when editing in this view.
Incorrect settings can cause performance problems.

Workflow

Hosts View Services View

Set Up a Host Maintain a Host Maintain a Service

You are here

What do you want to do?

T T

Administrator set up a host. Setting Up a Host

Administrator  maintain a host. Maintaining Hosts

Administrator  maintain a service. Maintaining Services

Administrator  view and edit host and service Explore and Edit Service Property
configurations.* Tree

* You can perform these tasks in the current view.
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Related Topics
e View Topology Details

e Edit Service Dialog

e Services Config View

e Services Logs View

e Services Security View

¢ Services Stats View

e Services System View

¢ Services View

Quick Look

NETWITNESS mvestigale  Respond  Users  Hosts  Fles  Dashboar

HOSTS SERVICES EVENT SOURCES ENDPOINT SOURCES

-+ Change Service | B concentrator! - Concentrator | Explore ~

database

deviceappliance

B[] database

B[] deviceappliance
a[ince rest

B[ logs sak

O
09
"

B[ rest services
a[)sdk storedproc
B[] services sys

&[] storedproc users

B sys
B[ Jusers

The Services Explore View has two main panels:
* The Node list
¢ The Monitor panel

You can right-click on a file to access the Properties for the file. See Services Explore View - Properties
Dialog for more information.

The Node List

The Node list displays the services as a tree-like series of nodes and folders. The levels in the Node list
expand and collapse to display the full hierarchy.
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%= Concentrator

Ei&l Concentrator (Concentrator)
B [Jconcentrator
BE connections
B IP address

B[] sessions

B[] IP address
@[] Port
@[] Port
@[] Fort
@[ Port
B[] database
B[] deviceappliance
DE] ndex
B[ Jlogs
B ) res:
B[] sdk
B[] services

DDV.:&":

Each root folder is named based on the functionality it exposes. For instance, the /connections folder
shows all connected IP addresses. Underneath each IP address or port in the list are two folders,
sessions and stats.

* The sessions folder displays all authenticated user sessions originating from the IP/Port.
e The stats folder displays values, such as the number of messages sent or received, bytes sent or

received, and other values set by the service. These are not editable.

Selecting any folder in the tree view displays its children in the Monitor panel. Every node in the tree is
actively monitored, so when a statistic or configuration node changes value, it is immediately reflected in
the tree and Monitor panel.

The Monitor Panel

The Monitor panel displays properties and values for a selected node (such as index) and a child folder
(such as config). There are two ways to edit values:

e Click the value and type a new value

* Send a set message in the Properties dialog
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findex/config Concentrator
index.dir /var/netwitness/concentrator/index=2.89 TB
index.dir.cold

index.dir.warm

index.slices.open 42

page.compression huffhybrid

reindex.enable true

save.session.count auto
Topics

e View Topology Details

Services Explore View - Properties Dialog

You can use the Services Explore view > Properties dialog to perform the following tasks.
* Send messages to a system node
e Retrieve values for a property for multiple services

» Set values for a property for multiple services

Right-click any file in the Node list or Monitor panel to display the Properties context menu.

findex/Config

in dE:" all i an

_ Properties
indes

index.dirwarm

When you select Properties from the Node list or Monitor panel context menu, the Properties dialog
opens below the Monitor panel. All nodes have support help that contains the following information.

¢ A description of the node
» The list of supported messages with a corresponding description

* Security roles needed to access the messages

The available messages vary according to the service and root folder. Many of these messages are also
accessible as options with a NetWitness dashboard or view.
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Workflow

Hosts View Services View

Set Up a Host Maintain a Host Maintain a Service

You are here

What do you want to do?

T T N

Administrator  set up a host. Setting Up a Host
Administrator maintain a host. Maintaining Hosts
Administrator  maintain a service. Maintaining Services
Administrator send messages to a system node.* Explore and Edit Service Property
Tree
Administrator  retrieve values for a property for multiple Explore and Edit Service Property
services.* Tree

Administrator  set values for a property for multiple services.* Explore and Edit Service Property
Tree

* You can perform these tasks in the current view.

Related Topics

e Services Explore View

The following example shows the Properties dialog with information in Message Help displayed.
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NETWITNESS

SERVICES

Report

-+ Change Service | & Concentrator Explore &

= Concentrato
Bici Concentrator
B[ Jconcentrator
B[] connections
B & database
[ config
stats
B[] deviceappliance
B[ Jindex
B[ Jlogs
B[ ]rest
B[] sdk

B[] services

——~—
4

/database/config Concentrator

hash.dir ‘
< >

Properties for Concentrator /database/config/meta.dir. , X

help v Parameters

Message Help

Describes this node and its supported messages. NOTE: Command parameters are passed as
<parameter1>="<yalue>" <parameter2>="<value>" etc., where <value> must be in double

quotes if there is whitespace. To pass a quote in the value, you must escape it by preceding it
with a backslash \. -

-

Response Output

description:The directory where the meta database is stored (separate multiple dirs with ~
semicolon). Optional assigned max size (=#unit), units are: t for TB; g for GB, m for MB. Change

of size takes effect immediately, adding or removing directories takes effect on service restart.
security.roles:database.manage,everyone v

»

The Properties dialog has the following features.

Message drop-
down list

Parameters
input field

Message Help

Response
Output

Description

Lists all available messages for the current node. Select a message from this drop-
down list to send to the node.

Type the message parameters in this field.

Sends the message to the selected node.

Displays help text for the current message.

Displays the response to a message or output from a message.
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Services Logs View

The Services Logs view provides the ability to view and search the logs for a specific service. The

a4
Services Logs view is identical to the System Logging panel ( (Admin) > System tab > System
Logging) with two exceptions:

* The Services Logs view has an additional filter to select messages for the service or host.

e The System Logging panel has an additional tab for Settings.

For a complete description of NetWitness logging features in the System Logging panel, see "Monitor
Health and Wellness of NetWitness Platform" in the System Maintenance Guide.

Workflow

Hosts View Services View

Set Up a Host Maintain a Host Maintain a Service

You are here

What do you want to do?

(T T S

Administrator set up a host. Setting Up a Host

Administrator maintain a host. Maintaining Hosts

Administrator maintain a service. Maintaining Services

Administrator ~ view and search the logs See "Monitor Health and Wellness of NetWitness
for a specific service.* Platform" in the System Maintenance Guide

* You can perform these tasks in the current view.

Related Topics
o Edit Service Dialog

¢ Services Config View

e Services Explore View

e Services Security View

e Services Stats View
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e Services System View

e Services View

Quick Look

The following figure shows the Services Logs view Realtime tab.

NETWITNESS vestigate  Responc sers  Hosts  Files  Dashboard ~ Reports

HOSTS SERVICES EVENT SOURCES ENDPOINT SOURCES HEALTH & WELLNE S A SECURITY

& Change Service | Concentrator Logs ©

System Logging

Historical
ALL v || Keywords Concentrator v | Search
Timestamp Level Message
2020-01-06T15:23:29.000 DEBUG 1 90.5% streams 1 meta-000047533.nwmdb
2020-01-06T15:23:34.000 AUDIT

-06T1 DEBUG  Stream hit obj 8
2020-01-06T1 AUDIT User admin (session 509380, 1
2020-01-06T1 INFO
2020-01-06T DEBUG
2020-01-06T15: INFO Accepting connection from trusted peer 10.237.178.100 with subject name C=US, ST=VA, L =

4:02.000 DEBUG Trusted user admin has been granted QT: 60 ST: 0 QP: QPri: 20 N

The following figure shows the Services Logs view Historical tab.

NETWITNESS Investigate ~ Respond Hosts es  Dashboard  Rey
SERVICES EVENT DURCES ENDPOINT SOURCES HEALTH & WELLNESS S N SECURITY

% Change Service Concentrator Logs «

System Logging

Realtime Historical
Er ALL v || Keywords Concentrator v »
IP address
Timestamp Level Message
2020-01-06T15:30:20.000 DEBUG IP address:38822 has received a ping command, a reply of 51 byte sent -
2020-01-C DEBUG treams 1 session-000003848.nwsdb
2020-01 DEBUG treams 1 meta-000047536.nwmdb
2020-01 AUDIT |IP address: 38822 has logged out
2020-01-06T1 DEBUG Closing |P address:38822 sent 1.42 GB over life of connection
2020-01-06T1 INFO Connection 419067 (IP address) ogged off user

Accepting connection from trusted pee (IP address)  with subjectname C=US,ST=VA L

| | C Displaying 9951 - 10000 of 10000
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e o

Realtime This is the monitor mode of the service log. For more information, see "System Logging
tab - Realtime Tab" in the System Maintenance Guide,

Historical  This is a searchable view of the service log. For more information, see "System Logging
tab - Historical Tab" in the System Maintenance Guide.
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Services Security View

In NetWitness, each service has a separate configuration of users, roles, and role permissions, which are
managed in the Services Security view.

To access service information and perform service operations through NetWitness, a user must belong to
a role that has permissions on that service. For NetWitness version 10.4 or later Core services that utilize
trusted connections, it is no longer necessary to create NetWitness Core user accounts for users that log
on through the web client. You only need to create NetWitness Core user accounts for aggregation, thick
client users, and REST API users.

Note: Only the default admin user in NetWitness is created by default on all services. As a prerequisite
to managing service security, the default admin user account must be present in the Admin Services
view. For every other user, you must configure access to each particular service through NetWitness.

Workflow

Hosts View Services View

Set Up a Host Maintain a Host Maintain a Service

You are here

What do you want to do?

CIR I T

Administrator  set up a host. Setting Up a Host
Administrator maintain a host. Maintaining Hosts
Administrator  maintain a service. Maintaining Services

Administrator ~ manage configuration of users, roles, and See the System Security and User
role permissions.* Management Guide.

* You can perform these tasks in the current view.

Related Topics

e Add, Replicate, or Delete a Service User

e Add a User Role to a Service

e Change a Service User Password

e Duplicate or Replicate a Service Role
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e Edit Service Dialog

e Services Config View

e Services Explore View

e Services Logs View

e Services Stats View

e Services System View

e Services View

Quick Look

The Services Security view has three tabs: Users, Roles, and Settings.

Roles and Service Access

Primary considerations in configuring service security are defining the roles and assigning users to the
roles. The Service Security view separates these two functions into the Users tab and the Roles tab.

 In the Users tab, you can add a user, edit user settings, change the user password, and edit the role
membership of the user for a selected service. Although you select a single service in the Services
Security view, you can apply the settings for one service to other services.

 In the Roles tab, you can create roles and assign permissions to the roles for a selected service.

Topics

e Services Security View - Users Tab

e Services Security View - Roles Tab

» Services Security View - Settings Tab

Services Security View - Users Tab

In the Services Security view Users tab, you can configure the following for a service:

* Add user accounts.

* Change service user passwords.

» Configure user authentication properties and query handling properties for the service.

» Specify the user role membership, which specifies the roles that the user belongs to on the selected
service.

Note: For version 10.4 or later NetWitness Core services that utilize trusted connections, it is no
longer necessary to create NetWitness Core user accounts for users that log on through the web client.
You only need to create NetWitness Core user accounts for aggregation, thick client users, and REST
API users.
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Workflow

Hosts View Services View

Set Up a Host Maintain a Host Maintain a Service

You are here

What do you want to do?

T T o

Administrator ~ set up a host. Setting Up a Host

Administrator maintain a host. Maintaining Hosts

Administrator  maintain a service. Maintaining Services

Administrator add user accounts.* Add, Replicate, or Delete a Service User

Administrator ~ change service user passwords.* Change a Service User Password

Administrator  configure user authentication See "Verify Query and Session Attributes
properties and query handling per Role" in the System Security and User
properties for the service.* Management Guide,

Administrator  specify the user role membership See "Add a User and Assign a Role" in the
(roles that the user belongs to on the  System Security and User Management
selected service).* Guide.

* You can perform these tasks in the current view.

Related Topics

e Services Security View - Roles Tab

e Services Security View - Settings Tab

e Services Security View
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Quick Look

NETWITNESS
SERVICES
= Change Service | ¥ broker - Broker
Roles Settings

+-1@ User Information

Username
Name Username

admin R
Administrator acmin

test Password Confirm Password
Ema

Administrator account for this service

<

Groups

¥  Administrators

Data_Privacy_Officers
DuplicateAdministrator
DuplicateAnalysts
Malware_Analysts
Operators

SOC_Managers %

The Users tab has a User List panel on the left. Selecting a username from the panel makes the User
Definition panel on the right available.

User List Panel
The User List panel has the following features.

Description

+ Adds a new user to the current service.

Deletes the selected users from the service.
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e Jown

o B Performs one of the following actions on the selected service user account:

¢ Replicate: Replicates the entire service user account to selected services.

¢ Change Password: Changes the password of a service user and replicates the new
password to Core services with that user account defined. The Change Password
option replicates only the password change to the Core services selected and does not
replicate the entire user account.

Username The usernames for all user accounts that access the service. The username must be one
used to log on to NetWitness.

The following figure shows the "Replicate User to other services" dialog.

Replicate User to other services

Please enter and confirm the service user password. The entire service user account
replicates to the selected services. The user password also changes on each selected
service.

Password

Confirm Password

L] Name ~ Address Type

[l Broker Broker

[7] Concentrator Concentrator

[[] Archiver Archiver

[] workbench Workbench

[[] Log Collector Log Collector

[] Log Decoder Log Decoder

[ Warehouse Connector Warehouse C...
NW — Malware A Malware A

Replicate

The following figure shows the Change Password dialog.
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Change Password

Please enter and confirm the service user password. Only the user password changes on the selected
services. No other user attributes will replicate to the services
Password
Confirm Password
Name ~ Address Type
Endpoint Log Hybrid — Log Decoder Log Decoder -
Log Decoder — Log Collector Log Collector
Log Decoder — Log Decoder Log Decoder
Log Hybrid — Concentrator Concentrator
Log Hybrid — Log Collector Log Collector
Log Hybrid — Log Decoder Log Decoder
Malware Analysis — Broker Broker
Network Decoder — Network Decoder Network Dec...
Network Hybrid — Concentrator Concentrator
Network Hybrid — Network Decoder Network Dec...
Remote LC (VLC) — Log Collector Log Collector -

Change Password

User Definition Panel

The User Definition panel has three sections:

e User Information identifies the user as created in the Admin Services Security view.
e User Settings define parameters that apply to this user's access to the service.

¢ Role Membership defines user roles to which the user belongs.

There are two buttons at the bottom of the panel:

e The Apply button saves the changes made in the User Definition panel, and they become effective
immediately.

¢ If you have not saved changes in the User Definition panel, the Reset button resets all fields and
settings to their values before editing.

User Information

The User Information section has the following features.

Description
Name The name of the user.
Username The username that this user enters to log in to the service. This is the NetWitness

username generated when the administrator added the user and the associated
credentials in the Admin Services Security view.
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o oo

Password The password that the user enters to log on to the service. This is the NetWitness
(and Confirm password generated when the administrator added the user and the associated
Password) credentials in the Administration Security view. The NetWitness account password

and the service password must match in order to allow the user to connect to the
service through NetWitness.

Email (Optional) The user's email address.

Description  (Optional) A general description field to describe this user.

User Settings

The User Settings section has the following features.

Fd | oscroton

Auth Type  The authentication scheme for this user. The product line supports internal and external
authentication.

e NetWitness Platform specifies internal authentication, and is enabled by default. In
this mode, all users must authenticate with the user account and passwords that are
generated when the administrator uses the NetWitness Admin Services Security
view to create the user and their associated credentials.

» External specifies that authentication is enabled through the host interface with
PAM (Pluggable Authentication Modules). For more information, see "Configure
PAM Login Capability" in the System Security and User Management Guide.

Core Query

! Note: This field was previously known as "SA Core Query Timeout" and does not
Timeout

appear for 10.4 and earlier service versions. NetWitness version 10.4 and earlier
services use "Query Level" instead.

Specifies the maximum number of minutes a user can run a query on the service. If this
value is set to 0, the query timeout is not enforced for the user on the service.

Query (Optional) Restricts query results seen by the user by appending the query syntax to
Prefix every query. For example, adding the query prefix email != 'ceolcompany.com'
prevents those email results from showing up in the sessions.

Session (Optional) Controls the behavior of the application when scanning meta values to

Threshold  determine session counts. If any meta value has a session count that is above the set
threshold, the determination of the true session count stops when the threshold is
reached.

If a threshold is set for a session, the Navigate view (INVESTIGATE > Navigate)
shows that the threshold was reached and the percentage of query time used to reach the
threshold.

Role Membership

The Role Membership section shows a list of all roles. The checkbox next to a role is selected for the
roles that a user is a member of for the selected service.
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Services Security View - Roles Tab

The Services Security view Roles tab enables you to create roles and assign permissions. Each role can
have different permissions for different services. For example, the Analysts role can have different role
permissions based on the selected service.

Before you can add users to roles, you need to define user roles, usually by function, and assign
permissions to the roles.

Procedures related to this tab are described in Add a User Role to a Service.

Workflow

Hosts View Services View

Set Up a Host Maintain a Host Maintain a Service

You are here

What do you want to do?

T T

Administrator ~ set up a host. Setting Up a Host
Administrator ~ maintain a host. Maintaining Hosts
Administrator ~ maintain a service. =~ Maintaining Services

Administrator define user roles.* Add a User Role to a Service

Administrator ~ assign permissions  See "Add a Role and Assign Permissions" in the System
to the roles.* Security and User Management Guide.

Administrator  add a user role to a  See "Add a Role and Assign Permissions" in the System
service.* Security and User Management Guide,

* You can perform these tasks in the current view.

Related Topics

¢ Duplicate or Replicate a Service Role

e Duplicate or Replicate a Service Role

e Services Security View - Users Tab
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e Services Security View - Settings Tab

e Services View

Quick Look

NETWITNESS

OSTS SERVICES

+ Change Service | ¥ concentrator1 - Concentrator | Security

+ -® Replicate 2
: Role Information
Role Name ~ Name

Administrators

Aggregation

Aggregation
D el -
Analysts Role Permissions
Data_Privacy_Officers -
e - Name Description

DuplicateAdministrator N

- v aggregate Allows aggregation of data =
DuplicateAnalysts N

— concentrator.manage Allows users to manage the concentrator service
Malware_Analysts o cTions. AlIOAWVE USers to man. onnections to the = c

connections.manage Allows users to manage connections to the service

Operators

database.manage VS users

to manage the system databases
SOC_Managers e -
everyone Special system role that includes all users

index.manage Allows users to manage the system index

logs.manage S users to manage logs

owner Special system role that includes only the owner
rules.manage Allows users to manage the concentrator rules
¥ sdk.content Allows users to access sdk content
sdk.manage Allows users to manage queries and the sdk subsy...
v sdk.meta Allows users to access sdk metadata
¥ sdk.packets Allows users to access raw packets or logs
services.manage Allows users to manage connections to other servi...
storedproc.execute Allow users to execute stored procedures

storedproc.manage Allow users to manage stored procedures

sys.manage Allows users to manage the system

The Roles tab has a Role Name panel on the left. Selecting a role name shows the Role Information
panel for the selected role on the right.

Role Name Panel
The Role Name panel has the following features.

Description

=+ Adds a new group to the current service.
- Deletes the selected group from the current service.
T:=j Copies a role and its assigned permissions to a new role. The name of the new role must

be unique. For example, you can copy the Analysts role and create another role with a
new name, such as Analyst Managers,
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e Jowan

Replicate  Pushes a role and its assigned permissions to other services. After you select a role and
click Replicate, the Replicate Role to other services dialog is displayed. In the dialog,
you can select the services where you want to replicate the role.

The following figure shows the Replicate Role to other services dialog.

Replicate Role to other services

[ Name ~ Address Type

[ Broker Broker

[ concentrator Concentrator
|:| Network Decoder Metwork Dec...
O Broker

Replicate

Role Information and Permissions Panel
The Role Information and Permissions panel defines role permissions.

There are two buttons:

¢ The Apply button saves the changes made in the Role Permissions panel and they become effective
immediately.

e If you have not saved changes in the Role Permissions panel, the Reset button resets all fields and
settings to their values before editing.

Topics

e Services Security View - Service User Roles and Permissions

e Services Security View - Aggregation Role

Services Security View - Service User Roles and Permissions

The Services Security view Roles tab enables you to create service user roles and assign permissions.
You can also use the pre-configured service user roles included with NetWitness to assign user
permissions.

Related Topics

e Services Security View - Aggregation Role

o Services Security View - Roles Tab

Service User Roles

NetWitness has the following pre-configured service user roles.
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Assigned

Permissions

Personnel/Account

Administrators

Aggregation

Analysts, Malware
Analysts, and SOC_
Managers

Data Privacy
Officers

Operators

All permissions

aggregate
sdk.content
sdk.meta
sdk.packets

sdk.meta
sdk.content
sdk.packets

storedproc.execute

sys.manage
users.manage
sdk.meta
sdk.content
sdk.packets
sdk.manage
logs.manage
database.manage

index.manage
dpo.manage

sys.manage
services.manage
connections.manage
users.manage
logs.manage
parsers.manage
rules.manage
database.manage
index.manage
sdk.manage
decoder.manage

archiver.manage

concentrator.manage

storedproc.manage

NetWitness System Administrator

You can use this role to create an Aggregation
account.

This role provides the minimum permissions
necessary to perform aggregation of data. It is
only available on NetWitness version 10.5 and
later services.

Users can use specific applications, run queries
and view content for purposes of analysis.

Data Privacy Officer

Data Privacy Officers have the dpo.manage
permission on Network Decoders and Log
Decoders.

Operators are responsible for the daily operation
of the services.
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Service User Permissions

There are many permissions that you can assign a service role in NetWitness. Users can have different
permissions on each service, depending on their role assignments and the permissions selected for each
role. This table describes the permissions that you can assign to a role.

e

sys.manage

services.manage

connections.manage

users.manage

aggregate

sdk.meta

sdk.content

sdk.packets

appliance.manage

decoder. manage

concentrator.manage

logs.manage

parsers.manage

rules.manage

database.manage

index.manage

sdk.manage
storedproc.execute
storedproc.manage

archiver.manage

Allows the user to edit the service configuration settings.
Allows the user to manage connections to other services.
Allows the user to manage connections to the service.

Allows the user to create individual users and user roles and specify user
permissions.

Allows the user to perform aggregation of data.

Allows the user to run queries in the Investigation and Reporting
applications and to view the metadata returned by the query.

Allows the user to access raw packets and logs from any client
application (Investigations and Reporting).

Allows users to access raw packets and logs from any client application.

Allows the user to manage the appliance (host) tasks. This permission is
required by the Appliance service.

Allows the user to edit the configuration settings for the Network
Decoder service.

Allows the user to edit the configuration settings for the
Concentrator/Broker service.

Allows the user to view the service logs and edit the logging
configuration settings for the specified service.

Allows the user to manage all attributes under the parsers node.

Allows the user to add and delete all rules.

Allows the user to set database locations, sizes, and the various
configuration settings for the session, meta and/or packet/log databases.

Allows the user to manage all index-related attributes.
Allows the user to view and set all SDK configuration items.
Allows the user to execute a Lua stored procedure.

Allows the user to manage Lua stored procedures.

Allows the user to modify the Archiver configuration.
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omsen o

dpo.manage Allows the user to manage the transform configuration and the applicable
keys.

Services Security View - Aggregation Role

This topic describes the Aggregation role and permissions that allow service users to
perform aggregation.

Related Topics

e Services Security View - Service User Roles and Permissions

e Services Security View - Roles Tab

The Aggregation role is a service user role intended only for aggregation of data. It has the minimum
role permissions required to do aggregation:

e aggregate
e sdk.meta
e sdk.packets

e sdk.content

The Aggregation role is available only on NetWitness version 10.5 and later services and it can be

used for an aggregation account. Members of this role or service users with these permissions can
perform aggregation on Network Decoders, Concentrators, Archivers, and Brokers. The aggregate
permission allows service users to perform aggregation of sessions and metadata along with raw packets
and logs.

You can still use the decoder.manage, concentrator.manage, and archiver.manage
permissions, but the Aggregation role permissions allow aggregation only and prevent the other available
operations.

a4
You access the service roles from the (Admin) > Services (select a service) > > View >
Security > Roles tab.

Procedures related to roles are described in Hosts and Services Maintenance Procedures. Services
Security View - Service User Roles and Permissions provides detailed information on the pre-configured
roles.

The following figure shows the permissions in the Aggregation role.
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NETWITNESS

SERVICES

- Change Service | R concentrator - Concentrator Security

+ -® Replicate . P N
rOl€ InTormaticn
Role Name ~ ame
Administrators Aperepatio
Aggregation
Aggregation

Name Description
v Allows aggregation of data
Allows use
SOC_Managers
Specia
Specia
Al t0 manage the conc
v sdk.content Allows users to access sdk content
sdk.manage Allows users to manage queries and the sdk subsy...
v sdk.meta Allows users to access sdk metadata
v sdk.packets Allows users to access raw packets or logs

services.manage Allows users to manage connections

ored proce

d procedures

Services Security View - Settings Tab

In the Services Security view Settings tab, Administrators can enable and configure system roles that
define permissions on a per meta key basis for individual Brokers, Concentrators, Network Decoders,
and Log Decoders. Configuring this feature adds configurable meta keys to the Services Security view >
Roles tab so that individual meta keys can be applied to specific roles on a specific service. The
following figure illustrates this.
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NETWITNESS Investigate ~ Respond ~ Users ~ Hosts ~ Files O B ¥ O ani

SERVICES E

-+ Change Service | concentrator1 -

- Name Description

v Allows aggregation of data

ownes

rules.manage
¥ sdk.content Allows users to access sdk content

dk.manage Allow 7S 10 Manage queries and the sdk subsy...

v sdk.meta Allows users to access sdk metadata
v sdk.packets Allows users to access raw packets or logs

This configuration is generally part of a data privacy plan implemented to ensure that specific types of
content consumed or aggregated by a service are kept secure by limiting visibility of the metadata and
content to privileged users. See the Data Privacy Management Guide for more information.

Workflow

Hosts View Services View

Set Up a Host Maintain a Host | Maintain a Service

You are here
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What do you want to do?

T T

Administrator  set up a host. Setting Up a Host
Administrator maintain a host. Maintaining Hosts
Administrator maintain a service. Maintaining Services
Administrator ~ enable and configure system roles that define See the System Security
permissions on a per meta key basis for individual and User Management
Brokers, Concentrators, Network Decoders, and Log Guide for more
Decoders.* information.

* You can perform these tasks in the current view.

Related Topics

o Services Security View - Users Tab

e Services Security View - Roles Tab

¢ Services Security View

Quick Look

NETWITNESS

HOSTS SERVICES EVENT SC

-+ Change Service | lz] Decoder Security &

Users Roles Settings

Configure Meta and Content Restrictions

When enabled, administrators can set querying and viewing permissions for meta and content on a per meta key basis. Additional role
permissions are exposed in the service security view. These permissions will be prefixed with sdk.meta. The sdk.meta permissions can
be defined using a whitelist or blacklist. Whitelisting includes the meta keys selected. Whereas blacklisting, excludes the meta keys
selected. With either whitelisting or blacklisting, the filtering can apply to the meta, content, or both.

SDK Meta Role Permissions  No Filtering (Disabled) v

Apply

The Settings tab includes two features.

e =

SDK Meta Role  Provides option for disabling or configuring meta key and content restrictions.
Permissions field  The filtering options are described.

Apply button Applies the selected configuration immediately. If not disabled, the meta keys are
added to the Roles tab so they can be applied to specific roles.
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SDK Meta Role Permissions Options

The following table lists the filtering options available in the SDK Meta Role Permissions selection list,
and the numeric values used to disable (0) and the types of filtering (1 through 6).

Note: There is no need to know the numeric value unless configuring metadata and content visibility
manually in the system. roles node.

system.roles | Settings

. Description
Node Value Tab Option
0 No Filtering System roles that define permissions on a per meta key basis are
(Disabled) disabled.

1 Whitelist Metadata and content for the specified SDK meta roles are white
metadata and listed, or visible to users assigned the system role.
content

2 Whitelist only ~ Metadata for the specified SDK meta roles is white listed, or
metadata visible to users assigned the system role.

3 Whitelist only  Content for the specified SDK meta roles is white listed, or
content visible to users assigned the system role.

4 Blacklist Metadata and content for the specified SDK meta roles are
metadata and black listed, or not visible to users assigned the system role.
content

5 Blacklist only =~ Metadata for the specified SDK meta roles is black listed, or not
metadata visible to users assigned the system role.

6 Blacklist only ~ Content for the specified SDK meta roles is black listed, or not
content visible to users assigned the system role.
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Services Stats View

The Services Stats view provides a way to monitor the status and operations of a service. This view
displays key statistics, service system information, and host system information for a service. In addition,
more than 80 statistics are available for viewing as gauges and in timeline charts. In historical timeline
charts, only statistics for session size, sessions, and packets are viewable.

Workflow

Hosts View Services View

Set Up a Host Maintain a Host Maintain a Service

You are here

What do you want to do?

T T

Administrator set up a host. Setting Up a Host
Administrator maintain a host. Maintaining Hosts
Administrator maintain a service. Maintaining Services
Administrator ~ monitor the status and operations of a service.* See the System
Maintenance Guide,
Administrator  chart statistical information for a service over a user- See the System
specified period of time.* Maintenance Guide.

* You can perform these tasks in the current view.

Related Topics
o Edit Service Dialog

¢ Services Config View

e Services Explore View

e Services Logs View

e Services Security View

¢ Services System View

e Services View
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Quick Look

The following figure shows an example of the Services Stats view for a Network Decoder.

NETWITNESS

HOSTS SERVICES EVENT SOURCES ENDPOINT SOURCES HEALTH & WELLNESS

& Change Service | B Decoder | Stats ©

Decoder

Key Stats Service System Info Host System Info Ph

c‘:l'll SIS BeydH

Memory Process cPu Memory Process Max

wemcr, oy Memory Procece

>

Although different statistics are available for different types of services, certain sections are common to
the Services Stats view for any Core service:

e Summary Stats

* Gauges

e Timeline Charts
 Historical Timeline Charts

e Chart Stats Tray

Summary Stats Section

The Summary Stats section is at the top of the default view and has no editable fields. There are five
panels in the Summary Stats section: Key Stats, Service System Info, Host System Info, Logical Drives,
and Physical Drives. The Key Stats panel displays different statistics for different types of services. The
remaining four panels in the Summary Stats section are the same for all types of services.

Key Stats
The Key Stats panel displays different statistics for different types of services.

e For a Network Decoder or Log Decoder, key statistics include capture statistics, such as capture rate,
total packets or logs captured, total packets or logs dropped, the data capture begin time and end time.
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Key Stats
Capture Rate 0 MBPS

Max Capture 33 MBPS
Rate

Total Captured 8.2 Million Packets
Total Dropped 0 Packets (0% loss)
Total Packets 271,941 Packets
Begin Time 2008-Feb-13 16:55:19
End Time 2015-Jan-23 05:15:47

¢ A Broker or Concentrator aggregates data from multiple services. Therefore, the key statistics for all
aggregate services are presented in a list. The columns in the list provide the service name, the capture
rate, the maximum capture rate, the number of sessions behind (that need to be aggregated), and the

service status.

Key Stats
Key Stats Rate Max Behind Status
0 2346 0 consumir
0 0 0 consumir
0 26 0 consumir

Service System Info

The Service System Info panel includes the percentage of CPU used by the service, the memory usage
statistics (system, total, process, and maximum process), service uptime, status, running since time, and

the current time.
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Service System Info

CPU 7%
System Memory 14.9 GB
Total Memory 15.6 GB
Process Memory 111.4 MB

Max Process Memory 15.6 GB

Uptime 1 week, 6 days, 3 hours and 25
minutes

Status Ready

Running Since 2015-]an-23 09:29:11

Host System Info

The Host System Info panel includes the percentage of CPU used by the host, the memory usage
statistics (system, total, process, and maximum process), host uptime, status, running since time, and the
current time.

Host System Info

CPL 0%

Systemn Memory 31.2 GE

Total Memory 31.4 GE

Process Memory 229 ME

viax Process 31.4 GE

demory

Uptime 5 weeks, 1 day, 19 hours and
57 minutes

Status Ready

Logical Drives and Physical Drives

The Logical Drives panel and Physical Drives panel are shown with an icon for the drive name and
state. Drive types are used in the names and the drive status options are listed below.
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Logical Drives

| »

Status Options

md0 mid 1 mrd..  mrd..  mrd. mrd. mr
mrd..  mrd.. mrl.  mrd. mrl. mrde mr
Physical Drives L
i v
1| [ »
Drive Types and Status
Description Comments
sd SCSI block device  Directly connected SAS,
SATA MegaRAID volumes.
1d MegaRAID Logical Defined in BIOS or with
Volume MegaCLI tool.
pd MegaRAID Not directly exposed to Linux.
Physical Disks
md Linux software
RAID Volume
Gauges

Green: OK
Red: FAIL
Green: OK

Yellow: DEGRADED/BUILDING
Red: FAIL

Green: OK
Red: FAIL
Green: OK

Yellow: DEGRADED/BUILDING
Red: FAIL

The Gauges section in the Services Stats view presents statistics in the form of analog gauges.

See Services Stats View - Gauges for details on configuring gauges.

Timeline Charts

Timeline charts display the selected statistics in a running timeline with focus on the current time. This is
the same for all types of services, and only the display name of the timeline is editable. See Services
Stats View - Timeline Charts for details on configuring timelines.

Historical Timeline Charts

Historical timeline charts display statistics for session size, sessions, and packets in a historical timeline.
This is the same for all types of services. Only the display name, begin date, and end date. See Services
Stats View - Timeline Charts for details on configuring timelines.
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Note: Historical timeline charts is being deprecated for Log Collector, Virtual Log Collector (VLC)
and Windows Legacy Collector services.

Chart Stats Tray

The Chart Stats Tray lists all available statistics for the selected service type. Different services have
different statistics to monitor. See Services Stats View - Chart Stats Tray for a detailed description.

Topics
e Services Stats View - Chart Stats Tray

e Services Stats View - Gauges

e Services Stats View - Timeline Charts

Services Stats View - Chart Stats Tray

In the Services Stats view, the Chart Stats Tray provides a way to customize the monitored statistics for
individual services. The Chart Stats Tray lists all available statistics for the service. The number of
statistics varies according to the type of service being monitored. Any statistic in the Chart Stats Tray
can be displayed in a gauge or a timeline chart. Only statistics for session size, sessions, and packets are
viewable in historical timeline charts.

Workflow

Hosts View Services View

Set Up a Host Maintain a Host Maintain a Service

You are here

What do you want to do?

(T T R

Administrator set up a host. Setting Up a Host

Administrator maintain a host. Maintaining Hosts

Administrator maintain a service. Maintaining Services

Administrator ~ customize the monitored statistics for individual See the System Maintenance
services.* Guide.

* You can perform these tasks in the current view.
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Related Topics

e Services Stats View - Gauges

¢ Services Stats View - Timeline Charts

* Services Config View

Quick Look

The following example shows the Services Stats view for a Network Decoder. The Chart Stats Tray is
collapsed.

NETWITNESS

HOSTS SERVICES EVENT SOURCES ENDPOINT SOURCES HEALTH & WELLNESS

& Change Service | B Decoder Stats
Decoder £
Key Stats Service System Info Host System Info Ph ;

. -
»
Memory Process cPU Memory Process Max
o S .
. , i

To view the Chart Stats Tray, click on the to expand the Chart Stats Tray.
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Chart Stats Tray
Search

Stats

Active CPU Time
Stat Name:Cpu.active
Path:/decoder/parsers/stats/cpu/cpu.active

Assembler Client Bytes
stat Name:assembler.client.bytes
Path:/decoder/stats/assembler.client.bytes

Assembler Client Retransmit
Stat Name:assembler.client.retrans
Path:/decoder/stats/assembler.client.retrans

Assembler Packet Bytes
Stat Name:assembler.packet.bytes
Path:/decoder/stats/assembler.packet.bytes

Assembler Packet Pages
Stat Name:assembler.packet.pages
Path:/decoder/stats/assembler.nacket.pages

| Page 1 |of11 | ) NI C

Stats 1-120f 132

The Chart Stats Tray has different statistics for different types of services. In the example above, 132
statistics are available for the Network Decoder. The following table describes features of the Chart Stats

Tray.

[ Feawre | Descripton

4 | Click to expand the panel horizontally.
| b Click to collapse the panel horizontally.

Search X Type a search term in the field and press RETURN,
Statistics that match are displayed with the matching word
highlighted.

« Click to go to the first page.
( Click to go to the previous page.
Page 1 | of 11 Type a page number in the Page field.
) Click to go to the next page.
» Click to go to the last page.
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oo | merpion

C Click to refresh the view.

Stats 1-12 of 132 Displays the range of statistics being displayed. The total
number statistics varies by service type.

Services Stats View - Gauges

The Gauges section of the Services Stats view presents statistics in the form of an analog gauge. You can
drag any statistic available in the Chart Stats Tray to the Gauges section. The properties of each
individual gauge are editable; all gauges have an editable title and some have additional editable
properties.

Workflow

Hosts View Services View

Set Up a Host Maintain a Host Maintain a Service

You are here

What do you want to do?

T T

Administrator  set up a host. Setting Up a Host

Administrator  maintain a host. Maintaining Hosts

Administrator  maintain a service. Maintaining Services

Administrator  view statistics in the form of an analog See the System Maintenance Guide,
gauge.*

* You can perform these tasks in the current view.

Related Topics

¢ Services Stats View - Chart Stats Tray

e Services Stats View - Timeline Charts

¢ Services Config View
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Quick Look

The following figure shows the default gauges in the Services Stats view for a Log Decoder.

Gauges - Page 1 of 1

Memory Process CPU Memeory Process Max

16GB
2

1004.9MB 2368

2HGE

!
EE0.0ME I."
|

|
335.0ME -\ 18GB 2.0GE

r_\_‘g Memory Process 33GB 0.0 Memory Process Max 31 2GE
The default gauges show these statistics:

* Process memory use

e CPU use

¢ Maximum process memory use

The controls in the Gauges title bar and in each gauge are the standard dashlet controls. Dashlets are the
parts that make up a dashboard.

Gauges - Page 1 of 2

» In the Gauges title bar (from left to right), you can collapse/expand, delete a page, add a page, page
backward, and page forward.

* In each gauge, you can edit properties ( ** ) and delete (* * ) the gauge.

Services Stats View - Timeline Charts

The Services Stats view Timeline Charts sections display statistics in a running timeline. The Services
Stats view includes two types of timelines: current time and historical. You can drag any statistic
available in the Chart Stats Tray to the Timeline Charts section or Historical Timeline Charts section.
Only statistics for session size, sessions, and packets are viewable in historical timeline charts. The
properties of an individual timeline chart are editable; all timeline charts have an editable title and some
have additional editable properties.
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Workflow

Hosts View Services View

Set Up a Host Maintain a Host Maintain a Service

You are here

What do you want to do?

T T I

Administrator  set up a host. Setting Up a Host
Administrator  maintain a host. Maintaining Hosts
Administrator  maintain a service. Maintaining Services

Administrator  view statistics in the form of a current or historical ~ See the System Maintenance
timeline.* Guide.

* You can perform these tasks in the current view.

Related Topics

e Services Stats View - Chart Stats Tray

e Services Stats View - Gauges

¢ Services Config View

Quick Look

The following figure is an example of a current timeline showing the value and timestamp of a data
point.

Timeline Charts - Page 1 of 1 ~n—t

Memory Process X epu ax

358 280
288 735
188 490
vl e i —

PR | T T 00— T B E— T N
03:13 pm 03:30 pn =2 =B pm 04:03 pm 04:20 pm 04:11 pm 04:15 pm 04:20 pm 04:24 pm 04:28
pm

Memory Process Max
2258
3518
1678

848
00

The following figure is an example of a historical timeline chart.

T T T T
04:15pm 04:20 pm 04:24 pm 04:28 pm
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Historical Timeline Charts

Timeline - Sessions

P =—-

The default current timeline charts show these statistics:

* Memory Process
« CPU

e Memory Process Max

The historical time charts show these statistics:
e Sessions
e Packets

e Session Size

The controls in the Timeline Charts title bar and in each timeline are the standard dashlet controls. The
Historical Timeline Charts title bar and timelines have the same controls.

Timeline Charts - Page 1 of 2

* In the Timeline Charts title bar (from left to right), you can collapse/expand, delete a page, add a

page, page backward, and page forward.

* In each timeline, you can edit Properties (" ) and delete (

) the timeline.

* Hovering over a data point in the chart, displays the value and timestamp for the selected point.
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Services System View

This topic introduces features in the Services System view using Decoders (Network Decoder and Log
Decoder) as an example. See the appropriate configuration guides for other services (for example, the

Q
NetWitness Broker and Concentrator Configuration Guide) for details on their respective (Admin)
> Services > System views.

A Log Decoder is a special type of Decoder, and is configured and managed in a similar way to a
Network Decoder. Therefore, most of the information in this section refers to both types of Decoders.
Differences for Log Decoders are noted. For more information on Decoders, see the Decoder
Configuration Guide.

Workflow

Hosts View Services View

Set Up a Host Maintain a Host Maintain a Service

You are here

What do you want to do?

oo

Administrator set up a host. Setting Up a Host

Administrator maintain a host. Maintaining Hosts

Administrator maintain a service. Maintaining Services

Administrator  view system and session information about a See the System Maintenance
service.* Guide,

* You can perform these tasks in the current view.

Related Topics
e Edit Service Dialog

e Services Config View

¢ Services Explore View

e Services Logs View

e Services Security View
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e Services Stats View

e Services View

Quick Look
The following figure shows an example of the Services System view for a Network Decoder.

LY

NETWITNESS Ivestigate Respond ~ Users Hosts Fles Dashboard  Repor O B % 0

HOSTS SERVICES EVENT SOURCES ENDPOINT SOURCES HEALTH & WELLNESS SECURITY

Change Service ) Decoder

Appliance Service Information

Decoder (Host)

11 x (R "
3 2 - utes 37 seconds ays 2 2 nutes 43 secon
Decoder User Information Host User Information
acm 3

Login Time Active Queries

The following figure shows the Services System view for a Log Decoder.
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NETWITNESS
HOSTS SERVICES
Change Service 9 Log Decoder
&L, Upload Log File ® StartCapture () ResetlLogStacs [} Host Tasks @ Shutdown Service () Shutdown Appliance Service & Reboot
Log Decoder Service Information Appliance Service Information
Log Decoder Log Decoder (Host)
11.cx.x (Rev Null) 11.0x.x (Rev Null)
GB Ge

es 59 se es 41 seconds
Log Decoder User Information
aomin aomin
Administrators Agdministrators
AEETEEATe. CONNECTONI. MANAEE. CAADAIEe MANAge Apphance.Manage CONNECTONI MANaAge. (O3 Manage

decoder.manage. dpo.manage. index.manage. services.manage. st cexecute
Ogs.manage. parsers.manage. rules.manage. storedproc.manage. sys.manage. users.manage
s storedproc.execute
storedproc.manage. sys.manage. users.manage
Session User 1P Acoress Login Time ~ Active Queries

acmin IP address

Services Info Toolbar
The following toolbars show the options specific to Log Decoders (top) and Network Decoders (bottom).

| X, Upload Log File ® Start Capture ) Reset Log Stats B HostTasks () Shutdown Service () Shutdown Appliance Service () RebcctJ

|.L Upload Packet Capture File ® Start Capture [ HostTasks () Shutdown Service () Shutdown Appliance Service () Reboot |

In addition to the common options in the Services System view toolbar, you can start and stop capture of
packets or logs. The upload file options are different for the standard Network Decoder (packet capture
file) and the Log Decoder (log file).

e

Upload Displays a dialog that provides a way to select a packet capture (.pcap) file for upload
Packet to the selected Network Decoder. For more information, see "Upload Packet Capture
Capture File" in the Decoder Configuration Guide.

File

Note: This option does not apply to Log Decoders.

Displays a dialog that provides a way to select a log (. 1og) file for upload to the
selected Log Decoder. For more information, see "Upload Log File to a Log Decoder"
in the Decoder Configuration Guide.

Upload Log
File

Start/Stop  Starts packet capture on the selected Decoder. When packet capture is in progress, the
Capture option in the toolbar changes to Stop Capture, and the option to upload a file is
unavailable.
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Related Topics
e Services System View - Host Task List Dialog

Services Topology View

This topic introduces the services topology, a hierarchical view of the NetWitness Platform core services

depicting the collection and aggregation in your deployment.

This visualization displays the topology for the Broker, Concentrator, Log Decoder, Packet Decoder,
Hybrids, ESA and Log Collector. You can view the services that are online and details of each node.

Workflow

Hosts View Services View

Maintain a Service

Set Up a Host Maintain a Host

You are here

What do you want to do?

(T TR ey

Administrator maintain a service. Maintaining Services

Quick Look

The following figure shows an example of how each service is aggregating data in a hierarchy along
with which services are online or offline.

USWEST - Broker ; IN - Broker
IN-MH - Concentrator

SFO - Log Decoder BLR - Log Decoder BOM-LDL - Log Decoder BOM-LD2 - Log Decoder

SFO - Log Collector BLR - Log Collector BOM-LD! - Log Collector BOM-LDZ - Log Collecior
|
hLc1-vic SFOVLCZ- VLT BLRVLCL-VLC BLRALCZ-VLC BLRVLCS - VLC BLRVLCA-VLC BLRALCS - VLG BOM-VLC1 - VLC BOMVLC2 - VLC

BOM-VLE3 -VLC
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The following figure shows the details of a node. When you hover over any of the services, additional
details such as name, IP version, Port number and Version number are displayed.

@ logriecoder? - Log Collector

(§5)) concentratort - Concentrator

@

C =

Node Displays a dialog that provides name, IP version, Port number and
Version number.

Search Enter the service name to locate a specific service.
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Services System View - Host Task List Dialog

In the NetWitness Services System view, you can use the Host Tasks option to manage tasks that relate
to a host and its communications with the network. Several service and host configuration options are
available for Core services.

Workflow

Hosts View Services View

Set Up a Host Maintain a Host Maintain a Service

You are here

What do you want to do?

T T

Administrator ~ set up a host. Setting Up a Host
Administrator maintain a host. Maintaining Hosts
Administrator maintain a service. Maintaining Services
Administrator ~ manage host-related tasks and host Hosts and Services
communications with the network.* Maintenance Procedures

* You can perform these tasks in the current view.

Related Topics

e Services System View
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Quick Look

Host Task List

Task w

Arguments Run

Info

Output

Cancel

The table below describes the Host Task List dialog features.

T T S

Task An entry field in which you type or select a message for a Core host. When you click
in this field a drop-down list of available host tasks is displayed.

Arguments  An entry field in which you enter the arguments, if any, for the message.

Run Executes the task and arguments in the entry fields.
Info Information about the message purpose and syntax.
Output The output or result of an executed task.

Cancel Closes the Host Task list dialog.

Host Task Selection List

These tasks are displayed as a drop-down list in the Task field. The available options are regulated by the
security role required to execute the option.

Add Filesystem Starts monitoring the storage services attached to the specified filesystem. See
Monitor Add and Delete a Filesystem Monitor,
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Delete Filesystem
Monitor

Reboot Host

Set Host Built-in
Clock

Set Host
Hostname

Set Network
Time Source

Set Syslog
Forwarding

Show Network
Port Status

Show Serial
Number

Shut Down Host
Start Service
Stop Service

setSNMP

Stops monitoring the storage services attached to the specified filesystem. See
Add and Delete a Filesystem Monitor,

Shuts down and restarts the host. See Reboot a Host.

Sets the local host clock. See Set Host Built-In Clock.

This method of changing the hostname is deprecated in NetWitness 10.6. To edit a
hostname, see Edit or Delete a Service.

Sets the clock source for this host. See Set Network Time Source.

Enables or disables syslog forwarding from a remote server to the selected
service. See Set Syslog Forwarding,

Shows the network interface information for a host. See Show Network Port
Status,

Gets the host serial number. See Show Serial Number,

Shuts down the physical host and the host remains off. See Shut Down Host,

Starts a service on this host. See Stop and Start a Service on a Host.

Stops a service on this host. See Stop and Start a Service on a Host.

Enables or disables the SNMP service on a host. See Set SNMP.
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Service Configuration Settings

This topic introduces the available service configuration settings for NetWitness Core services.

NetWitness Core services include Brokers, Concentrators, Network Decoders, Log Decoders, and
Archivers. The service configuration parameters listed below constitute all viewable and configurable
parameters. Some parameters are configurable in various parts of the NetWitness user interface while
other parameters are viewable or configurable only on the Services Explore view.

Aggregation Configuration Parameters

This table lists and describes the available configuration parameters that are common to services that
perform aggregation, such as Concentrators and Archivers.

Configuration Path Iconcentrator/config or /archiver/config

aggregate.autostart Automatically restarts aggregation after a service restart, if
enabled. Change takes effect immediately.
aggregate.buffer.size Displays the size of the buffer (default unit is KB) used per

round of aggregation. Larger buffers may improve aggregation
performance but could impact query performance. Change takes
effect after aggregation restart.

aggregate.crc If enabled, all aggregation streams will be CRC validated.
Change takes effect immediately.

aggregate.hours Displays the maximum number of hours behind a service will
be allowed to start aggregation. Change takes effect
immediately.

aggregate.interval Lists the minimum number of milliseconds before another
round of aggregation is requested. Change takes effect
immediately.

aggregate.meta.page.factor  [jsts the allocated number meta pages per session used for
aggregation. Change takes effect on service restart.

aggregate.meta.perpage Lists the allocated number of meta stored on one page of data.
Change takes effect on service restart.

aggregate.precache Determines if the concentrator will precache the next round of
aggregation for upstream services. Can improve aggregation
performance but could impact query performance. Change takes
effect immediately.

aggregate.sessions.max Lists the number of sessions to aggregate on each round.
Change takes effect after aggregation restart.

aggregate.sessions.perpage  [ists the number of sessions stored on one page of data.
Change takes effect on service restart.
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Configuration Path

aggregate.time.window

consume .mode

export.

export.

export.

export.

export.

export.

export.

export.

export.

export.

enabled

expire.minutes

format

local.path

meta.fields

remote.path

rollup

session.max

size.max

usage.max

heartbeat.error

heartbeat.interval

Iconcentrator/config or /archiver/config

Displays the maximum +/- time window, in seconds, that all
services must be inside before another round of aggregation is
requested. Zero turns off time window. Change takes effect
immediately.

Determines if the concentrator can only aggregate locally or
over a network, based on licensing restrictions. Change takes
effect on service restart.

Allows export of session data, if enabled. Change takes effect
on service restart.

Lists the number of minutes before export cache files are
expired and flushed. Change takes effect immediately.

Determines the file format used during data export. Change
takes effect on service restart.

Displays the local location to cache exported data. Optional
assigned max size (=#unit), units are: t for TB; g for GB, m
for MB. Change takes effect on service restart.

Determines which meta fields are exported. Comma-separated
list of fields.

* means all fields.

* and field list means all fields except the listed fields.

Just the field list means only those fields are included.
Change takes effect immediately.

Displays the remote protocol (nfs://) and location to export
data. Change takes effect on service restart.

Determines the rollup interval for export files. Change takes
effect on service restart.

Displays the maximum sessions per exported file. For export
file types that cache, this determines cached memory sizes.
Zero is no limit. Change takes effect immediately.

Displays the maximum bytes per exported file. For export file
types that cache, this determines cached memory sizes. Zero is
no limit. Change takes effect immediately.

Displays the maximum percentage of cache space used before
stopping aggregation. Zero is no limit. Change takes effect
immediately.

Lists the number of seconds to wait after a service error before
attempting a service reconnect. Change takes effect
immediately.

Lists the number of milliseconds between heartbeat service
checks. Change takes effect immediately.
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Configuration Path

Iconcentrator/config or /archiver/config

heartbeat.next.attempt Lists the number of seconds to wait before attempting a service
reconnect. Change takes effect immediately.

heartbeat.no.response Lists the number of seconds to wait before taking unresponsive
service offline. Change takes effect immediately.

Appliance Service Configuration Parameters

The NetWitness Core Appliance service provides hardware monitoring on legacy NetWitness hardware.
The list describes the Appliance Configuration parameters.

Appliance

Description

Parameter Field

Logs /logs/config refer to Core Service Logging Configuration Parameters
REST /rest/config refer to REST Interface Configuration Parameters
Services /services/<service name>/config refer to Core Service-to-Service

Configuration Parameters

System /sys/config refer to Core Service System Configuration Parameters

Archiver Service Configuration View

This topic lists and describes the available configuration settings for NetWitness Archivers.
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Workflow

You are here

Archiver Configuration View

Edit .xml and
Juafiles.

Wiewy modify
EBrvice
parsmeters.

Appliance
Service

[Drata
Retention
Scheduler

Specfy how
lzng to retain
database
records.

Wiew modify
appliance
EErvice
paEmeters.

Administrator ~ Configure Meta Filters for Aggregation. Refer to "(Optional) Configure Meta Filters
for Aggregation" in the NetWitness Archiver Conﬁguration Guide for instructions.
Administrator ~ Configure Group Aggregation. Refer to "Configure Group Aggregation" in the
NetWitness Deployment Guide for instructions.
Quick Look

To access the Services Config view:

QA
1. In NetWitness, select (Admin) > Services.

The Admin Services view is displayed.

2. Select an Archiver service and select

Services Config view for the Archiver service is displayed.

>View > Config.

This is an example of the Services Config view for an Archiver.
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NETWITNESS

HOSTS SERVICES

Files Applance Service Configuration

s Aggregaton Settings

g Vol 4 Service Heartheat

Broker Service Configuration Parameters

The following list describes the Broker configuration parameters.

Broker /broker/config refer to Aggregation Configuration
Parameters

aggregate.interval.behind  Minimum number of milliseconds before another round of
aggregation is requested when the broker is behind. Change takes
effect immediately.

Database /database/config refer to "Database Configuration Nodes" in
the NetWitness Core Services Database Tuning Guide,

Index /index/config

index.dir The directory where the broker device mapping files are stored.
Change takes effect on service restart.

language.filename The index language specification (XML) that is loaded on
startup. Change requires service restart.

Logs /logs/config refer to Core Service Logging Configuration
Parameters

REST /rest/config refer to REST Interface Configuration
Parameters

SDK /sdk/config refer to "SDK Configuration Nodes" in the

NetWitness Core Services Database Tuning Guide
and NetWitness Platform Core Service system.roles Modes

Services /services/<service name>/config refer to Core Service-
to-Service Configuration Parameters

162 Hosts and Services Views References



Hosts and Services Getting Started Guide

System /sys/config refer to Core Service System Configuration
Parameters

Concentrator Service Configuration Parameters

The following list describes the Concentrator configuration parameters.

Concentrator

Parameter Description

Field

Concentrator /concentrator/config refer to Aggregation Configuration Parameters

Database /database/config refer to "Database Configuration Nodes" in the NetWitness
Core Database Tuning Guide,

Index /index/config refer to "Index Configuration Nodes" in the NetWitness Core
Database Tuning Guide,

Logs /logs/config refer to Core Service Logging Configuration Parameters

REST /rest/config refer to REST Interface Configuration Parameters

SDK /sdk/config refer to "SDK Configuration Nodes" in the NetWitness Core
Database Tuning Guideand NetWitness Platform Core Service system.roles
Modes

Services /services/<service name>/config refer to Core Service-to-Service

Configuration Parameters

System /sys/config refer to Core Service System Configuration Parameters

Core Service Logging Configuration Parameters

The following table describes the logging configuration parameters for all NetWitness Core services.
Logging configuration is the same for all Core services.

Logs Configuration Folder llogs/config

log.dir Displays the directory where the log database is stored.
Optional assigned max size (=#) is in MBs. Change takes effect
on service restart.

Controls what types of log messages are stored (comma

log.levels separated). Module specific settings are defined like this:
<Module>=

[debug|info|audit|warning|failure|all |none],
Change takes effect immediately.
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Logs Configuration Folder llogs/config

log.snmp.agent

snmp.trap.version

snmpv3.

snmpv3.

snmpv3.

snmpv3.

snmpv3.

snmpv3.

snmpv3.

snmpv3.

syslog.

engine.boots

engine.id

trap.auth.local.key

trap.auth.protocol

trap.priv.local.key

trap.priv.protocol

trap.security.level

trap.security.name

size.max

Sets a remote SNMP Trap Receiving agent.
Sets the SNMP version (2¢ or 3) to be used for gets and traps.

Displays the SNMPv3 engine boots count. This field auto-
increments on startup and should not normally need to be set by
the user.

Sets the SNMPv3 engine ID, which is 10-64 hexadecimal digit
number optionally preceded by 0x. You can add suffix values
at the end of the engine ID for each of the SA Core services
running on the same host. For example, if the generated Engine
ID for the SA Core host is 0x1234512345, you can set the
Engine ID for the Decoder service as 0123451234501 and
set 0x123451234504 for the Appliance service.

Sets the SNMPv3 Trap Authentication Local Key, which is a
16 or 20 hexadecimal digit number (depending on which
authentication protocol is used) preceded by 0x. For MDS5, the
key is 16 hexadecimal digits, while SHA uses 20 hexadecimal
digits. You can use any desired algorithm to generate the local
keys. It is recommended that a generation method involving
randomness be used as opposed to selecting key values
manually.

Displays the SNMPv3 Trap Authentication Protocol (none,
MDS5 or SHA).

Sets the SNMPv3 Trap Privacy Local Key, which is a 16
hexadecimal digit number preceded by 0x.

Displays the SNMPv3 Trap Privacy Protocol (none or AES).

Displays the SNMPv3 Trap Security Level, which indicates
whether authentication and privacy are used or not. Possible
values are noAuthNoPriv, authNoPriv, or authPriv,

Sets the SNMPv3 Trap Security Name used during SNMPv3
trap authentication.

Displays the maximum size of a log sent to syslog (some syslog
daemons have issues with very large messages). Zero means no
limit. Change takes effect immediately.

Core Service-to-Service Configuration Parameters

This topic lists and describes the configuration parameters that control how a Core service connects to
another Core service. For example, when a Concentrator connects to a Network Decoder, the connection
parameters are controlled by these settings.
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Whenever a Core service establishes a connection to another Core service, the service that acts as

the client creates a new sub-folder in the /services folder of the configuration tree. The name of the
sub-folder corresponds to the name of the service and has the form host :port. For example, the service
connection folder for a Concentrator connection to a Network Decoder could be /services/reston-
va-decoder:50004. Inside each service connection folder, there is a config sub-folder that holds
configurable parameters.

The following list describes the Service Configuration parameters:

allow.nonssl.to.ssl  Allows a non-SSL connection to connect to a SSL service, when set to
true. Otherwise, if false, non-secure to secure connections will be
denied. Change takes effect immediately.

compression Displays a config node that determines if data is compressed before
sending. A positive value determines the number of bytes that need to be
sent before it will be compressed. Zero means no compression.

crc.checksum Displays a config node that determines if data streams are validated with
a CRC checksum. A positive value determines the number of bytes that
need to be sent before it will be CRC validated. Zero means no CRC
validation.

ssl Displays a config node that enables or disables SSL encryption on the
connection.

Core Service System Configuration Parameters

The following list describes the System configuration parameters that are common to all NetWitness
Core services.

System Configuration

/sys/config
Folder

compression Displays the minimum amount of bytes before a message is
compressed, when set to a positive value. Zero means no compression
for any message. Change takes effect on subsequent connections.

crc.checksum Displays the minimum bytes before a message is sent over the
network with a CRC checksum (to be validated by the client), when
set to a positive value. Zero means no CRC checksum validation with
any message. Change takes effect on subsequent connections.

drives Displays drives to monitor for usage stats. Change takes effect on
service restart.

port Displays the port this service will listen on. Change takes effect on
service restart.

scheduler Displays the folder for scheduled tasks.
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System Configuration

/sys/config
Folder

service.name.override  Djgplays an optional service name used by upstream services for
aggregation in lieu of hostname.

ssl Encrypts all traffic using SSL, if enabled. Change takes effect on
service restart.

stat.compression Compresses stats as they are written to the database, if enabled.
Change takes effect on service restart.

stat.dir Displays the directory where the historical stats database is stored
(separate multiple dirs with semicolon). Optional assigned max size
(=f#unit), units are: t for TB; g for GB, m for MB. Change takes
effect on service restart.

stat.exclude Lists stat pathnames to be excluded from the stat database. The
following wildcards are permitted:
? match any single character
* match zero or more characters to delimiter /
** match zero or more characters including delimiter.
Change takes effect immediately.

stat.interval Determines how often (in milliseconds) statistic nodes are updated in
the system. Change takes effect immediately.

threads Lists the number of threads in the thread pool to handle incoming
requests. Change takes effect immediately.

Decoder Configuration Parameters

The following list describes the configuration parameters that are identical on both Network Decoder and
Log Decoder services.

aggregate.buffer.size Displays the size of the buffer (default unit is KB) used per
round of aggregation. Larger buffers may improve aggregation
performance but could impact capture performance. Change
takes effect after capture restart.

aggregate.precache Determines if the decoder will pre-cache the next round of
aggregation for upstream services. Can improve aggregation
performance but could impact capture performance. Change
takes effect immediately.

assembler.pool.ratio Displays the percentage of pool pages that assembler manages
and uses for the assembly process. Change takes effect on
service restart.
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assembler.session.flush Flushes sessions either when they are complete, or when they
are parsed. Change takes effect on service restart.

assembler.session.pool Lists the number of entries in the session pool. Change takes
effect on service restart.

assembler.size.max Lists the maximum size that a session will obtain. A setting of
0 removes the session size limit. Change takes effect
immediately.

assembler.size.min Lists the minimum size that a session must be before persisting.

Change takes effect immediately.

assembler.timeout.packet Lists the number of seconds before packets are timed out.
Change takes effect immediately.

assembler.timeout.session Lists the number of seconds before sessions are timed out.
Change takes effect immediately.

assembler.voting.weights Displays the weights used to determine which session stream is
marked client and server. Change takes effect immediately.

capture.autostart Determines if capture begins automatically when the service
starts. Change takes effect on service restart.

capture.buffer.size Displays capture memory buffer allocation size (default unit is
MB). Change takes effect on service restart.

capture.device.params Displays capture service specific parameters. Change takes
effect on service restart.

The parameters understood by this field are specific to the
currently selected capture device. If any of the parameters are
not recognized by the current capture device, they are ignored.

On Log Decoders, there is only the Log Events capture device.
It accepts some optional parameters.

e use-envision-time: If this is set to 1, the time metadata
for each event will be imported from the Log Collector
stream. If this is 0 or not set, the imported event time will be
stored in the event.time meta.

e port: This parameter can be set to a numeric value to
override the default syslog port listener, 514.

capture.selected Displays current capture service and interface. Change takes
effect immediately.

export.expire.minutes Lists the number of minutes before export cache files are
expired and flushed. Change takes effect immediately.

export.packet.enabled Allows export of packet data, if enabled. Change takes effect on

service restart.
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export.packet.local.path Displays the local location to cache packet exported data.
Optional assigned max size (=#unit), units are: t for TB; g for
GB, m for MB. Change takes effect on service restart.

export.packet.max Displays the maximum packets per exported file. For export file
types that cache this determines cached memory sizes. Zero is
no limit. Change takes effect immediately.

export.packet.remote.path Lists the remote protocol (nfs://) and location to export data.
Change takes effect on service restart.

export.packet.size.max Displays the packet maximum bytes per exported file. For
export file types that cache this determines cached memory
sizes. Zero is no limit. Change takes effect immediately.

export.rollup Determines the rollup interval for export files. Change takes
effect on service restart.

export.session.enabled Allows export of session data, if enabled. Change takes effect
on service restart.

export.session.format Determines the file format used during session export. Change
takes effect on service restart.

export.session.local.path Displays the local location to cache session exported data.
Optional assigned max size (=#unit), units are: t for TB; g for
GB, m for MB. Change takes effect on service restart.

export.session.max Displays the maximum sessions per exported file. For export
file types that cache, this determines cached memory sizes.
Zero is no limit. Change takes effect immediately.

export.session.meta.fields  Determines which meta fields are exported. Comma-separated
list of fields.
* means all fields.
* plus field list means all fields BUT listed fields.
Just field list means only those fields are included.
Change takes effect immediately.

export.session.remote.path  Digplays the remote protocol (nfs://) and location to export
data. Change takes effect on service restart.

export.session.size.max Lists the session maximum bytes per exported file. For export
file types that cache, this determines cached memory sizes.
Zero is no limit. Change takes effect immediately.

export.usage.max Lists the session maximum bytes per exported file. For export
file types that cache, this determines cached memory sizes.
Zero is no limit. Change takes effect immediately.

parse.threads Lists the number of parse threads to use for session parsing.
Zero means let server decide. Change takes effect on service
restart.
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pool.packet.page.size Displays the size of a packet page (default is KB). Change
takes effect on service restart.

pool.packet.pages Lists the number of packet pages decoder will allocate and use.
Change takes effect on service restart.

pool.session.page.size Displays the size of a session page (default is KB). Change
takes effect on service restart.

pool.session.pages Lists the number of session pages decoder will allocate and use.
Change takes effect on service restart.

Network Decoder Service Configuration Parameters

This topic lists and describes the available configuration parameters for NetWitness Network Decoders.

Decoder

Parameter Description

Field

Decoder /decoder/config refer to Decoder Configuration Parameters,

Database /database/config refer to "Database Configuration Nodes" in the NetWitness
Core Database Tuning Guide,

Index /index/config refer to "Index Configuration Nodes" in the NetWitness Core
Database Tuning Guide.

Logs /logs/config refer to Core Service Logging Configuration Parameters,

REST /rest/config refer to REST Interface Configuration Parameters,

SDK /sdk/config refer to "SDK Configuration Nodes" in the NetWitness Core

Database Tuning Guide and NetWitness Platform Core Service system.roles Modes,

System /sys/config refer to Core Service System Configuration Parameters,

Log Decoder Service Configuration Parameters

This topic lists and describes the available configuration parameters for Log Decoder configuration
settings.

Log Decoder

Description
Setting Field

Database /database/config refer to "Database Configuration Nodes" in the NetWitness
Core Database Tuning Guide.
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Log Decoder

. . Description
Setting Field
Decoder /decoder/config refer to Decoder Configuration Parameters.
Index /index/config refer to "Index Configuration Nodes" in the NetWitness Core
Database Tuning Guide.
Logs /logs/config refer to Core Service Logging Configuration Parameters.
REST /rest/config refer to REST Interface Configuration Parameters.
SDK /sdk/config refer to "SDK Configuration Nodes" in the NetWitness Core

Database Tuning Guideand NetWitness Platform Core Service system.roles Modes.

System /sys/config refer to Core Service System Configuration Parameters.

Log Tokenizer Configuration Settings

The Log Decoder has a set of configuration items that control how the automatic log tokenizer creates
meta items from unparsed logs. The log tokenizer is implemented as a set of built-in parsers that each
scan for a subset of recognizable tokens. The functionality of each of these native parsers is shown in the
table below. These word items form a full-text index when they are fed to the indexing engine on the
Concentrator and Archiver. By manipulating the parsers.disabled configuration entry, you can control
which Log Tokenizers are enabled.

Configuration

Parser Name Description
Parameters
Log Tokens Scans for runs of consecutive token.device.types,
characters to produce 'word' meta token.char.classes,
items. token.max.length,

token.min.length,
token.unicode

IPSCAN Scans for text that appears to be an ~ token.device.types
IPv4 address to produce ip.addr
meta items.

IPV6SCAN Scans for text that appears to be an ~ token.device.types
IPv6 address to produce ipv6 meta
items.

URLSCAN Scans for text that appears to be a token.device.types
URL to produce alias.host,
filename, username, and

password meta items.

DOMAINSCAN Scans for text that appears to be a token.device.types
domain name to produce
alias.host, tld, cctld, and sld

meta items.
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Configuration

Parser Name Description
Parameters
EMAILSCAN Scans for text that appears to be an ~ token.device.types
email address to produce email and
username meta items.
SYSLOGTIMESTAMPSCAN Scans for text that appears to be token.device.types

syslog-format timestamps. Syslog is
missing the year and time zone.
When such text is located, it is
normalized into UTC time to create
event.time meta items.

INTERNETTIMESTAMPSCAN  Scans for text that appears to be REC token.device.types

3339-format timestamps to create
event.time meta items.

Log Tokenizer Configuration Parameters.

Log Decoder Parser Description
Setting Field

token.device.types

token.char.classes

token.max.length

token.min.length

The set of device types that will be scanned for raw text tokens. By
default, this is set to unknown, which means only logs that were not
parsed will be scanned for raw text. You can add additional log types here
to enrich parsed logs with text token information.

If this field is empty, then log tokenization is disabled.
This field controls the type of tokens that are generated. It can be any

combination of the values alpha, digit, space, and punct. The default
value is alpha.

alpha: Tokens may contain alphabetic characters

digit: Tokens may contain numbers
e space: Tokens may contain spaces and tabs

¢ punct: Tokens may contain punctuation marks

This field puts a limit on the length of the tokens. The default value is 5
characters. The maximum length setting allows the Log Decoder to limit
the space needed to store the word metadata.

Using longer tokens requires more meta database space, but may provide
slightly faster raw text searches. Using shorter tokens causes the text query
resolver to have to perform more reads from the raw logs during searches,
but it has the effect of using much less space in the metadb and index.

This is the minimum length of a searchable text token. The minimum
token length will correspond to the minimum number of characters a user
may type into the search box in order to locate results. The recommended
value is the default, 3.
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Log Decoder Parser Description
Setting Field

token.unicode This boolean setting controls whether unicode classification rules are
applied when classifying characters according to the
token.char.classes setting.
When this is set to true, each log is treated as a sequence of UTF-8
encoded code points and then classification is performed after the UTF-
8 decoding is performed.
When this is set to false, each log is treated as ASCII characters and
only ASCII character classification is done.
Unicode character classification requires more CPU resources on the Log
Decoder. If you do not need non-English text indexing, you can disable
this setting to reduce CPU utilization on the Log Decoder. The default is
enabled.

REST Interface Configuration Parameters

The following list describes the available configuration parameters for the REST interface built in to
all NetWitness Core Services.

REST

Configuration |/rest/config

Path

cache.dir Displays the host directory to use for temporarily creating and storing files.
Change takes effect on service restart.

cache.size Displays the total maximum size (default unit is MB) of all files in the cache
directory before the oldest are deleted. Change takes effect on service restart.

enabled Switches to enable or disable REST services, 1 is on, 0 is off. Change takes
effect on service restart.

port Displays the port the REST service will listen on. Change takes effect on service
restart.

ssl Encrypts all REST traffic using SSL, if enabled. The default system means use

setting from /sys/config/ssl. Change takes effect on service restart.

NetWitness Platform Core Service system.roles Modes

All NetWitness Platform Core services offer role-based authorization modes. This topic describes the
modes that are available, and how they are configured within every service.

The configuration node /sdk/config/system.roles sets querying and viewing permissions for
metadata and content on a per key basis. This parameter supports the data privacy management function
and when enabled using one of the non-zero values helps a data privacy officer to control access to
specific meta keys and content. This parameter is configurable in the NetWitness Platform user interface
(see "Data Privacy Tab" in the Data Privacy Management Guide for details). When the value is edited,
change takes effect immediately.
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Zero means that service permissions based on SDK meta keys are disabled.

e 0 - disabled

When one of the non-zero values is specified, the data privacy officer can select a meta key to whitelist
or blacklist the display of the associated metadata, content, or both, for a specific user role on a service.

¢ | - whitelist meta and content filtered

2 - whitelist meta filtered

3 - whitelist content filtered

4 - blacklist meta and content filtered

5 - blacklist meta filtered

6 - blacklist content filtered
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Centralized Service Configuration via Policy Settings

This topic introduces the available centralized service configuration settings for Concentrators, Decoders
and Log Decoders services.

Centralized Service Configuration — Groups Tab

Note: The information in this topic applies to NetWitness Platform Version 11.7 and Later.

The

Workflow

(Configure) > Policies view contains two tabs: Groups and Policies.

]
Set Up a Host Maintain a Host | Maintain a Service
|

You are here

What do you want to do?

T T

Administrator ~ set up a host. Setting Up a Host

Administrator ~ maintain a host. Maintaining Hosts

Administrator ~ maintain a service. Maintaining Services

Administrator ~ Centrally Create and Maintain Service Hosts and Services Maintenance
Groups.* Procedures

* You can perform these tasks in the current view.

Related Topics:

e Hosts and Services Set Up Procedures

¢ Hosts and Services Maintenance Procedures
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Quick Look

NETWITNESS Respon osts  Files  Dashboard  Reporls ONE % @ admin
LIVE CONTENT SUBSCRIPTIONS CAPTURE POLICIES POLICIES INCIDENT RULES INCIDENT NOTIFICATIONS ESA RULES CUSTOM FEEDS LOG PARSER R

POLICIES ~ GROUPS
Lroups

ROLICYSIATUS [0 GROUPNAME 1 DESCRIPTION  SERVIC.. SERVICES POLICIES POLICY STATU v (
O Published

O Unpublished
O Failed DecoderGroup1 Decoder  packethybridl - Deco... [CON]DecoderPolicyl  Failed

ConcGroupl Concent... loghybrid1- Concent... None N/A DESCRIPTION

) GROUP TYPE
O N/A . . . Concentrator
LDGroupl LogDec... loghybrid1-LogDec.. [CON]LDPolicyl Failed
POLICY STATUS
SERVICE TYPE N/A
O Decoder
O LogDecoder =l
O Concentrator SERVICE NAME VERSION | STATUS

loghybrid1 - Concentrator  11.7.0.0 N/A
SERVICE STATUS

O Requires Restart

|IJ Showing 3 out of 3items | 1selected

Below is an example of the Groups tab:

The following table describes the Groups tab.

Toolbar

o Create New- Lets you create a new group. For more information, see "Create a Group" in the
Centralized Service Configuration via Policy.

o Edit — Lets you edit the group. For more information, see "Managing Policies and Groups" in
the Centralized Service Configuration via Policy.

o Publish — Publishes selected groups.

o Restart Services — Restarts the service associated with the selected group. This option is
disable if:

o There are no services in the group.
o No service restart is required.

o Delete- Deletes the selected groups.
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b Filter Pane

« Filters: You can filter groups based on Policy Type and Policy Status, Service Type and
Service Status.

To hide, click the B icon at the top-right of the panel. To display if hidden, click the
icon in the toolbar.

¢ Reset: Removes the currently applied filter criteria.

For more information, see "Filter Groups" in the Centralized Service Configuration via Policy.

RIN Group List Pane
e Group Name — Name of the group.

e Description — Description of the group.

o Service Type — Displays the service type to which the group is applied.

» Services — Displays the service to the which the group is applied.

o Policies — Displays the policy to which the group is applied.

o Policy Status — Status of the policy. The values are: Published, Unpublished, Failed, N/A.

You can also sort on any column. If you mouse over a column header, a sort icon is displayed:
. Click the icon to sort by the selected column.

Z3 Groups Details Panel
Displays the properties of the selected group.

Note: Click the row to view the Properties panel for a group.

Create Group Dialog

Below is an example of the Create Group dialog.
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NETWITNESS Invesligale Dashboard

Respond  Users  Hosls  Files

LIVE CONTENT SUBSCRIPTIONS CAPTURE POLICIES POLICIES INCIDENT RULES

POLICIES GROUPS

New Group Identify Group - New Group
GROUP NAME

Enter a unique group name

Define Group
GROUP DESCRIPTION (OPTIONAL)

q a1 Enter adescription
Assign Policies

SERVICE TYPE

Select the type of service for a group

Save and Close

The table describes the information and options in the Create Group dialog.

Group Name

Group Description (Optional)

Service Type

Save and Close

Define Group Dialog

Below is an example of the define group dialog.

Reporls (O]

% ® admin

INCIDENT NOTIFICATIONS ESA RULES CUSTOM FEEDS LOG PARSER

Cancel

Name of the
group. The
name should be
unique.

Description of
the group.
Description
should not
exceed 8000
characters.

Select the type
of service for a
group. Available
options are Log
Decoder,
Decoder, and
Concentrator.

Saves the
settings and
closes the Create
Group dialog.
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POLICIES GROUPS

TestGroup Define Group - TestGroup

» Assign services to the group. A service is disabled if it is ned to another group.
Identify Group

Services List Selected Services

N
@ ) HIDE SERVICES IN A GROUP

SERVICE NAME = SERVICE TYPE GROUP POLICIES HOST VERSION (3 A Add services using ® button

endpointlogh...  Concentrat.. None None endpointl... 11.7.00 ®

endpointlogh...  Concentrat.. None None endpointl... ®

packethybrid...  Concentrat.. None None packethy...

packethybrid...  Concentrat.. None  None packethy...

Save and Close

The table describes the information and options in the Define Group dialog.
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R

Service List Displays the list
of services
associated with
the selected
service type.

The following
describes
services list:

¢ Service
name —
Name of the
service.

« Service type
— Displays
the service
type of the
service.

e Group —
Name of the

group.

e Policies —
Displays the
policies
associated
with the
service.

o Host — Host
name of the
service.

¢ Version —
Service
version.

o All - Lets
you to add
services to
the group.
You can
either click

E to add

all services or

click E to

add specific
service.
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I

Hide Services in a Group Displays the
services that is
not assigned to
any group. By
default, this
option is
disabled.

Selected Services Displays the list
of selected
services for the

group.

Save and Close Saves the setting
and closes the
Define Group
dialog.

Save and Publish Saves and
publishes the
created group.

Note: This
option is
disabled if
you have not:
- Assigned
services

- Assigned
policies

Assign Policy Dailog

Below is an example of Assign Policy dialog.
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NETWITNESS e ond I rd o} % @ admin
LIVE CONTENT S SCRIPTIONS CAPTURE POLICIES POLICIES INCIDENT RULES INCIDENT NOTIFICATIONS ESA RULES CUSTOM FEEDS LOG PARSER RULES

POLICIES GROUPS

TestGroup Assign Policies - TestGroup
g ation) can be
Identify Group

Define Group Policies List Selected Policies

poLicy Type Select

POLICY TYPE  DESCRIPTION GROUPS ACTION

s using ® button
DecoderPolicy1 Configuration DecoderGrou...

‘ Previous ‘ Save and Close ‘ ‘ Cancel ‘

The following table describes assign policy dialog:
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R

Policies List Displays the list
of policies
associated with
the group. The
following
describes
policies list:

e Name —
Name of the
policy.

o Policy Type
— Displays the
policy type.

o Description —
Description of
the policy.

e Groups —
Groups
associated
with the
policy.

e Action -

Click E to

add policies
to the group.

Policy Type Select the policy
type from the
drop-down list.

Selected Policies Displays the list
of selected
policies for the

group.

Save and Close Saves the
settings and
closes the Create
Group dialog.
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R

Save and Publish Saves and
publishes the

created group.

Note: This
option is
disabled if you
have not:

- Assigned
services.

- Assigned
policies.

Centralized Service Configuration — Policies Tab

Note: The information in this topic applies to NetWitness Platform Version 11.7 and Later.

—0
The (Configure) > Policies view contains two tabs: Groups and Policies.

Workflow

|
Set Up a Host Maintain a Host | Maintain a Service
|

You are here

Related Topics:

» Hosts and Services Set Up Procedures

e Hosts and Services Maintenance Procedures

What do you want to do?

T T N

Administrator  set up a host. Setting Up a Host
Administrator ~ maintain a host. Maintaining Hosts
Administrator =~ maintain a service. Maintaining Services
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User Role Documentation
Administrator ~ Centrally Create and Maintain Service Hosts and Services Maintenance
Policy.* Procedures

* You can perform these tasks in the current view.

Quick Look

Below is an example of the Policies tab:

NETWITNESS \ e Users 5 iles Jashboard ~ Reports 9] % @ admin>
LIVE CONTENT SUBSCRIPTIONS CAPTURE POLICIES POLICIES INCIDENT RULES INCIDENT NOTIFICATIONS ESA RULES CUSTOM FEEDS LOG PARSER R

POLICIES GROUPS 4

Y Filters < || ¥ Publsh Concentrator RESTART poicy

eIl e [0 NAME 1 DESCRIPTION CATE.. SERVIC.. GROUPS POLI.. LAST UPD...

O Published

. Concen... Confi.. Concen.. Concentrator.. (+1, Publi.. 08/16/20... DESCRIPTION
O Unpublished C ~

O Failed Decode... Confi.. Decoder  Decoder OOC-GRO... Publi.. 08/16/20...
O N/A
Decode... Confi.. Decoder  None N/A  08/12/20..

SERVICE TYPE POLICY STATUS
Decode... Confi... Decoder Decoder group Fa... 08/12/20... Published
O Decoder e
O LogDecoder Decode... Confi... Decoder  None N/A 08/12/20... v Com
O Concentrator
Decode... Confi... Decoder  None N/A 08/12/20...
SETTING

Decode... Confi... Decoder  None N/A 08/12/20...
Aggregate Autostart O Enabled

Decode... ... Decoder  None E Aggregate Interval 15

|ogdeco... ... LogDec... logdecodergr.. (+3 ... A 08/16/20... Aggregate Max Sessions 3000

Showing 10 out of 10 items | 1 selected

Toolbar

e Create New- Lets you create a new policy. For more information, see "Create a Policy" in
the Centralized Service Configuration via Policy.

o Edit — Lets you edit the policy. For more information, see "Managing Policies and Groups"
in the Centralized Service Configuration via Policy.

o Publish — Publishes the selected policy or policies.
o More Actions

o Assign to Group -Lets you assign policy to a group.
o Clone — Lets you clone a policy.

o Revert — Lets you revert to previous policy settings. By default, the revert value is set to 5.
You can customize the revert value in Explorer view.

o Delete - Deletes the selected policy or policies permanently.
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p)a Filter Pane
« Filters: You can filter policies based on Policy Type and Policy Status and Service Type.

To hide, click the B icon at the top-right of the panel. To display if hidden, click the
icon in the toolbar.

¢ Reset: Removes the currently applied filter criteria.

For more information, see "Filter Policies" in the Centralized Service Configuration via Policy.

RI Policy List Pane
Name — Name of the policy.

* Description — Description of the policy.

» Category — Type of policies applied.

* Service Type — Displays the service type to which the policy is applied.

* Groups - Lists the group to which this policy is applied.

* Policy Status — Status of the policy. The values are: Published, Unpublished, Failed, N/A.
 Last Updated — Displays the time when the policy is updated.

» Updated By — The user who updated the policy.

You can also sort on any column. If you mouse over a column header, a sort icon is displayed:

. Click the icon to sort by the selected column.

L3 Policy Details Pane
Displays the properties of the selected policy.

Note: Click the row to view the Properties panel for a policy.

Create Policy

Below is an example of the Create Policy dialog.
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NETWITNESS Investi Respond  Users  Hosts Files Dashboard ~ Reports

LIVE CONTENT SUBSCRIPTIONS CAPTURE POLICIES POLICIES INCIDENT RULES INCIDENT NOTIFICATIONS

POLICIES GROUPS

New Policy Identify Policy - New Policy
POLICY TYPE

Configuration

Define Policy ST [

. Enter a unigue policy name
Assign to Group

POLICY DESCRIPTION (OPTIONAL)

ter a descriptior

SERVICE TYPE

Choose a service type

Save and Close

The table describes the information and options in the Create Policy dialog.

Cancel

Policy Type

Policy Name

Policy Description (Optional)

Service Type

ESA RULES

admi

CUSTOM FEEDS LOG PARSER

Displays the
policy type.

Name of the
policy. The
name should be
unique.

Description of
the policy.
Description
should not
exceed 8000
characters.

Displays the
type of the
service.
Available
options are Log
Decoder,
Decoder, and
Concentrator.
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Description

(For version 11.7.1 and Later) Clone from Existing Service (Optional) Displays the list
of services
based on the
service type to
clone those
settings.

Save and Close Saves the
settings and
closes the Create
Policy dialog.

Define Policy Settings

NETWITNESS ‘ sers  Hosts  Files  Dashboard  Reports d B ¥ © anin>
LIVE CONTENT SUBSCRIPTIONS CAPTURE POLICIES POLICIES INCIDENT RULES INCIDENT NOTIFICATIONS ESA RULES CUSTOM FEEDS LOG PARSER R

POLICIES GROUPS

TestPolicy Define Policy - TestPolicy

) Customize se
Identify Policy

Customized Settings
Assign to Group

COMMON SETTINGS © @ )

No settings are selected. Add settings us D button

Save and Close
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I

Default Settings Displays the
settings of the
service based on
the category, for
example, Database,
Decoder and so on.

Clickl to expand
the setting
category.

The following
describes Default
settings:

o Setting- Name
of the setting.

e Value- The
settings value.

o Description-
Description of
the setting.

o All - Lets you
to select the
settings for
customization.
You can either

click E to

customize all
the settings
value or click

ona
specific setting

Common Settings Displays the
common settings
of the service. By
default, it is
disabled.

(For version 11.7.1 and Later) 10g Settings Fetches the 10g
settings.
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Customized Settings

Assign to Group

NETWITNESS

LIVE CONTENT SUBSCRIPTIONS

POLICIES  GROUPS
TestPolicy

Identify Policy

Define Policy

Respond  Users  llosls  Files

CAPTURE POLICIES POLICIES

Assign to Group - TestPolicy
A to the policy.
Group List

GROUP NAME POLICIES SERVICES

sadddddddddddddd... ~ None

Save and Close

Previous

Dashl

INCIDENT RULES

Lists the selected
settings for
customization.

T
Click to add
the setting.

Update the value
based on your
requirement.

Reports & % ©

admin

INCIDENT NOTIFICATIONS ESA RULES CUSTOM FEEDS LOG PARSER RULES

d to another policy.

Selected Groups

SERVICE TYPE ACTION

Add groups using @ button

LogDecoder

Cancel
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R

Group List

Selected Group

Save and Close

Save and Publish

Displays the list
of group
associated with
the policy. A
group is
disabled if it is
already assigned
to another
policy.

o Group Name
o Policies
o Services
o Service Type

e Action

Lists the
selected groups.
Click é to
add groups.

Saves the
settings and
closes the
Assign to Group
dialog.

Saves and
publishes the
created policy.

Note: This
option is
disabled if:

- Policy
settings are
not
customized.

- Policy is not
assigned to
groups.
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Troubleshooting Version Installations and Updates

This section describes the error messages displayed in the Hosts view when it encounters problems
updating host versions and installing services on hosts in the Hosts view. If you cannot resolve an update
or installation issue using the following troubleshooting solutions, contact Customer Support.

Troubleshooting instructions for the following errors that may occur during the upgrade are described in
this section.

* deploy admin Password Expired Error

* Downloading Error

» Error Deploying Version <version-number> Missing Update Packages
» Upgrade Failed Error

e External Repo Update Error

» Host Installation Failed Error

* Host Update Failed Error

e Missing Update Packages Error

e OpenSSL 1.1.x Error

» Patch Update to Non-NW Server Error

» Reboot Host After Update from Command Line Error

e Reporting Engine Restarts After Upgrade

Troubleshooting instructions are also provided for errors for the following hosts and services that may
occur during or after an upgrade.

* Log Collector Service
e NW Server

e Orchestration

e Reporting Engine

* Event Stream Analysis
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deploy_admin User Password Has Expired Error

Error

The deploy_admin user's password has expired. In order to perform a service install or
Error ~ ¥ update, change the user's password in the NetWitness Suite and follow instructions on
Message

Cause The deploy_admin user password has expired.

Reset your deploy admin password password.

1. On the NW Server host only, run the following command.
nw-manage --update-deploy-admin-pw
Please enter the new deploy admin account password: <new-
deploy-admin-password>
Please confirm the new deploy admin account password: <new-

deploy-admin-password>

2. Review the output of the nw-manage --update-deploy-admin-pw command to
verify the deploy admin password was successfully updated on all hosts. If an NW
host is down or fails for any reason as displayed by the output of the nw-manage --
update-deploy-admin-pw command, run nw-manage --sync-deploy-admin-
pw --host-key <host-identifier> to synchronize the password between the
NW Server and the host that failed once the communication failure is resolved.

Solution

3. On the host that failed installation or orchestration, run the nwsetup-tui command
and use the new deploy_admin password in response to the Deployment Password
prompt.
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Downloading Error

or downloading update packages. Check the logs.

ooting Version Installations and Updates for more

When you select an update version and click Update >Update Host, the download starts
but fails to complete.

Version download files can be large and take a long time to download. If there are
communication issues during the download it will fail.

1. Try to update again.

2. If it fails again with the same error, try to update using the offline methods as
described in "Offline Method from Hosts View" or "Offline Method Using Command
Line Interface" in the Upgrade Guide for NetWitness Platform 11.6. Go to the
NetWitness All Versions Documents page and find NetWitness Platform guides to
troubleshoot issues.

3. If you are still not able to update, contact Customer Support.
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Error Deploying Version <version-number> Missing Update

Packages

Initialize Update Package for RSA NetWitness Platform

Initialize Update for Version <version-number>

A Error deploying version <version-number>

Error deploying version <version-number> is displayed in the Initialize Update Package
for RSA NetWitness Platform dialog after you click on Initialize Update if the update
package is corrupted.

1. Click Close to close the dialog.
2. Remove the version folder from staging folder.

3. Make sure that the salt-master service is running.

Recopy the update package zip file to the staging folder.

A

In the Hosts view toolbar, select Check for Updates again.
£ Update ~ @2 Discover
LUpdate Host
Check for Updates
6. Click Initialize Update.
7. Click Update > Update Hosts from the toolbar.

8. Click Begin Update from the Update Available dialog.
After the host is updated, it prompts you to reboot the host.

9. Click Reboot from the toolbar.

Upgrade Failed Error

While updating/installing a device to version 11.2 or above, the following error can
occur and be found in /var/log/netwitness/config-management/chef-solo.log:

[2019-04-16T20:55:32+00:00] ERROR: Running exception handlers

[2019-84-16T20:55:32+00:08] ERROR: Exception handlers complete %

[2019-04-16 :32400:00] FATAL: Stacktrace dumped to /var/lib/netwitness/config-management/cache/chef-stacktrace.out
[2619-84-16
[2019-04-16T20:55:32+00:00] ERROR: ruby_block[resolve ips] (mw-dns-client::config line 69) had an error: Resolv::ResolvError: no address for 889e5752-Gae3-4286-
33fdcebe

:55:32+00:00] FATAL: Please provide the contents of the stacktrace.out file if you file a bug report

[2019-04-16T20:55:32+00:08] FATAL: Chef::Exceptions::ChildConvergeError: Chef run process exited unsuccessfully (exit code 1)
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The reason can be because the target host is unable to communicate to the Admin
Server on port 53 as it is attempting to use the dnsmasq service on the Admin Server
to resolve, in this case, 889¢5752-6ae¢3-4286-a944-c182 33fdccbe. This is the salt
minion id of the admin server. You can see this by running "cat /etc/salt/minion" on
the Admin Server to compare. Example output:

I'P:‘cn:ﬂt@':}E;—N'I.vlu'-\dmin ~]# cat fetc/salt/minion
master: localhost

hash_type: sha256

log_level: info

id: 889e5752-bae3-4286-a944-c18233f4cchc

If possible, configure any firewalls between the target host and the Admin Server
host to be able to communicate on port 53. If this is not possible, the workaround is
to include the minion id in the /etc/host file on the component hosts and starting in
the 11.4 release, modify the chef recipe not to overwrite this workaround.

Refer to Install/Upgrade fails in RSA NetWitness Platform because
Resolv::ResolvError: no address for a particular host KB Article.

Received an error in the error log similar to the following when trying to update to
version 11.6 :
FATAL: Chef::Exceptions::Package: yum_package[rsa-protobufs-rt] (rsa-

audit::packages line 11) had an error: Chef::Exceptions::Package: Mo version
specified, and no candidate wversion available for rsa-protobufs-rt

Custom builds/rpms installed for certain components installed on hosts, such as in the
case of installing Hotfixes.

To resolve the issue, follow the below steps.
1. SSH to Admin Server.

2. Locate the component descriptor file by running the following command.
cd /etc/netwitness/component-descriptor/

3. Open the component descriptor file by running the following command.
vi nw-component-descriptor. json

4. Search for “packages” section for the component you have custom build/rpm. For
example, below shown is the package details for “concentrator” host that has custom
build/rpm.

“concentrator”: {
“cookbook name”: “rsa-concentrator”,
“service names”: [“rsa-nw-concentrator”],
“family”: “launch”,
“default port”: xxxx, “description”: “Concentrator”,
“packages”:[{ “name”: “rsa-nw-concentrator”,
“version” : “11.6.0.0-2003001075220.5.cecf24b.e.17.centos”
by

5. Delete the complete version details including (,) character in the packages section. For
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example, it should look like as shown below after you delete the version details.
“packages”: [{

“name”: “rsa-nw-concentrator”

s

Note: You must delete the version details for all the host that has custom builds/rpms
in the component descriptor of the admin server.

6. Run the upgrade process again.

External Repo Update Error

Received an error similar to the following error when trying to update to a new version
from the :

.Repository 'nw-rsa-base': Error parsing config: Error parsing
"baseurl = 'https://nw-node-zero/nwrpmrepo /<version-—
number>/RSA'": URL must be http, ftp, file or https not ""

There is an error the path you specified.

Make sure that:
¢ the URL does exist on the NW Server host.

* you used the correct path and remove any spaces from it.

Host Installation Failed Error

Install for

Host installation failed
Error installing <service> on host <ip-address>. Checkthe loz=.

See Troubleshooting Version Installations and Updates for more
details.

When you select a host and click Install the install service process fails.

1. Try to install the service again.
Often this is all you need to do.

2. If you still cannot install the service:

a. Monitor the following logs on NW Server as it progresses (for example, submit
the tail -f command string from the command line'):
/var/netwitness/uax/logs/sa.log

/var/log/netwitness/orchestration-server/orchestration-
server.log
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/var/log/netwitness/deployment-upgrade/chef-solo.log
/var/log/netwitness/config-management/chef-solo.log
/var/lib/netwitness/config-management/cache/chef-
stacktrace.out

The error appears in one or more of these logs.

b. Try to resolve the issue and reinstall the service.

* Cause 1 - Entered the wrong deploy admin password in the nwsetup-tui.
Solution - Reset your deploy admin password password.

1. On the NW Server host and all other hosts on 11.x, run the following
command.
/opt/rsa/saTools/bin/set-deploy-admin-password

2. On the host that failed installation or orchestration, run the nwsetup-tui
command and use the new deploy_admin password in response to the
Deployment Password prompt.

e Cause 2 -The deploy admin password has expired.
Solution - Reset your deploy admin password password.

1. On the NW Server host and all other hosts on 11.x, run the following
command.
/opt/rsa/saTools/bin/set-deploy-admin-password

2. On the host that failed installation or orchestration, run the nwsetup-tui
command and use the new deploy_admin password in response to the
Deployment Password prompt.

3. If you still cannot apply the update, gather the logs from step 2 and contact Customer
Support.

Host Update Failed Error

Update for <host>

Error updating host <ip-address= to version <version-number=.
Check the logs. See Troubleshooting Version Installations and
Updates for more details.

When you select an update version and click Update > Update Host, the download
process is successful, but the update process fails.

1. Try to apply the version update to the host again.
Often this is all you need to do.

2. If you still cannot apply the new version update:
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a. Monitor the following logs on NW Server as it progresses (for example, run the
tail -f command from the command line):
/var/netwitness/uax/logs/sa.log
/var/log/netwitness/orchestration-server/orchestration-
server.log

/var/log/netwitness/deployment-upgrade/chef-solo.log
/var/log/netwitness/config-management/chef-solo.log
/var/lib/netwitness/config-management/cache/chef-
stacktrace.out

The error appears in one or more of these logs.
b. Try to resolve the issue and reapply the version update.

e Cause | - deploy admin password has expired.
Solution - Reset your deploy admin password .
Complete the following steps to resolve Cause 1.

1. In the NetWitness Suite menu, select Kl (Admin) > Security > Users
tab.

2. Select the deploy admin and click Reset Password.

3. (Conitional) If NetWitness Suite does not allow you to expired deploy
admin password in the Reset Password dialog, complete the following
steps.

a. Reset deploy admin to use a new password.

b. On all non-NW Server hosts on 11.x , run the following command using

the matching deploy admin password from NW Server host.
/opt/rsa/saTools/bin/set-deploy-admin-password

* Cause 2 -The deploy admin password was changed on NW Server host
but not changed on non-NW Server hosts.
Complete the following step to resolve Cause 2.

®  On all non-NW Server hosts on 11.x , run the following command using

the matching deploy admin password from NW Server host.
/opt/rsa/saTools/bin/set-deploy-admin-password

3. If you still cannot apply the update, gather the logs from step 2 and contact Customer
Support.

Missing Update Packages Error

Initialize Update for Version xx.x.x.x
Missing the following update package(s)

Download Packages from RSA Link
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Problem

Solution

Missing the following update package(s) is displayed in the Initialize Update Package
for RSA NetWitness Platform dialog when you are updating a host from the Hosts
view offline and there are packages missing in the staging folder.

1. Click Download Packages from RSA Link in the Initialize Update Package for
RSA NetWitness Platform dialog.
The NetWitness Community page that contains the update files for the selected
version is displayed.

2. Select the missing packages from the staging folder.
The Initialize Update Package for RSA NetWitness Platform dialog is displayed
telling you that it is ready to initialize the update packages.

OpenSSL 1.1.x

Error
Message

Problem

Solution

The following example illustrates an ssh error that can occur when the ssh client is run

from a host with OpenSSL 1.1.x installed:

$ ssh root@10.1.2.3

ssh _dispatch_run fatal: Connection to 10.1.2.3 port 22: message
authentication code incorrect

Advanced users who want to ssh to a NetWitness Platform host from a client that is using
OpenSSL 1.1.x encounter this error because of incompatibility between CENTOS 7.x and
OpenSSL 1.1.x. For example:

$ rpm -g openssl

openssl-1.1.1-8.e18.x86 64

Specify the compatible cipher list on the command line. For example:

$ ssh -oCiphers=aesl28-ctr,aesl92-ctr,aes256-ctr root@l10.1.2.3
I've read & consent to terms in IS user agreement.
root@10.1.2.3"'s password:

Last login: Mon Oct 21 19:03:23 2019

Patch Update to Non-NW Server Error

Error
Message

Problem

Solution

The /var/log/netwitness/orchestration-server/orchestration-

server. log has an error similar to the following error:

API|Failure /rsa/orchestration/task/update-config-management
[counter=10 reason=IllegalArgumentException::Version 'll.x.x.n' is
not supported

After you update the NW Server host to a version, you must update all non-NW Server
hosts to the same version. For example, if you update the NW Server from 11.4.0.0 to
11.6.0.0 , the only update path for the non-NW Server hosts is the same version (that is,
11.6.0.0). If you try to update any non-NW Server host to a different version (for
example, from 11.4.0.0 to an 11.4.x.x) you will get this error.

You have two options:
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e Update the non-NW Server host to 11.6.0.0, or

¢ Do not update the non-NW Server host (keep it at its current version)

Reboot Host After Update from Command Line Error

You receive a message in the User Interface to reboot the host after you update and
reboot the host offline.

[  sA server IP-Address n version-number Reboot Host

You cannot use CLI to reboot the host. You must use the User Interface.

Reboot the host in the Host View in the User Interface.

Reporting Engine Restarts After Upgrade

In some cases, after you upgrade to 11.6 from versions of 11.x, such as 11.4, the
Reporting Engine service attempts to restart continuously without success.

The database files for live charts, alert status, or report status may not be loaded
successfully as the files may be corrupted.

To resolve the issue, do the following:

1. Check which database files are corrupted:
Navigate to the file located at

/var/netwitness/reserver/rsa/soc/reporting-
engine/logs/reporting-engine. log and check the following blocks:

o If the live charts db file is corrupted, the following logs are displayed:

Attempt Failed!!! Clearing pending acquires. While trying to acquire a needed new resource, we failed to succeed
more than the maximum number of allowed acquisition attempts (30). Last acquisition attempt exception:

org.h2jdbc)dbcSQLException: File corrupted while reading record: null. Possible solution: use the recovery tool
[20030-196]

at org.h2.message.DbException.get)dbcSQLException(DbException.java:345)
at org.h2.message DbException.get(DbException.java: 168)

org.springframewaork beans.factory.BeanCreationException: Error creating bean with name
‘chartSummaryDAOImpl': Invocation of init method failed; nested exception is
com.rsa.soc.re.exception.ReportingException: java.sql.SQLException: Connections could not be acquired from the
underlying database!

o If the alert status db file is corrupted, the following logs are displayed:
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Attempt Failed!!l! Clearing pending acquires. While trying to acquire a needed new resource, we failed to succeed
more than the maximum number of allowed acquisition attempts (30). Last acquisition attempt exception:

org.h2.jdbc)dbcSQLException: File corrupted while reading record: null. Possible solution: use the recovery tool
[90030-198]

at org.h2.message.DbException.get/dbcSQLException(DbException.java:345)
at org.h2. message.DbException.get(DbException java:168)

org.springframewaork. beans.factory.UnsatisfiedDependencyException: Error creating bean with name
‘alertStatusHandler': Unsatisfied dependency expressed through field ‘alertExecutionStatsDAO'; nested exception
i5 org.springframework.beans.factory.UnsatisfiedDependencyException: Error creating bean with name
‘alertExecutionStatsDAOImpl": Unsatisfied dependency expressed through field
'persistedAlertExecutionStatsDAQ'; nested exception is
org.springframework.beans.factory.BeanCreationException: Error creating bean with name
'persistedAlertExecutionStatsDAOImpl'

o If the report status db file is corrupted, the following logs are displayed:

org.h2.jdbc.JdbcSQLException: File corrupted while reading
record: null. Possible solution: use the recovery tool
[90030-196]

To resolve the live charts database file corruption, perform the following steps:

a. Stop the Reporting Engine service.

b. Move the 1ivechart.mv.db file from
/var/netwitness/reserver/rsa/soc/reporting-engine/livecharts
folder to a temporary location.

c. Restart the Reporting Engine service.

Note: Some live charts data may be lost on performing the above steps.

To resolve the alert status or report status database file corruption, perform the
following steps:

a. Stop the Reporting Engine service.

b. Replace the corrupted db file with the latest alertstatusmanager.mv.db or
reportstatusmanager.mv.db file from

/var/netwitness/reserver/rsa/soc/reporting-engine/archives

folder.
c. Restart the Reporting Engine service.

For more information, see the Knowledge Base article Reporting Engine restarts
After upgrade to RSA NetWitness Platform 11.4.

After you upgrade to version 11.6, the Reporting Engine service does not restart.

The Reporting Engine service may not start due to any of the following reasons.
- workspace.xml not updated.

- Time is not converted properly in livechart h2 database.

- JCR (Jackrabbit repository) is corrupted with primary key violation.

To resolve the issue, run the Reporting Engine Migration Recovery tool (rsa-nw-re-
migration-recovery.sh) on the Admin Server where the Reporting Engine service
is installed.
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Note: You can find the Reporting Engine Migration Recovery tool in the below
location.

/opt/rsa/soc/reporting-engine-11.6.0.0-<Tag>/nwtools

1. SSH to Admin Server.

2. Untar the RE (Reporting Engine) tool, run the following command.
tar -xvf rsa-nw-re-recovery-tool-bundle.tar

3. (Optional) If you want to untar the RE tool file in some other directory, you can
create a directory and untar the RE tool. Run the following commands.
mkdir <NAME OF THE DIRECTORY>

tar -xvf rsa-nw-re-recovery-tool-bundle.tar --directory <PATH OF
THE DIRECTORY>

4. Run the script, run the following command.
./<PATH OF THE DIRECTORY>/rsa-nw-re-recovery-tool.sh

For more information, see the Knowledge Base article Reporting Engine Migration
Recovery Tool.

Log Collector Service (nwlogcollector)

Log Collector installation logs are posted to /var/log/install/nwlogcollector install.log
on the host running the nwlogcollector service.

<timestamp>.NwLogCollector PostInstall: Lockbox Status : Failed to
open lockbox: The lockbox stable value threshold was not met
because the system fingerprint has changed. To reset the system
fingerprint, open the lockbox using the passphrase.

The Log Collector Lockbox failed to open after the update.

Log in to NetWitness and reset the system fingerprint by resetting the stable system value
password for the Lockbox as described in the "Reset the Stable System Value"

topic under "Configure Lockbox Security Settings" topic in the Log Collection
Configuration Guide,

<timestamp> NwLogCollector PostInstall: Lockbox Status : Not Found

The Log Collector Lockbox is not configured after the update.

If you use a Log Collector Lockbox, log in to NetWitness and configure the Lockbox as
described in the "Configure Lockbox Security Settings" topic in the Log Collection
Configuration Guide,
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<timestamp>: NwLogCollector PostInstall: Lockbox Status : Lockbox
maintenance required: The lockbox stable value threshold requires
resetting. To reset the system fingerprint, select Reset Stable
System Value on the settings page of the Log Collector.

You need to reset the stable value threshold field for the Log Collector Lockbox.

Log in to NetWitness and reset the stable system value password for the Lockbox as
described in "Reset the Stable System Value" topic under "Configure Lockbox Security
Settings" topic in the Log Collection Configuration Guide,

Decoder tries to start capture events but fails.

Aug 27 01:44:41 nwdecoder NwDecoder[8@52]: [Decoder] [failure] The PF_RING
driver is not installed.

To resolve the issue, do the following steps,
1. SSH to the Decoder host.

2. Run the following commands.
yum reinstall pfring*
systemctl restart nwdecoder

NW Server

These logs are posted to /var/netwitness/uax/logs/sa.log on the NW Server Host.

After upgrade, you notice that Audit logs are not getting forwarded to the configured
Global Audit Setup;

or,

The following message seen in the sa. log.
Syslog Configuration migration failed. Restart jetty service to
fix this issue

NW Server Global Audit setup migration failed to migrate from 11.4.x.x or 11.5.x.x. to
11.6.0.0.

1. SSH to the NW Server.

2. Submit the following command.
orchestration-cli-client --update-admin-node

Troubleshooting Version Installations and Updates 203




Hosts and Services Getting Started Guide

Orchestration

The orchestration server logs are posted to /var/log/netwitness/orchestration-
server/orchestration-server.log onthe NW Server Host.

1. Tried to upgrade a non-NW Server host and it failed.
2. Retried the upgrade for this host and it failed again.

You will see the following message in the orchestration-server.log.
"'file' wvirtual returned False: cannot import name HASHES""

Salt minion may have been upgraded and never restarted on failed non-NW Server host

1. SSH to the non-NW Server host that failed to upgrade.

2. Submit the following commands.

systemctl unmask salt-minion
systemctl restart salt-minion

3. Retry the upgrade of the non-NW Server host.

Reporting Engine Service

Reporting Engine Update logs are posted to to/var/log/re install.log file on the host running the
Reporting Engine service.

<timestamp> : Available free space in /var/netwitness/re-
server/rsa/soc/reporting-engine [ ><existing-GB ] is less than the
required space [ <required-GB> ]

Update of the Reporting Engine failed because you do not have enough disk space.

Free up the disk space to accommodate the required space shown in the log message. See
the "Add Additional Space for Large Reports" topic in the Reporting Engine
Configuration Guide for instructions on how to free up disk space.

Event Stream Analysis

After upgrading to version 11.6, the ESA correlation server does not aggregate events
from the configured data sources.

Invalid username or password at
com.rsa.netwitness.streams.base.RecordSourceSubscription.run
(RecordSourceSubscription.java:173)

To resolve the issue, do the following steps.
In the NetWitness user interface,
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1. Goto (Configure) > ESA Rules.
ESA Rules panel is displayed with Rules tab open.

2. In the Rules tab options panel, under Deployments, select a deployment.
3. In the Data Sources section, select the data source and click 4 in the toolbar.

4. In the Edit Service dialog, type the password for that data source.

5. Click the Test Connection button to make sure that it can communicate with the
ESA service and then click OK.

Note: Do the above procedure for all the configured data sources.

6. After you finish making changes to the deployment, click Deploy Now to redeploy
the ESA rule deployment.
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